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X4 ESB

1 Einfdhrung

1.1 Wasist ein ESB Project?

Ein ESB(Enterprise Service Bus) Project ist eine Projektart innerhalb der X4 BPMS, mit der Sie
Technical Processes grafisch modellieren und ausfiihren konnen. ESB Projects enthalten eine
vordefinierte Ordnerstruktur, in der beliebig viele Technical Processes (*.wrf) angelegt werden
konnen.

1.2 Wie kannich ESB Projects nutzen?

Innerhalb von ESB Projects konnen Sie technische Prozesse erstellen und grafisch modellieren. Alle
Prozessbausteine werden dabei einfach per Drag & Drop in die Zeichnungsflache tdbernommen. Dort
kénnen sie nach der Parametrierung direkt Uber das integrierte Debugging-Werkzeug getestet oder
per Mausklick zeit- und ereignisgesteuert auf dem X4 Server ausgefiihrt werden.

Die Einsatzmaéglichkeiten von ESB Projects sind sehr vielfaltig. Beispiele fir die Anwendung sind u.a.
elektronischer Datenaustausch zwischen Systemen Uber die verfligharen Adapter oder die
Transformation von Daten Gber Mappings.

Forking und Merging in einem Technical Process
gS-FDrUUInMErgE.Wﬁ e

Forking process execution, joining back, and merging XML documents

Operation: Write
Writes two files in

Operation: Read project repository. Operation: Write
Split Execution ordef _for - Merges output - »
Ftreads a }jcc;t(urrent trF.; Il_l :i tai'o?-nni:‘n:teosfwo each fork transition Joins the fork fromthe forks to  Writes XML docurment
om proje is defined in transitions back to one XML with merged input data
repository. (or more) parallel STty Th one, and keeps the 3 twith  from previous action to
forks, that use the output of both forks ocEnt Wi project repository
? same input data in memory root element
! "<Merge/>" o
e = 7 =
' H |
! { éi
s —m e =, [
- OQutputi e Uy | P
O—p‘ : I utpu »=p =] —O
Start Dacument E—— ﬁ El Merge FnalOutput Stop

Output2
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2

1

Oberflache

<

File Edit View Project Tools Window Help

P20~ o=
[P Projects 52 | 67 Apps = 0

Filter

= = 0

Meniileiste

Symbolleiste

Sichten

Perspektiven

Editoren und
Zeichnungsflache

Statusleiste

Uber die Mendileiste konnen Sie verschiedene Funktionen und
Editoren des X4 Designers aufrufen.

Uber die Symbolleiste kdnnen Sie verschiedene Funktionen und
Anzeigeoptionen aufrufen. Einige Symbole sind nur aktiv, wenn
die entsprechende Funktion fir das ausgewahlte oder gedffnete
Element verfligbar ist, siehe auch Symbolleiste.

Sie kdnnen die angezeigten Sichten per Drag&Drop individuell
anordnen.

Uber diese Symbole kénnen Sie zwischen den Perspektiven X4
Designer, Debug und BPMN Designer wechseln.

In diesem Bereich werden Prozesse und Dateien zum Anzeigen
und Bearbeiten in Registerkarten gedffnet.

In der Statusleiste werden der verbundene Server, der
angemeldete Benutzer und die Version der X4 BPMS angezeigt.
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2.

Symbolleiste

Uber die Symbolleiste kdnnen Sie verschiedene Funktionen und Anzeigeoptionen aufrufen. Einige
Symbole sind nur aktiv, wenn die entsprechende Funktion flir das ausgewahlte oder gedffnete
Element verflgbar ist.

C{’J

i

&2

Cd

I N

r&ll:_\_

Connect

Disconnect

New

Save

Save all

Repository Refresh

Attach/Detach Debug

Start Debugging

Undo

Redo

Cut

Copy

Paste

Start Debugging

Verbindung zum Server herstellen

Verbindung zum Server trennen

Neues Element hinzufligen

@ Welche Elemente Sie (iber dieses Symbol hinzufiigen kénnen,
hangt davon ab, in welcher Perspektive und an welcher Stelle der

Baumstruktur im Repository Sie sich befinden.

Anderungen im aktuell gedffneten Fenster speichern
Alle Anderungen speichern
Server-seitige Aktualisierung durchfiihren

Debugger mit der Server-Instanz verbinden/Debugger von der
Server-Instanz losen

Debugger starten

Letzten Bearbeitungsschritt rickgangig machen
Rickgangig gemachten Schritt wiederherstellen
Auswahl ausschneiden

Auswahl kopieren

Auswabhl einfigen

Optionen zur Prozessausflihrung aufrufen:

« Start Debugging: Prozess debuggen(Fehler anzeigen
und beseitigen)

« Start Without Debugging: Prozess direkt ausfihren

« Debug/Run Options: Run/Debug-Einstellungenim X4
Designer 6ffnen

© SoftProject GmbH
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Suspend
P Resume
B Stop Debugging

Step Into

Step Over

Step Return

@ Toggle Breakpoint

¥ Clear all Breakpoints

&d Quick Watch

(= Output
Q Zoomout

wx ~|Z00m
Zoom In
Snap to grid

() Show Process Quality Index

2.2 Kontextmenu

Debugging anhalten
Debugging fortsetzen
Debugging beenden

Prozess-Schritt ausflihren (mit Anzeige der Schritte des
Subprozesses)

Prozess-Schritt ausfiihren (ohne Anzeige der Schritte des
Subprozesses)

Aus Subprozess herausspringen

Breakpoint (Debug-Haltepunkt)zu markiertem Baustein setzen
oder entfernen

Alle Breakpoints in diesem Prozess l6schen

Quick-Watch-Sicht 6ffnen, um Platzhalter, dynamische
Parameter und Kontextvariablen mit inren Werten wahrend des
Debuggens zu betrachten

Output-Sicht 6ffnen, um das Ergebnis jedes Prozess-Schrittes
wahrend des Debuggens zu betrachten

Ansicht verkleinern
Zoom-Stufe wahlen
Ansicht vergréBern
Raster einblenden und Bausteine am Raster ausrichten

Process Quality Index einblenden

Kontextmenti fiir Prozessbausteine

© SoftProject GmbH
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Wenn Sie im Editor-Bereich des X4 Designers mit der rechten Maustaste auf einen Prozessbaustein
klicken, stehen Ihnen je nach Bausteinart und Prozesstyp verschiedene Funktionen zur Verfligung:

Add Component
Layout

Select All

Copy Process Diagram to
Clipboard

Edit Label...
Undo...

Redo...
Copy
Cut

Set... document

Edit ...

Toggle Breakpoint
Delete

Validate
Preview

Show input schema
Show output schema

Select in Repository
Navigator

View Call Hierarchy

Refresh

Neue Prozesskomponente hinzufligen
Ausgewahlte Prozesskomponenten ausrichten:

« Align Horizontal: Komponenten anhand des Mittelwertes
horizontal ausrichten

« Align Vertical: Komponenten anhand des Mittelwertes
vertikal ausrichten

« Distribute Horizontal: Komponenten gleichmaBig
horizontal verteilen

» Distribute Vertical: Komponenten gleichmaBig vertikal
verteilen

Alle Prozesskomponenten auswahlen
Prozessdiagramm zwischenspeichern

Namen der Prozesskomponente bearbeiten
Rickgangig machen

Letzten Schritt wiederherstellen
Markierten Prozessbaustein kopieren
Markierten Prozessbaustein ausschneiden

Markierten Baustein durch ein anderes Element im Repository
austauschen

Markierten Baustein/Datei bearbeiten (nur Modul-Bausteine und
Dokumente)

Debug-Haltepunkt setzen
Prozessbaustein aus dem Prozessdiagramm entfernen

Subprozess auf Gliltigkeit prifen (nur bei Subprozessen)

Prozessbaustein in separatem Editor 6ffnen (nur bei Modul-
Bausteinen und Dokumenten)

Input-Schema des Subprozesses anzeigen (falls vorhanden)
Output-Schema des Subprozesses anzeigen (falls vorhanden)
Prozessbaustein im Repository Navigator zeigen

Verwendungsnachweis flr den markierten Prozessbaustein anzeigen

Prozessbaustein neu aus dem Repository laden (nur bei Modul-
Bausteinen und Dokumenten)
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Bring to Front
Bring Forward

Send Backward
Send to Back
Properties

Schema Declaration...

Symbolin den Vordergrund des Diagramms setzen
Symbol im Diagramm eine Ebene nach vorne setzen

Symbol im Diagramm eine Ebene nach hinten setzen
Symbolin den Hintergrund des Diagramms setzen
Eigenschaften des Prozessbausteins in der Properties-Sicht anzeigen

Schema-Deklaration flr den Prozess hinterlegen

Kontextmenii in der Projects-Sicht

Das Kontextmeni konnen Sie per Rechtsklick auf ein Element in der Projects-Sicht aufrufen.

New
Open/ Open With

Save As Template

Copy Full Path to Clipboard /

Copy XStore URL to
Clipboard

Cut, Copy und Paste
Delete

Rename/Refactor
Exclude from Project

Include to Project
Repair References
Validate

View Call Hierarchy
Start Without Debugging
Import

Export

Neue Elemente (Prozesse, Ordner, Adapter etc.)im Repository
anlegen

Markiertes Element (Prozess, Ordner, Adapter etc.) mit dem
Standard-Editor oder einem bestimmten Editor 6ffnen

Markiertes Element als Vorlage speichern

Pfad zur markierten Datei in die Zwischenablage kopieren (als
Ordnerpfad oder als xstore://-URL)

Markiertes Elemente ausschneiden, kopieren oder einfligen

Markiertes Element aus dem Repository I6schen (der Léschvorgang
kann nicht riickgéngig gemacht werden)

Element (und falls gewlinscht dessen Referenzen) umbenennen
Ressource aus dem Projekt ausschlieBen

® . Die Datei wird im Dateisystem beibehalten, ist jedoch
nicht mehr Bestandteil des Projektes und wird ausgegraut
dargestellt. )
« Die Ublichen Operationen wie Offnen, Bearbeiten,
Kopieren, Loschen usw. konnen flir ausgeschlossene
Dateien nicht ausgefihrt werden.

Ausgeschlossene Ressource wieder in das Projekt aufnehmen

Pfade von Repository-Ressourcen in Prozessdiagrammen reparieren
Prozess auf Glltigkeit prifen

Anzeigen, in welchen Prozessen dieses Element verwendet wird
Prozess direkt ausfihren

Ressource ins Repository importieren

Projekt oder Ressource exportieren
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Clean-Up Project Nicht verwendete Dateien auswahlen und aus dem Repository
|6schen

2.3 Perspektiven

Eine Perspektive ist eine festgelegte Anordnung von Sichten und dem Editorbereich. Sie kdnnen per
Drag&Drop individuell anordnen.

= X4 Designer Die X4 Designer-Perspektive ist die Standardansicht.

= Debug Die Debug-Perspektive ist eine optimierte Ansicht flir das Debugging von
Geschaftsprozessen und technischen Prozessen.

< BPMN Die BPMN Designer-Perspektive ist eine optimierte Ansicht fiir die Modellierung von
Designer Geschaftsprozessen.

2.3.1  Perspektive wechseln

Im X4 Designer kdnnen Sie zwischen Perspektiven wechseln. Die Anordnung der Sichten bleibt dabei
erhalten.

« Um die Perspektive zu wechseln, klicken Sie im oberen rechten Bildschirmbereich auf das
Symbol der gewlinschten Perspektive.

2.3.2  Perspektive zurucksetzen

Um eine Perspektive zurlickzusetzen, gehen Sie wie folgt vor:

1. Wechseln Sie in die Perspektive.
2. Wahlen Sie in der Menlleiste Window > Reset Window Layout.
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2.4  Sichten

= Projects

& Apps

In der Sicht Projects wird eine Baumstruktur des verbundenen Repositorys mit
verschiedenen Elementen wie Projekten, Ordnern und Dateien angezeigt. Sie kdnnen
das Kontextmen( aufrufen, indem Sie mit der rechten Maustaste auf ein Element
klicken. Abhangig davon, an welcher Stelle in der Baumstruktur Sie sich befinden,
andern sich die Optionen im Kontextmendi.

Uber das Textfeld Filter (iber dem Projektbaum kdnnen Sie nach Dateien innerhalb
des verbundenen Repositorys suchen. Platzhalter wie x oder ? sind nicht mdglich.

Uber die Symbolleiste der Sicht Projects kdnnen Sie die folgenden Aktionen
ausfihren:

. 8 Jump from active Editor to Repository Navigator: Gedffnete Datei im Editor
im Repository Navigator markieren

.3 Show or hide all files: Inhalt des Dateisystems einblenden und ausblenden.
Aus dem Projekt ausgeschlossene Dateien werden dabei ausgegraut dargestellt.

In der Sicht Apps werden alle X4 Apps angezeigt, die zum Blindeln von Projekten
verwendet werden.
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= Properties In der Sicht Properties kdnnen Sie die Eigenschaften von markierten
Prozessbausteinen und gedffneten Prozessen anzeigen und bearbeiten.

« Inderlinken Spalte befinden sich die Eigenschaften, in der rechten Spalte die
zugehorigen Werte.

« Firjeden Prozess kann ein Titel sowie eine Beschreibung hinterlegt werden.
Diese Angaben werden in der erzeugten Dokumentation angezeigt.

« Um die Eigenschaften eines getffneten Prozesses zu bearbeiten, klicken Sie auf
einen leeren Bereich auf der Zeichnungsflache.

] Properties &3 4 B = = 0
Property Value
Business Data [Electronic Invaice, Invoic...
Can Stop 3
Case W
Case States [Invoice is imported, To b...
Created 19, &, 2019 08:12:44
Created By BrigitteStall
Free-flow mode
In service ¥
Instance limit 1]
Last Update 19. 8. 2019 03:16:52
Last Update By ErigitteStall
Schedule Disabled
Stop on error 7
Title Approval of electronic inv...
Verzion 1566195411781

StandardmaBig werden die gebrauchlichsten Eigenschaften angezeigt. Uber die
Symbolleiste der Sicht Properties kdnnen Sie jedoch zusatzliche Einstellungen

vornehmen:
- L% pin to Selection: Angezeigte Eigenschaften in der Sicht Properties anheften
. 5 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen
=5

i

Show Advanced Properties: Erweiterte Eigenschaften anzeigen

. Restore Default Value: Auf Standardwerte zurlicksetzen

. 7 View Menu: Zusatzoptionen 6ffnen
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» Run/Debug Wird ein Prozess auf Fehler Uberprift bzw. simuliert, werden in der Sicht Run/Debug

Console

Console zu jedem ausgefihrten Prozess-Schritt Debug-Informationen angezeigt.
Fehlermeldungen werden rot hervorgehoben, erfolgreiche Statusmeldungen grin.

Wenn ein Prozess-Schritt ein Zwischenergebnis ausqgibt, wird dieses wahrend des
Debuggens in einer temporaren Datei gespeichert, die Sie Gber den entsprechenden
Verweis ansehen kénnen(z. B. file://1376054979039/).

@ Sie kdnnen die Sicht Run/Debug Console iiber das Menii View > Run/Debug
Console aufrufen.
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@ Output
einsehen.

@ Sie kdnnen die Sicht Output wahrend des Debuggens iiber das Menii Debug >

In der Sicht Output kdnnen Sie die Ergebnisse jedes einzelnen Debug-Schritts

Output oder tGber das Symbol Output & inder Symbolleiste aufrufen.

& Importinvoice.wrf

Import electronic invoice

4

o=

Start Invoce

=
2
Import

electronic
nvoice

(= Output » bd Quick Watch) P Run/Debug Console
Encoding: UTF-8 MIME-Type: text/xml

<fxml version="1.8" encoding="UTF-8"¢>»

<Receiver>

<Name>SoftProject GmbH</Name>
<VatId>DE12345678</VatId>
<Street>Am Erlengraben 3</Street>
<ZipCode>76275</ZipCode>
<City>Ettlingen</City

ty
<Country>DE</Countrys

c R >y -
</Receiver>

Save features

(= Qutput =  Bd Quick Watch | B Run/Debug Console

O

Stop

The current output contains large amount of data (9,97 ME).

Opening large amounts of data can adversely affect the performance of the X4 Designer.
If the data could not be displayed, please increase the memory used by X4 Designer.

To load the data, press the "Load™ button.

i1 Load

& Wenn die ausgegebenen Daten gréBer als 1MB sind, wird eine Warnung
angezeigt. Sie konnen die Daten Uber eine Schaltflache herunterladen.
GroBe Datenmengen konnen die Performance des X4 Designers

beeintrachtigen.

Uber die Symbolleiste kdnnen Sie auBerdem die folgenden Aktionen ausfiihren:

. [ Find content: Daten in der Sicht Output finden
. Copy all content: Alle Daten in der Sicht Output in die Zwischenablage

kopieren

. B Copy selected content: Ausgewahlte Daten aus der Sicht Output in die

Zwischenablage kopieren

. B Save content: Daten aus der Sicht Output speichern

. 2 Format content: Daten aus der Sicht Output formatieren

A Hinweis
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= X4 Server
Log

= Call
Hierarchy

Binare Daten werden in der Sicht Output als hexadezimale Daten
ausgegeben. Bilder und textbasierte Inhalte werden als Bild bzw. Text
ausgegeben. Durch die Ausgabe binarer Daten als hexadezimale Daten wird
die Performance des X4 Designers nicht beeintrachtigt.

In der Sicht X4 Server Log kdnnen Sie den Server-Status und insbesondere Fehler im

X4-Server-Log aus dem X4 Designer heraus verfolgen.
P, Run/Debug Conscle | [E] ¥4 Server Log &1 | |2 Call Hierarchy = B

2019-08-28 12:55:33.135 INFO [de.softproject.integration.engine.Xdengine] (default task-2) Finis
2019-08-28 12:55:33.136 INFO [de.softproject.integration.engine.Xdengine] (default task-2) Proc
2019-08-28 12:55:33.145 ERROR [de.softproject.integration.engine.X4engine] (default task-2) Mo
2019-08-28 12:55:33.146 INFO [de.softproject.integration.engine.Xdengine] (default task-2) Finis
2019-08-28 12:55:33.163 INFO [de.softproject.integration.engine.debug.impl 5ession] (default ta

< >

@ Sie kdnnen die Sicht X4 Server Log (iber das Men(i View > X4 Server Log aufrufe

In der Sicht Call Hierarchy konnen Sie flr jeden Prozess und Prozessbaustein im
Repository anzeigen, von welchen Repository-Elementen diese verwendet werden.

n.

hRun,-"DEbug Console [E] ¥4 Server Log | 3= Call Hierarchy 53 = O

v g BPMProject_2/Processes/Activities/Processes/Approvefutomatically.wrf
[a] BPMProject_2/Processes/Invoicefipproval.bpm

Wenn Sie mit der rechten Maustaste auf ein Element im Repository Navigator
klicken, wird ein Kontextmeni aufgerufen. Mit View Call Hierarchy wird
anschlieBend eine Auflistung aller Repository-Elemente angezeigt, die mindestens
eine Referenz auf das markierte Element enthalten.
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@ Error Log Inder Sicht Error Log kdnnen Sie im X4 Designer aufgetretene Fehler einsehen.

h Run/Debug Conscle [E] X4 Server Log 3*0 Call Hierarchy | € Error Log 53
Workspace Log

ftyp 1

Message Plug-in

v (& Warnings while parsing the key bindings from the org.eclipse.ui
!, Cannot bind te an undefined command: plug- org.eclipse.ui

€3 Cannet convert null to a primitive org.eclipse.core.databind...
€3] Cannot convert null to a primitive arg.eclipse.core.databind...
€3 Cannot convert null to a primitive arg.eclipse.core.databind...

w (& Warnings while parsing the key bindings from the org.eclipse.ui
I, Cannot bind to an undefined command: plug- org.eclipse.ui

Date

28.08.19, 10:03
28.08.19, 10:03
19.08.19, 08:16
19.08.19, 0815
19.08.19, 08:07
19.08.19, 08:04
19.08.19, 08:04

s =3 e m o= =
=l - x X 5 ZF
B X e

i

V= H

Uber die Symbolleiste kdnnen Sie auBerdem die folgenden Aktionen ausfiihren:

. . Import Log: Error Log(. log)importieren
. ® Clear Log Viewer: Error Log bereinigen

. R Delete Log: Error Log unwiderruflich 1dschen

. = Open Log: Log-Datei(.log)im X4 Designer 6ffnen

. 7 Restore Log: Error Log wiederherstellen
« 7 View Menu: Zusatzoptionen 6ffnen

= Export Log: Error Log exportieren und als . log-Datei speichern

@ Sie konnen die Sicht Error Log (iber das Men(i View > Error Log aufrufen.

@ Problems Inder Sicht Problems werden alle Fehler und Warnungen aufgelistet. Sie kdnnen die

Liste der Probleme Uber das Filtersymbol anpassen.

% Debug In der Sicht Debug Sessions werden alle aktiven Debug-Sessions aufgelistet. Indem
Sessions  Siein der Sicht Debug Sessions auf einen Prozess doppelklicken, wechseln Sie in die

zugehorige Debug-Session.

Aktive Debug-Sessions sind grau markiert. Mit dem Server verbundene, neue Debug-

Sessions sind orange markiert.

. Breakpoint In der Sicht Breakpoints werden alle gesetzten Breakspoints aufgelistet. Sie konnen
S Breakpoints aktivieren, deaktivieren und l6schen. AuBerdem kdnnen Sie alle
Breakpoints tberspringen, ohne die Breakpoints zu l6schen.
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63 Quick
Watch

= Outline

» Baseb4
» Digest

» Regex

In der Sicht Quick Watch kdnnen Sie Variablen, Parameter und dynamische
Parameter mit ihren Werten wahrend des Debuggens getrennt voneinander
betrachten.

Dazu wahlen Sie in der Dropdown-Liste den entsprechenden Eintrag aus:

(= Output |6d Quick Watch > | P» Run/Debug Console

Variables ~

Parameters

Dynamic Parameters

Ausgewahlte Variablen werden nach jedem Debug-Schritt aktualisiert.

Wenn Sie den Eintrag Parameters auswahlen, kénnen Sie Uber die Kontrollkastchen
Project, Global und System festlegen, welche Parameter Sie anzeigen mochten:

(= Output |bd Quick Watch > | P Run/Debug Console

Parameters w Project @ Global B System

& Enthélt das Ergebnis Inhalte, die groBer als 1MB sind, wird eine Warnung
angezeigt, und Sie kdnnen das Ergebnis Uber eine Schaltflache
herunterladen.

GroBe Datenmengen kdnnen sich negativ auf die Leistungsfahigkeit des X4
Designers auswirken.

@ Sie kdnnen die Sicht Quick Watch wahrend des Debuggens {iber das Menii Debug >
Quick Watch oder Gber das Quick-Watch-Symbol 6d in der Symbolleiste aufrufen.

In der Sicht Outline wird das vollstandige Prozessdiagramm als Abbildung angezeigt.
Sie kdnnen auf einzelne Bereiche in der Abbildung klicken und so mihelos durch den
Prozess navigieren, selbst wenn die Abbildung groBer ist als das Designer-Fenster.

@ Sie kdnnen die Sicht Outline Giber das Menii View > Outline aufrufen.
Zeichenketten Base64-kodieren oder dekodieren

Hash-Wert fur Zeichenketten erzeugen

Regularen Ausdruck (Regex) auf eine Zeichenkette anwenden, um den Ausdruck zu

testen oder um die Zeichenkette gemaR einem Muster direkt zu ersetzen
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# URLCodec Zeichenketten URL-kodieren oder dekodieren

2.4.1 Sichten offnen

& |n der Perspektive BPMN Designer kdnnen keine weiteren Sichten gedffnet werden, da alle
relevanten Sichten standardmaBig gedffnet sind.

« Wahlen Sie in der Menlleiste im Menl View die gewiinschte Sicht.

2.5 Editoren

Im X4 Designer werden Prozesse und Dateien zum Anzeigen und Bearbeiten in Registerkarten
gedffnet. Der verwendete Editor ist abhangig vom gedffneten Dateityp.

Editor
BPMN Editor

Datenbank-Editor

JSON Editor

Mapping Editor

Parameter-Editor

Process Editor

XML Editor

Verwendung
.bpm

.pld

.stm

.json

Xsl

.rep

.param

.wrf

xml

xhtml

Beschreibung

Mit dem BPMN Editor konnen Sie
Geschaftsprozesse gemal dem
Notationsstandard BPMN 2.0 modellieren.

Mit dem Datenbank-Editor konnen Sie SOQL-
Abfragen fir Bausteine einer
Datenbankverbindung definieren, um Daten aus
einer relationalen Datenbank abzufragen.

Mit dem JSON Editor konnen Sie JSON-
Dokumente direkt im X4 Designer bearbeiten.

Mit dem Mapping Editor konnen Sie XSL-
Mappings in einer grafischen Ansicht erstellen
und bearbeiten.

Mit dem Parameter-Editor kdnnen Sie Projekt-
Parameter und Projekt-Parameter-Gruppen
erstellen, um Prozessbausteine zu
parametrieren.

Mit dem Process Editor konnen Sie technische
Prozesse grafisch modellieren.

Mit dem XML Editor kdnnen Sie wohlgeformte
XML-Dokumente erstellen und bearbeiten.
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XSD Editor .xsd Mit dem XSD-Editor konnen Sie eine XML-
Schemadefinition fir lhre XML-Dokumente
erstellen.

2.5.1  BPMN Editor

Mit dem BPMN Editor kdnnen Sie Geschaftsprozesse gemaB dem Notationsstandard BPMN

2.0 modellieren. Der Editor entspricht in Aufbau und Bedienweise in weiten Teilen dem Process
Editorim X4 Designer, unterscheidet sich jedoch im Hinblick auf die Prozessbausteine und Symbole
im Prozessdiagramm. Mit dem BPMN Editor werden die modellierten Geschaftsprozesse direkt mit
den technischen Prozessen verknupft. Das heiBt: Sie kdnnen Ihre fachlichen und technischen
Prozesse modellieren und liber den X4 Server testen und ausfiihren, ohne die Entwicklungsumgebung
zu wechseln.

Da auch nicht-automatisierbare Aktionen - etwa Arbeitsabldufe von Menschen -in
Geschaftsprozesse eingebunden werden kénnen, lassen sich Geschaftsprozesse nicht
notwendigerweise auf dem X4 Server ausfihren.

@ Im Free-flow-Modus besteht zusétzlich die Mdéglichkeit, den BPMN Editor als reines BPMN-
Zeichenwerkzeug mit einer erweiterte BPMN-Palette zu verwenden, bei der die Funktion Run/
Debug deaktiviert ist.

2.5.2 Datenbank-Editor

Mit dem Datenbank-Editor kdnnen Sie SQOL-Abfragen flir Bausteine einer Datenbankverbindung
definieren, um Daten aus einer relationalen Datenbank abzufragen. Durch die logische Trennung der
Prozessbausteine SOL-Anweisungund Datenbankverbindunglassen sich diese Prozessbausteine
im X4 Designer flexibel einsetzen und mehrfach verwenden.

® Um den Datenbank-Editor aufzurufen, legen Sie eine neue SQL-Statement-Datei(.stm)an,
oder 6ffnen Sie eine bereits vorhandene SQL-Statement-Datei.

Aufbau des Datenbank-Editors

Der Datenbank-Editor besteht aus den folgenden Bereichen:

» Statement Editor: In diesem Bereich kénnen Sie eine Verbindung zu einer Datenbank aufbauen
und die Struktur der verbundenen Datenbank anzeigen. Mit dieser Struktur kdnnen
anschlieBend SQL-Statements fur die Datenbank erstellt werden.

» Mapping Editor: In diesem Bereich kdnnen Sie flr das im Statement Editor zuvor erstellte
Statement ein Mapping von Elementen eines Input-XML-Dokuments auf die Named Parameter
des Statements definieren. Aus diesem Mapping kdnnen Sie anschlieBend ein XSL-Mapping
erstellen, das mit einem passenden Input-XML-Dokument eine dynamisch erzeugte Eingabe flr
den JDBC Connector erzeugt.
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Connection

JDBC Connector: | xstore;/Documentation_6.0/Adapters ~ | Connect.. Status: Connected tojava;/X4BAM_DS Execute Statement...
Database Statement
~ [& INFORMATION_SCHEMA ~ v Statements Root

F CATALOGS ~ Named Prepared Statement

E COLLATIONS Resulttag result

B COLUMNS Time Zone GMT

E COLUMN_PRIVILEGES Date Format

B CONSTANTS ~ INSERT

[ CONSTRAINTS
B CROSS_REFERENCES

INTO
VALUES

PUBLIC.CUSTOMERS (ADDRESS, CITY, COMPANYNAME, COUNTRY, CUSTOMER..

B DOMAINS ~ RowSet

B FUNCTION_ALIASES v Row

EE FUNCTION_COLUMNS address

= HELP city

B INDEXES companyName
E IN_DOUBT country

B LOCKS customerlD

B QUERY_STATISTICS phone

B RIGHTS postalCode

& ROLES e

Statement Editor| Mapping Editor

2.5.2.1 Statement Editor

Der Statement Editorist in folgende Bereiche unterteilt:

Connec Indiesem Bereich kdnnen Sie Uber einen JOBC Connectoreine Verbindung zu einer
tion- Datenbank aufbauen.
Bereich

« JDBC Connector: xstore-URL zu einem JDBC Connector

® « Um eine Verbindung aufbauen zu kdnnen, muss der Adapter innerhalb des
Parameters JndiName einen glltigen JNDI-Namen enthalten.
« Inder Dropdown-Liste werden die letzten acht verbundenen URLs zur
Auswahl angeboten.

» Connect: Mit der Datenbank verbinden
Unter Status wird der Verbindungstatus angezeigt.

- Execute Statement: Statement ausfihren

Databa Indiesem Bereich wird nach dem Verbindungsaufbau die Struktur der Datenbank
se- angezeigt. Fur die Darstellung der Struktur werden die folgenden Symbole verwendet:
Bereich

. & Datenbankschema

. B Datenbanktabelle

. Primarschlissel

« o= Primarschlissel/Fremdschlissel
« &= Fremdschlissel
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Statem
ent-
Bereich

In diesem Bereich kdnnen Sie Uber das Kontextmeni verschiedene Statements fur die
verbundene Datenbank anlegen:

New Named Prepared Statement: Im Statements Root ein neues Named Prepared
Statement anlegen

Edit Named Prepared Statement: Named Prepared Statement bearbeiten

New RowSet: Neues RowSet anlegen.

@ Innerhalb eines Named Prepared Statement kann lediglich ein RowSet existieren.
Dieses wird beim Anlegen des Named Prepared Statement automatisch mit angelegt.
Ein neues RowSet kann nur angelegt werden, wenn das bestehende RowSet geldscht
wurde.

New Row: Neue Zeile innerhalb eines RowSet hinzufligen

New Named Parameter Value: Einen neuen Named Parameter-Wert innerhalb einer
Zeile hinzuflgen

Edit Named Parameter: Named Parameter bearbeiten

New SELECT Statement: Ein neues SELECT-Statement anlegen

Edit SELECT: SELECT-Befehl bearbeiten

Edit FROM: FROM-Befehl innerhalb eines SELECT-Statements bearbeiten

New INSERT Statement: Ein neues INSERT-Statement anlegen

Edit INTO: INTO-Befehl bearbeiten

New VALUE Entry: Neuen Eintrag unter VALUE anlegen

Edit VALUE: Wert eines VALUE-Eintrags bearbeiten

New UPDATE Statement: Ein neues UPDATE-Statement anlegen

Edit UPDATE: UPDATE-Befehl bearbeiten

New SET Entry: Neuen Eintrag unter SET anlegen

Edit SET Entry: Eintrag unter SET bearbeiten

New DELETE Statement: Ein neues DELETE-Statement anlegen

Edit FROM: FROM-Befehl bearbeiten

Edit WHERE: WHERE-Bedingung bearbeiten

New Column: Neue Spalte innerhalb eines INSERT- oder SELECT-Befehls einfligen
New Table: Neue Tabelle innerhalb eines UPDATE- oder SELECT-Befehls einfligen

Delete: Element I0schen

@ Weitere Informationen zum Anlegen und Bearbeiten von Statements finden Sie im

Abschnitt Statement fir eine verbundene Datenbank erstellen.

Drag&Drop-Aktionen

Im Statement-Bereich kdnnen Sie die folgenden Drag&Drop-Aktionen ausfihren:
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2.5.2.2

SQL-Statement

SELECT

UPDATE

INSERT

DELETE

Mapping Editor

Datenbank-
Element

Column

Table

Column

Table

Table

Column

Table

Statement-
Element

SELECT

FROM

SET Entry

UPDATE

INTO

INTO

FROM

Aktion

Die auszuwahlende Spalte
hinzufligen

© Stent die Tabelle der Spalte
noch nicht im FROM, wird diese
hinzugeflgt.

Tabelle hinzufligen, aus der
ausgewahlt werden soll

Spalte als Eintrag setzen

© stent die Tabelle der
entsprechenden Spalte noch
nicht im UPDATE, wird diese
hinzugeflgt.

Die zu aktualisierende Tabelle
setzen

Tabelle setzen, in die
geschrieben werden soll

i ] Ist bereits eine Tabelle
vorhanden, wird diese ersetzt.
Dabei werden auch bereits
gesetzte Spalten(Columns)
geldscht.

Spalte setzen, in die
geschrieben werden soll

© Diesist nur maoglich, wenn
die Spalte aus der gesetzten
Tabelle stammt.

Die zu loschende Tabelle
setzen

0 Ist bereits eine Tabelle
vorhanden, wird diese ersetzt.

Mit dem Mapping Editor kénnen Sie fir die zuvor im Statement Editor angelegten Statements per
Drag&Dropp Mappings von einem Input-XML-Dokument auf die Named Parameters der Statements
konfigurieren und anschlieBend erstellen. Diese Mappings erzeugen mit einem passenden Input-XML-
Dokument eine dynamisch erzeugte Eingabe fir den JOBC Connector.

Der Mapping Editor ist in folgende Bereiche unterteilt:
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Generate mapping

~ [e] Customers v [e] statements
~ [&] Customer adapterPath="xstore:;/Documentation_6.0/Adapters/JDBC_Connector_1.fa"
id="777" mappinglnput="xstore:/X4Experience/ESB/3-Reference/3-Features/DatabaseEditor/Data/exampleCustomer.xml”
[e] Name N ~ [e] namedpreparedstatement
~ [&] Anschrift \‘\\ resulttag="result"
[e] Adresse N timezone="GMT"
[e] Stadt (2] sql
[l PLZ ~ [&] rowset
[l Land ~ [& row
[e] Telefonnummer [el address
[&] city
[e] companyName
[e] country
[el customerlD
(€] phone
[e] postalCode

Statement Editor Mapping Editor

Quelldok Auf der linken Seite befindet sich in der Quelldokument-Bereich. In diesem Bereich
ument- konnen Sie die Input-XML-Datei per Drag&Drop ablegen und anzeigen.
Bereich

Uber das Kontextmenii kénnen Sie den gewahlten Knoten wie folgt bearbeiten:

» Collapse: Knoten mit aufgeklappten Unterelementen zuklappen
« Expand: Unterelemente des Knotens aufklappen
+ Remove Input: Input-XML-Dokument entfernen

Verkniip In der mittleren Spalte befindet sich der Verknipfungsbereich. In diesem Bereich werden
fungsbe die xs1:value-of-Verknipfungenzwischen dem Element aus dem Quelldokument und
reich dem Named Parameter im Statement als Linien visualisiert.

Stateme Auf derrechten Seite befindet sich der Statements-Bereich. In diesem Bereich wird die
nts- gesamte Struktur der Statement-Datei angezeigt. Dabei kdnnen Mappings vom Input-XML
Bereich auf die Kind-Elemente eines Row-Elements erstellt werden.

2.5.3 JSON-Editor
Mit dem JSON Editor kdnnen Sie JSON-Dokumente direkt im X4 Designer bearbeiten.

® Um den JSON Editor zu starten, legen Sie entweder ein neues JSON-Dokument an oder
offnen ein bereits vorhandenes Dokument.

In der Sicht Outline wird die Struktur des gedffneten JSON-Dokuments angezeigt. Zudem konnen Sie
Uber das KontextmenU Quick Outline oder Uber die Tastenkombination STRG+0 die Sicht Quick Outline
offnen, um innerhalb des JSON-Dokuments nach Schlisseln und Werten zu suchen.

Tastenkombinationen

STRG+0 Sicht Quick Outline 6ffnen
STRG+Umschalttaste+F JSON-Code formatieren
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T text_1json 52

"para®: "

"GlossSeeAl

I
"GlossSee":

mal

~ L} Object ~
~ {} "glossary"
5 "fitle”; "example glossary”
~ {} "GlossDiv"
5 “title": "S"
~ {3} "GlossList”
~ {} "GlossEntry"
S "ID": "SGML"
5 "SortAs" "SGML"
5 "GlossTerm": "Standard General
5 "Acronym": "SGML"
S "Abbrev": "ISO 8879:1986"
w {7} "GlossDef"
5 "para’: "A meta-markup lani
v

w I'1 "GlossSephlsn”
< >

Regular expressions enabled|

languages such as DocBook.”,

O= Outline 32

~ {} Object
« £} "glossary”

S 'title": "example glossary"
~ {} "GlossDiv"
S “title”: S
w {} "GlossList”
w {} "GlossEntry"

L

5

“ID": "SGML"

"Sarths": "SGML"

"GlossTerm": "Standard Generalized Markup Language”
"Acronym": "SGML"

"Abbrey": "IS0 8379:1936"

{} "GlossDef"

5

"GlossSee": "markup”

@ Die Formatierung des JSON-Codes sowie die Farben zur Syntaxhervorhebung kdnnen Sie
unter Tools > Options > JSON Editor andern. Siehe auch JSON-Editor konfigurieren.

2.5.4

Mapping Editor

Mit dem Mapping Editor kénnen Sie XSL-Mappings in einer grafischen Ansicht erstellen und
bearbeiten. Eine XML-Datenstruktur kann hier mithilfe von XSLT in eine andere XML-Datenstruktur
oder in ein XSL-FO-Dokument transformiert werden. Der Mapping Editor unterstitzt Sie beim
Erstellen eines XSL-Mappings durch eine grafische Oberflache und durch eine automatische

Glltigkeitsprifung des Stylesheets sowie der XPath-Ausdricke.

Bei einem XSL-Mapping sind drei Dokumente involviert:

« XML-Quelldokument (oder ein XML-Schema mit der Strukturinformation)

« XSLT-Stylesheet (dieses wird im Mapping Editor erstellt)

« XML-Ausgabedokument

® Um den Mapping Editor zu starten, legen Sie entweder ein neues Mapping an oder 6ffnen ein
bereits vorhandenes XSLT-Mapping.

Aufbau des Mapping Editors

Der Mapping Editor ist in folgende Bereiche unterteilt:
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¥4 Designer - /ESBProject_1/Transformations/1/XSLMapping sl - XSLMappingaxs!

| File Edit View Project Tools Run Window Help
i Ak o
= Projects x | gR= 8
Filter
| [ [ EsBproject_1
> & Adapters
> & Processes

> & Resources
> & TemporaryFiles
> & Transformations

|| > ® X4Common (Libra

[ Properties x

Property Value

1 Quelldokument-Bereich

2  Verkniipfungsbereich

- o x
Q | u[& O
[% XSLMapping.xsl =n
« [ Data ~ B stylesheet version="1.0"
« & CUSTOMERS Xminsaxsl="httpy//www.w3.0rg/1999/XSL/Transform"
& CUSTOMERID 2 output method="htmI" media-type="text/html"
& COMPANYNAME 1 1% v B template match="/"
[& ADDRESS . v & htmi
@ any | BN @ xrmins="http://www.w3.0rg/1999 /xhtml"
& POSTALCODE NN « [ head
& COUNTRY NN v @ title
&l PHONE AN \\ T "Customers”
\\ N v (@ body
N\ ® style="font-family:Calibri, sans-serif"
N 5 « " for-each select="/Data/CUSTOMERS"
RN v @ div
. v @
N e value-of select="COMPANYNAME"
AN v Ep
e ¥ value-of select="CITY"
v Ep
@ style="text-alignright"
T “(c) SoftProject GmbH"
£ Created by X4 Designer 42, Copyright..
| Design| source| .
[ Output X |6d Quick Watch| > Run/Debug Console REBAR =0

Encoding: UTF-8 MIME-Type: text/xmi

<?xml version="1.8" encoding="I150-8859-1"?>
<Data> I
<CUSTOMERS >
<CUSTOMERID>1@1</CUSTOMERID>
<COMPANYNAME>SoftProject GmbH
</COMPANYNAME>
<ADDRESS>Am Erlengraben 3</ADDRESS>
<CITY>Ettlingen</CITY>
<POSTALCODE>76275¢</POSTALCODE>

Connected to: X4 Server (localhost:8080) | Workspace: 1 | Username: demo | X4 Server 7.3.1-SNAPSHOT

In diesem Bereich wird das zu transformierende Quelldokument
oder eine XML-Schema-Datei (. xsd)angezeigt.

Uber das Kontextmenii kdnnen Sie den gewahlten Knoten wie
folgt bearbeiten:

Copy XPath for this element to Clipboard: XPath-

Ausdruck zum entsprechenden Element in die
Zwischenablage kopieren und an anderer
Stelle verwenden
« Assign Input: Input-XML-Dokument zuweisen
« Remove Input: Input-XML-Dokument entfernen
« Paste Input: Input-XML-Dokument aus der

Zwischenablage einfligen

In diesem Bereich werden die Verknlpfungen zwischen Knoten
im Quelldokument und XSL-Stylesheet als verschiedenfarbige
Linien visualisiert.

® Unter Tastenkombinationen im Mapping Editor finden
Sie nutzliche Tastenkombinationen fir die Arbeit mit
XSL-Stylesheets in der grafischen Ansicht des X4
Mapping Editors.
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3

Stylesheet-Bereich

In diesem Bereich bearbeiten Sie den Hauptbestandteil eines
Mappings, das XSL-Stylesheet. Das Stylesheet wird in einer
Baumstruktur angezeigt und bietet Gber das Kontextmen
Zusatzfunktionen fur die XSL-Bearbeitung.

Die verschiedenen Bestandteile des XSL-Stylesheets werdenin
der Baumansicht mit Symbolen und farblichen Hervorhebungen
dargestellt:

« Knoten mit XSL-Anweisungen sind durch eine braune
Schriftfarbe und ein entsprechendes Symbol
gekennzeichnet, z. B. H*E*L for-each select="0atajCustomers" )

« Knoten mit einem XPath-Ausdruck sind durch ein
entsprechendes XPath-Symbol ( =) gekennzeichnet. Um den
XPath-Ausdruck zu bearbeiten, klicken Sie auf dieses
Symbol.

« Virtuelle Knoten (aus der Quellstruktur Gbernommene, aber
noch nicht im Stylesheet explizit vorhandene Knoten) werden
grau dargestellt.

Uber das Kontextmenii kdnnen Sie im Stylesheet-Bereich den
gewahlten Knoten wie folgt bearbeiten:

« Edit XSL Element: XSL-Element bearbeiten
« Rename: Knoten umbenennen
« Element: Element einfligen
« Attribute: Attribut einfligen
- Edit: (bei Processing Instructions, Namespace-
Deklarationen): Knoteninhalt bearbeiten
+ XSL Element: XSL-Element einfligen
« as Child: als Kind-Knoten
» Before: als Knoten vor dem markierten Knoten
« After: als Knoten hinter dem markierten Knoten
- Add other nodes: andere Knoten einfligen (Namespace, Text,
Comment, Processing Instruction)
« Add here: (nur bei virtuellen Knoten): virtuellen Knoten in
tatsachlichen Knoten umwandeln
« Add Processing Instructions: Processing Instructions
hinzufligen, um Parameter dynamisch zu setzen
+ Condition State flr Statusinformationen
« Log Info flr Log-Nachrichten
« Dynamic Parameter zum Setzen von dynamischen
Werten
+ No Result flr leere Mapping-Ausgaben
« Add Parameter: System-, Projekt- oder
globale Parameter einflgen, siehe Parameter erstellen und
verwenden
- Add Parent: Eltern-Element (ibergeordnetes Element)
einflgen
» Cut/Copy/Paste: Auswahl ausschneiden, kopieren und
einflgen
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4

5

 Delete: Knoten l6schen

« Expand/Collapse: Unterelemente des Knotens aufklappen
bzw. zuklappen

« Assign Virtual Nodes: virtuellen Knoten aus einem XML-
Dokument einfligen

« Remove Virtual Node: eingefiigten virtuellen Knoten
entfernen

@ Mit dem XSL Element Creation Wizard kdnnen Sie
einfach und schnell XSL-Mappings erstellen. Der Wizard
bietet neben der kompletten Palette an XSLT 2.0-
Elementen auch die Maglichkeit, die Mappings
bequem Uber das Kontextmenu anzulegen.

Uber den Wizard lasst sich festlegen, ob das neue
Element vor oder nach dem ausgewahlten Element oder
als Kind des ausgewahlten Elements angelegt werden
soll. Funktionen wie Autovervollstandigung oder die
Anzeige aller verfligbaren und erlaubten XSL-Elemente
ermoglichen schnelleres Arbeiten.

Zudem kdnnen die Attribute des XSL-Elements gesetzt
bzw. nach dem Anlegen bearbeitet werden. Zwingend
erforderliche Attribute werden dabei automatisch
Ubernommen, optionale Attribute konnen je nach Bedarf
ausgewahlt und befllt werden.

Bei Attributen, die mehrere Optionen zur Auswahl haben,
wird eine Liste mit den verfligbaren

Werten bereitgestellt.

Source- und Design-Ansicht Der Mapping Editor verfligt iber zwei Ansichten, zwischen denen

Output

Sie Uber zwei Registerkarten wechseln kénnen:

« Design: In der dreispaltigen Design-Ansicht wird das
XSLT-Stylesheet als Baum dargestellt. Hier konnen Sie die
Knoten des Quelldokuments den Knoten im XSLT-
Stylesheet grafisch zuordnen.

« Source: Indieser Quellcode-Ansicht konnen Sie das XSLT-
Stylesheet direkt im XML-Editor bearbeiten.

Das Ergebnis von lokal ausgefilihrten XSL-Mappings wird in der
Sicht Output angezeigt.

AuBerdem kénnen Sie Uber die Symbolleiste die folgenden
Aktionen ausfuhren:

« H save content of output view: Daten aus der Sicht Output
speichern

« le= Format the content of the output view: Daten aus der
Sicht Qutput formatieren
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6 Run Transformation

Uber P Run Transformation wird das XSL-Mapping lokal
ausgeflhrt, und das Transformationsergebnis wird in der Sicht
Output (5) angezeigt.

2.5.4.1 Tastenkombinationenim Mapping Editor

Hier finden Sie nitzliche Tastenkombinationen fir die Arbeit mit XSL-Stylesheets in der grafischen
Ansicht des X4 Mapping Editors.

Aktionen per Drag&Drop

Werte mit dem Zielknoten
verknipfen mit xs1:value-
of

Mehrere Werte im
Zielknoten verknipfen mit
xsl:value-of

Knoten kopieren mit
xs'l:copy-of

For-Each-Schleife zu
Knoten erstellen mit
xsl:for—-each

Knoten im Quelldokument per Drag&Drop auf den Zielknoten ziehen

Alt-Taste dricken und alle gewlnschten Knoten im Quelldokument auf
den Zielknoten ziehen

Ergebnis:im select-Attribut des erzeugten xs1:value-of-Elements
werden alle verknipften Elemente nacheinander hinterlegt und
konnen anschlieBend mit einer XPath-Funktion wie concat () oder
logischen Operatoren verknipft werden.

Beispiel: <xs1l:value-of select="Elementl Element2">

Strg-Taste driicken und Knoten im Quelldokument auf den Zielknoten
ziehen

Shift-Taste driicken und Knoten im Quelldokument auf den Zielknoten
ziehen

Funktion Tastenkombination
Basisfunktionen Element bearbeiten Enter

XSL-Transformation ausfihren F9

Element einfligen Einfg

Attribut einfligen Alt+Einfg

Text einflgen Strg+Einfg

UmschlieBendes Eltern-Element einfligen Strg+Shift+Einfg

Element umbenennen Alt+Shift+R

Markierten Knoten entfernen Entf
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Knoten kopieren

Knoten
verschieben

Im Stylesheet-
Baum navigieren

2.5.5

Code formatieren/einriicken (in der Source-Ansicht)

Markierten Knoten als vorangehenden Knoten einfligen

Markierten Knoten als nachfolgenden Knoten einfligen

Markierten Knoten als vorangehenden Eltern-Knoten
einfligen

Markierten Knoten als vorangehenden Knoten
verschieben

Markierten Knoten als nachsten Knoten verschieben
Markierten Knoten als vorangehenden Eltern-Knoten
verschieben

Zum Eltern-Element wechseln

Zum nachsten Geschwister-Knoten wechseln

Zum vorangehenden Element wechseln

Verbundene Knoten in Quelldokument-Bereich und

Stylesheet-Bereich markieren
Letzte Markierung wiederherstellen

Process Editor

Strg+Shift+F

Strg+Alt+Nach
oben

Strg+Alt+Nach
unten

Strg+Alt+Nach
links

Alt+Nach oben

Alt+Nach unten

Alt+Shift+Nach
links

Strg+Shift+Nach
links

Strg+Shift+Nach
unten

Strg+Shift+Nach
oben

Shift+Einfg

Alt+Shift+Nach
unten

Mit dem Process Editor kdnnen Sie technische Prozesse grafisch modellieren. AuBerdem kénnen Sie
flr jeden technischen Prozess und jedem einzelnen Prozessbaustein festlegen, wie diese ausgefihrt

werden sollen.

Mit dem Process Editor konnen Sie unter anderem:

2.5.5.1

@ DerProcess Quality Index ist ein experimentelles Feature. Die Funktionalitat ist derzeit noch

Verbindungen zwischen verschiedenen Backend-Systemen herstellen,
Daten in Echtzeit transformieren,

Geschaftsregeln im modellierten Prozess implementieren und
modellierte Prozesse debuggen und auf dem X4 Server ausfihren

Process Quality Index

eingeschrankt und wird fortwahrend weiterentwickelt.
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Der Prozess Quality Index ist ein grafisches Hilfswerkzeug, das angibt, wie qualitativ hochwertig ein

ESB-Prozess im Hinblick auf Kriterien wie die Einhaltung von Standards und die Ubersichtlichkeit

modelliert wurde.

40% 72%
Gewichtung der Kriterien
Kriterien Bedingung Gewichtung
Anzahl der Elemente 100% - <15 Elemente 45%
75% — <20 Elemente
50% - <25Elemente
25% - <30Elemente
0% — >=30 Elemente
Anzahl der Stopp-Elemente 100% —» <3 Elemente 15%
75% - <4Elemente
50% —» <5Elemente
25% - <BElemente
0% - >=6 Elemente
Labels der Elemente sind nicht leer wahr - 100% 10%
falsch - 0%
Prozesstitel wurde gesetzt (nicht Name der  wahr — 100% 5%
Prozessdatei)
falsch - 0%
Labels der Elemente wurden angepasst wahr - 100% 5%

(nicht Dateiname)

falsch - 0%
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Kriterien Bedingung

Keine Elemente auf der rechten Seite von wahr - 100%
Stopp-Elementen
falsch - 0%

Keine Elemente auf der linken Seite von wahr - 100%
Start-Elementen
falsch - 0%

Keine Uberlappenden Elemente wahr - 100%

falsch - 0%

Flow Direction Index
Maximum

2.5.5.2 Tastenkombinationen im Process Editor

Gewichtung
5%

5%

5%

5%
100%

Hier finden Sie ndtzliche Tastenkombinationen fir die Arbeit mit dem Process Editors.

Funktion
Prozess Prozess ausfihren
ausfithren und
debuggen

Prozess auf Fehler prifen (und ggf. aktiven
Debugging-Vorgang abbrechen)

Beim Debuggen Einzelschritt ausflihren
und anzeigen (auch in Subprozessen)

Beim Debuggen Prozess-Schritt ausfihren
(ohne Anzeige des Schritte des
Subprozesses)

Beim Debuggen aus Subprozess
herausspringen

Debugging anhalten

Debugging fortsetzen

© SoftProject GmbH
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F9

F4

F5

F6

F7

Strg+F8

F8
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Debugging abbrechen Strg+F2
Prozessbaustei Prozessbaustein zwischen zwei Datei per Drag&Drop aus dem
ne und verbundenen Bausteinen aus dem Repository auf den Ubergang ziehen.
Ubergénge Repository einfligen Wenn die Linie des Ubergangs dick
einfiigen wird, Maustaste loslassen.

Prozessbaustein von der Ubergangslinie  Alt-Taste driicken und
herunterziehen Prozessbaustein auf der
Zeichnungsflache verschieben

Prozessbaustein entfernen und Alt+Entf
Ubergangslinie behalten

Prozessbaustein durch eine Datei aus dem Datei per Drag&Drop aus dem
Repository ersetzen Repository auf den zu ersetzenden
Prozessbaustein ziehen

Prozessbaustein hinter einem Unverbundenen Prozessbaustein
unverbundenen Baustein einfligen und markieren, Shift-Taste dricken und
dabei automatisch einen Ubergang die Datei aus dem Repository hinter
herstellen den markierten Prozessbaustein ziehen
Elemente Alles auf der Zeichnungsflache auswahlen Strg+A
bearbeiten Prozessbaustein ausschneiden Strg+X
Prozessbaustein kopieren Strg+C
Prozessbaustein einfligen Strg+V
Prozessbaustein entfernen Entf
Bearbeitungsschritt rickgangig machen  Strg+Z
Bearbeitungsschritt wiederherstellen Strg+Y
Prozessbaustein bearbeiten Auf Symbol doppelklicken
Editor schlieBen Strg+W
Bearbeitetes Element speichern Strg+S
Datei im Repository umbenennen F2
Datei im Repository verschieben Datei per Drag&Drop in den Ordner
ziehen
Neu laden F5
Ansicht Prozessdiagramm vergréBern (zoomen) Strg++
bearbeiten Prozessdiagramm verkleinern Strg+-

2.5.6  XML-Editor

Mit dem XML Editor kdnnen Sie wohlgeformte XML-Dokumente erstellen und bearbeiten.

® Um den XML Editor zu starten, legen Sie entweder ein neues XML-Dokument an oder 6ffnen
ein bereits vorhandenes Dokument.

Aufbau des XML-Editors
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« Zum Bearbeiten von XML-Dokumenten stehen zwei Sichten zur Verfligung: die Sicht Design un
d die Sicht Source. Uber die Registerkarten am unteren Rand des Editors kdnnen Sie zwischen
den Sichten wechseln.

=] Customer-Data.xml & |
o=
Node Content
2 xml version="1.0" encoding="UTF-8"
~ [e] Root

v [g] Dataset
[e] CustomerlD
[e] CompanyMName
[e] ContactName
[e] ContactTitle
[e] Address
[e] PostalCode
Created by X4 Designer, Copyright @ SoftProject GmbH. All rights reserve...

Design | Source

Design In der Sicht Design wird die Baumstruktur des gedffneten XML-Dokuments tabellarisch
dargestellt. In der linken Spalte befinden sich die verschiedenen Knoten, die Sie auf- und
zuklappen konnen, sofern Kindknoten existieren. In der rechten Spalte werden die
Inhalte der Knoten angezeigt.

Uber das Kontextmenii kdnnen Sie die folgenden Aktionen ausfiihren:

+ Remove: Markierten Knoten entfernen

« Add DTD Information: Strukturdefinition in Form einer DTD (Document Type
Definition) hinzufligen

« Edit Namespaces: Namensraume bearbeiten

+ Add Attribute: Neues Attribut hinzufligen

« Add Child: Neuen Kindknoten (Element, Processing Instruction usw.) hinzufiigen

» Add Before: Neuen Knoten vor dem markierten Knoten einfligen

« Add After: Neuen Knoten hinter dem markierten Knoten einfligen

Source In der Sicht Source konnen Sie den Quelltext von XML-Dokumenten bearbeiten.

Dabei unterstitzt Sie der Editor durch folgende Funktionen:

« Syntax-Highlighting: Die verschiedenen Knotentypen werden farblich
hervorgehoben.

« Wohlgeformtheit: Beim Speichern erfolgt eine Prifung auf Wohlgeformtheit des
XML-Dokuments.

» Eingabehilfe: Der Editor macht Vorschlage, wenn Sie neue Elemente einfligen
maochten.

« Pretty-Print: Uber das Menii Source > Format kdnnen Sie |hr XML-Dokument mit
EinrGckungen und Zeilenumbrichen lesbarer formatieren.
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3  Prozessbausteine undihre Verwendung

3.1 Die Palette

Am rechten Rand der Zeichnungsflache befindet sich eine ausklappbare Werkzeugleiste, die Palette.
Sie enthalt verschiedene Prozessbaustein-Symbole, die Sie per Drag&Drop in die Zeichnungsflache

ziehen konnen.

.= Palette
= Control
= Modules
RN
= fi)
= Drawing
,{’D 1 o

b
Erel
o i
3 QO + W g ¥ #
Erl
= o—m [ By I
Fa CHe =
4

me A W

Wenn Sie den Mauszeiger Uber einen in der Zeichnungsflache platzierten Baustein bewegen, dann
werden oberhalb des Bausteins verschiedene Symbole angezeigt.

& Essindnichtalle Symbole bei allen Bausteinen verfligbar!

Symbol

o

Funktion/Bedeutung
Neuen Baustein nach dem aktuellen Baustein hinzufligen

Typ des Bausteins von Resource in Buffer andern

Typ des Bausteins von Buffer in Resource andern

& FirDateien, dieim Ordner TemporaryFiles liegen, ist diese
Option nicht verfligbar.

Baustein bearbeiten

Operation des Bausteins von Read in Wr1ite andern
Operation des Bausteins von Write in Read andern

Baustein I60schen
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3.2 Prozessbausteine verbinden

— -
Transition: Verbindet die einzelnen Prozessbausteine und definiert die Reihenfolge der

Prozessschritte durch die Pfeilrichtung.

Eigenschaften

& Einige Eigenschaften sind nur sichtbar, wenn in der Sicht Properties die Option Show
Advanced Properties aktiviert ist.

Label Freitextfeld zur Beschriftung des Ubergangs (zur (ibersichtlicheren
Gestaltung bzw. Dokumentation)

Log4J Log Logging Uber Log4jan dieser Stelle des Prozesses mit den aktuellen
Input-Daten aktivieren. Um das Logging Uber Log4jzu aktivieren,
markieren Sie die Eigenschaft, und klicken Sie auf ka

Madgliche Werte:

« Disabled:Keine Log4j-Aktion wurde festgelegt (Standard).
» Enabled:Eine Log4j-Aktion wurde festgelegt.

Save Point Save Point an dieser Stelle des Prozesses setzen, um den
kompletten Zustand der Prozess-Engine mit den verarbeiteten
Daten und Statusinformationen bei der Ausfihrung einer
Prozessinstanz im Dateisystem zu persistieren. Die Prozessinstanz
kann vom letzten gespeicherten Save Point Gber die Monitoring-
Oberflachen wiederaufgesetzt werden.

Mogliche Werte:

« No Savepoint:Kein Save Point wurde festgelegt (Standard)

» Save and Continue: Save Point erstellen und die
Prozessausflhrung direkt fortsetzen

» Save and Stop: Save Point erstellen und die Ausflhrung der
Prozessinstanz anhalten

o Delete: aktuellen Save Point I6schen

Source Component Baustein, an dem die Ubergangslinie beginnt (wird vom X4 Designer
gesetzt)

© SoftProject GmbH 45



X4 ESB

Target Component Baustein, zu dem die Ubergangslinie fiihrt (wird vom X4 Designer
gesetzt)
Priority Bei Gabelungen(Fork)und Verzweigungen (Cond+ition): Position

der Ausflihrreihenfolge (Prioritat)
Madgliche Werte:

 beliebige positive ganze Zahl
« 1: hochste Prioritat (Standard)

Condition Bei Bedingungs-Bausteinen: vom Condition Manager hinterlegte
Ausfiihrbedingung (wird vom Condition Manager gesetzt)

Beispiel
Ubergang zwischen zwei Prozessbausteinen mit einer Beschriftung (Label):

-
- La
O [ata processing O

Start Stop

3.5 Bausteineim Bereich,Control”

Folgende Control-Bausteine stellen die Basisfunktionen fir den Ablauf von Prozessen und deren
Kontrollstrukturen bereit:

= Control

+

Auf den folgenden Seiten finden Sie weitere Informationen zur Funktion der einzelnen Bausteine.

3.3.1  Stop

Die Grundelemente jedes Prozesses sind ein definierter Prozessbeginn(Start)und mindestens ein

Prozessende (Stop).
Jeder Prozess, den Sie anlegen, besteht automatisch aus einem Start-und einem Stop-Baustein.
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O O

Start Stop

Der start-Baustein kann nicht entfernt werden, und es ist nicht mdéglich, weitere Start-Bausteine

hinzuzufligen. Deshalb enthélt die Palette nur den Control-Baustein Stop ( O ).

Eigenschaften und Parameter

Status Statuscode der X4 Engine.

Code

(nur Stop- BeiVerwendung des Stop-Elements als ReST-Endpunkt in einem Prozess wird der
Baustein) HTTP-Statuscode bei Erreichen des Stop-Elements ausgegeben.

& st das Flag Stop on error flir den Prozess aktiviert, wird im Fehlerfall der
Statuscode des Stop-Elements ignoriert und 500 zurlickgegeben.

Ist Stop on error fir den Prozess deaktiviert, wird der Statuscode des Stop-Ele
ments ausgegeben.

Modgliche Werte:

« leer(Standard)
(ausgegebener Statuscode: 200 = fehlerfreier Prozessdurchlauf/500 =
Prozessdurchlauf mit Fehler)

« beliebiger numerischer Wert
(glltiger HTTPS-Statuscode, z. B. 200 = fehlerfrei/500 = mit Fehler)

Label Beschriftung des Symbols im Prozessdiagramm

Input und Output

Sowohl der Start-als auch der Stop-Baustein geben einen ggf. erhaltenen Input des vorherigen
Prozessschrittes (bei Start den Prozess-Input) ohne Verdnderung an den nachsten Prozessbaustein
weiter.

Der Stop-Baustein gibt auBerdem den Status des vorherigen Prozessbausteins unverandert weiter
und setzt damit den Ausflihrstatus des Prozesses.

3.3.2 Fork und Join

I Fork und I Join:
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Um zwei oder mehrere voneinander unabhangige Ausfihrungszweige mit demselben Input
auszufiihren, kdnnen Sie eine Gabelung (Fork-Baustein) verwenden. Wieder zusammenfiihren kénnen
Sie die separaten Ausflihrungszweige mit einem Jo1in-Baustein.

1] Get order M I

] oy 1

iy 2k i
< - i

Mapping.xd Put subscribers

Eigenschaften und Parameter

Rotation Drehung der Komponente
Mdgliche Werte:

« 0: nicht drehen(Standard)
« 90: um 90° gegen den Uhrzeigersinn drehen
« 180: um 180° drehen

« 270:um 270° gegen den Uhrzeigersinn drehen

Input und Output
Der Fork-Baustein gibt ein Input-Dokument an alle Ausfihrungszweige unverandert weiter.

Der Join-Baustein hingegen behalt die Output-Dokumente des letzten ausgefiihrten Bausteins
innerhalb der Gabelung im Speicher. Wenn es sich um XML-Dokumente handelt, dann kdnnen
samtliche Output-XML-Dokumente mit einem Merge-Baustein in einem XML-Dokument
zusammengefuhrt werden. Wenn die Gabelungen jedoch beispielsweise als letzten Baustein vor dem
Join ein Bindrdokument und ein XSL-Mapping zur dynamischen Parametrierung enthalten, dann kann
ein Transfer-Adapter sowohl die dynamischen Parameter als auch den Binardatenstrom verarbeiten.

Fork und Join verwenden
Ein Ausfihrungszweig kann aus einem oder mehreren Prozessschritten bzw. Bausteinen bestehen.

Die Ausfihrungszweige innerhalb einer Gabelung werden nicht parallel abgearbeitet, sondern anhand
einer Prioritat gesteuert, die an den Ubergédngen durch eine Zahl dargestellt wird. Die Prioritét der
Ausfiihrungszweige kdnnen Sie in den Eigenschaften des Ubergangs festlegen.
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@ Setzen Sie bei Fork/Join-Konstrukten, in denenin einem Ausflihrzweig eine Operation
ausgefiihrt wird (z. B. ein XSL-Mapping zur dynamischen Parametrierung eines Adapters)und

im anderen Zweig lediglich das Input-Dokument durchgeleitet werden soll, einen

i
Verbindungsbaustein( 1 )ein.

\ — e
Document Adapter.fa
121 B 5}
8
Transform

& ACHTUNG: Unerwartetes Verhalten der Prozess-Engine!
Wenn Sie innerhalb einer Schleife, die ein Fork- und Join-Element enthalt, eine weitere
Schleife in Ihrem Prozessdiagramm definieren, dann kann die Prozess-Engine den Status fir
die bereits abgearbeiteten Prozessschritte nicht korrekt zurticksetzen.
Lagern Sie stattdessen die innere Schleife mit smtlichen Prozessbausteinen als Subprozess
aus. Weitere Informationen hierzu finden Sie unter Subprocess.

3.3.3 Merge

F} Merge: Fihrt XML-Dokumente aus unterschiedlichen Quellen zu einem einzigen XML-Dokument
zusammen oder flhrt Text- oder Binardatenstréme zusammen.

Eigenschaften

Label Beschriftung des Symbols im Prozessdiagramm

Root Name des Wurzelelements, das den gesamten Inhalt der zusammengefihrten XML-
Element Dokumente enthalt.

Mdégliche Werte:

« Zeichenkette, die flir XML-Elementnamen qlltig ist.
Standard: Merge

Daten mit Merge zusammenfiihren

Der Merge-Baustein wird meist hinter der Zusammenflhrung einer Gabelung(Join)verwendet. Wenn
XML-Dokumente zusammengefihrt werden, dann enthalt das durch den Merge-Baustein erzeugte
XML-Dokument ein Wurzelelement, das wiederum die Wurzelelemente und sdmtliche Knoten der
zusammengefihrten XML-Dokumente enthalt. Diese XML-Struktur kann vom nachsten
Prozessschritt verarbeitet werden. Der Name des Wurzelelements kann Uber die Eigenschaft Root
Element des Merge-Bausteins festgelegt werden.
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@ Hinweis:
Wenn Gber einen Merge-Baustein XML-Dokumente und mindestens ein Nicht-XML-Dokument
zusammengeflhrt werden, wird die Ausgabe aller Dokumente in dem durch den Merge-Baust
ein erzeugten Output verkettet.

Wenn zwei XML-Dokumente zusammengefihrt werden, die bereits in einem vorherigen Schritt durch
den Merge-Baustein zusammengefihrt wurden, enthalt das Ergebnis-XML-Dokument lediglich ein
Wurzelelement und samtliche Knoten der zusammengefihrten XML-Dokumente.

Zusammenfiihrung von zwei Dokumenten

<?xml version="1.0" encoding="UTF-8" 7>

<Merge>
<l!-- Daten 1 -->
<l-- Daten 2 -->
</Merge>
Wenn die Input-Dokumente Textdaten (MIME-Typ text ... oder application/xml)mit derselben

Zeichenkodierung sind, dann wird deren Zeichenkodierung ausgegeben. Bei unterschiedlicher
Zeichenkodierung wird eine UTF-8-Sequenz ausgegeben. Wenn der MIME-Typ bei allen Input-
Dokumenten gleich ist, dann hat das Ergebnis auch diesen MIME-Typ, ansonsten text/plain.

3.3.4 Condition

<> Condition: Trifft Fallunterscheidungen mithilfe von Verzweigungen im Prozess, wobei jeder
dahinterliegende Zweig bei einer zutreffenden Bedingung ausgefihrt wird.

Eigenschaften

Label Freitextfeld zur Beschriftung des Cond-ition-Bausteins

Condition Ausflhrbedingung (wird automatisch gesetzt). Doppelklicken Sie auf
die Verbindungslinie, um Bedingungen zu hinterlegen.
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Rotation Drehung des Condition-Bausteins auf der Zeichnungsflache in Grad,
um je nach Anordnung der Prozessbausteine (auch von rechts nach
links oder von unten nach oben) den Ablauf korrekt darzustellen

Madgliche Werte:

« 0: keine Drehung(Standard)
« 90: um 90° gedreht

« 180: um 180° gedreht

« 270: um 270° gedreht

® Verwenden Sie in Schleifen beim Ricksprung vom Bedingungsbaustein zum ersten
Schleifenbaustein sowie zwischen einem Bedingungsbaustein und einem direkt darauf
folgenden Stop-Baustein einen Verbindungsbaustein (Connection).

! "
@=L —= 03

o
) I

Start Document Adapter Transform Document
Y
[ —I1] [y
—|— |—
L= ) r—b
Document [z].p@ ot Adapter
Transform

AdTyter Transform ’ Stop

I o
Il

3.3.4.1  Bedingungen erstellen und verwenden

Mit dem Condition-Baustein kdnnen Sie Verzweigungen im Prozess abbilden, wobei jeder
Ausfihrungszweig eine Bedingung enthalten muss.
Flr Fallunterscheidungen kénnen Sie Bedingungen definieren anhand von:

© SoftProject GmbH 51



X4 ESB

- Ausflihrstatus(Statuswert) eines bereits ausgefiihrten Prozessschritts
« Parametern(globalen, System- oder Projekt-Parametern)
« Kontextvariablen

Alle Werte werden zur Prozesslaufzeit vom X4 Server ausgewertet.

Wenn Sie fr einen Ausfihrungszweig keine Bedingung festgelegt haben, wird dieser immerausgefih
rt. Dies wird durch ein halbtransparentes Symbol des Condition-Bausteins dargestellt. Wenn
mehrere Bedingungen zutreffen, werden alle entsprechenden Zweige gemaB deren Prioritat
nacheinander ausgefihrt.

® Voraussetzungen
Um den Condition-Baustein korrekt nutzen zu kdnnen, missen folgende Voraussetzungen
erfillt sein:

« Ein Condition-Baustein muss mindestens zwei Ausflihrungszweige besitzen.

« Ausfihrungszweige dirfen nicht komplett leer sein. Mindestens ein Ausfihrungszweig
muss einen Prozessbaustein enthalten.

« Firjeden Ausfiihrungszweig muss mindestens eine eindeutige und gultige Bedingung
definiert werden.

» Der Condition-Baustein sollte sich nicht innerhalb eines Fork/Join-Konstruktes
befinden.

3.3.4.1.1 Condition-Baustein in einen Prozess einflgen

Grundsatzlich gehen Sie wie folgt vor, um den Condition-Baustein in einen Prozess einzufligen:
1. Ziehen Sie den Condition-Baustein © per Drag&Drop aus der Palette in die
Zeichnungsflache.

2. Definieren Sie Ubergangslinien vom davor liegenden Prozessbaustein zum Cond1tion-Baustei
nund fur die Ausfihrungszweige.
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3. Doppelklicken Sie auf den Condition-Baustein oder einen der dahinter liegenden
Ausfiihrungszweige, um den Condition Editor zu 6ffnen.

¥4 Condition Editor O
Branch
Parameters w BRAMNCH [#2 "' -= 24""] w
> Project Parameters
5 Global Parameters
» Systemn Parameters D_% &),
4
| O
[E]
' o
O—+—— .
~ ]
Start Check parameter Stop
value

Condition

& T/F CURRENT_PROJECT (String) [Systern Parameter] = MyX4Project

of A
o

noT

I Delete CURRENT_PROJECT (String) [System Parameter] = MyX4Project

Edit Condition
ﬂComponents B Parameters @ Variables

If result of CURRENT_PROJECT (String) [System Parameter] MLIE v MyX4Project

Close

4. Legen Sie im Condition Editor mindestens eine Bedingung fiir jeden Ausflihrungszweig fest.
Klicken Sie dazu auf einen Ubergang hinter dem Cond-i tion-Baustein, um einen
Ausfiihrungszweig zu wahlen. Der gewahlte Ubergang wird nun rot gestrichelt hervorgehoben.
Sie kodnnen im Condition-Bereich jetzt Auswertungskriterien wahlen (anhand des
Ausflihrstatus, anhand von Parametern (globalen, System- oder Projekt-Parametern) sowie
anhand von Kontextvariablen, siehe unten).

® Jede Bedingung kann aus mehreren Bedingungselementen bestehen, die Sie Uber
logische Operatoren (AND, OR und NOT) verkniipfen bzw. kombinieren und verschachteln
konnen. Weitere Bedingungselemente konnen Sie Uber die entsprechenden
Schaltflachen einfligen.

5. Klicken Sie auf Close, um die Bedingungen zu speichern.
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& ACHTUNG: Unerwartetes Verhalten der Prozess-Engine!
Wenn Sie innerhalb einer Schleife, die ein Fork-und Join-Element enthalt, eine weitere
Schleife in Ihrem Prozessdiagramm definieren, dann kann der X4 Server den Status fir die
bereits abgearbeiteten Prozessschritte nicht korrekt zurlicksetzen.
Lagern Sie stattdessen die innere Schleife mit sdmtlichen Prozessbausteinen als Subprozess
aus. Weitere Informationen hierzu finden Sie unter Subprocess.

3.3.4.1.2 Bedingungen anhand des Ausfuhrstatus definieren

Mit Condition-Bausteinen kdnnen Sie anhand des Statuswerts eines bereits ausgefiihrten
Prozessschritts eine oder mehrere Bedingungen definieren. So kann beispielsweise Uberprift
werden, ob ein Iterator-Adapter keine Daten mehr liefert, sodass die Prozessausfihrung auf
einen Stop-Baustein umgeleitet und damit beendet wird.

Um eine Bedingung anhand des Ausflhrstatus zu definieren, gehen Sie wie folgt vor:

1. Klicken Sie im Condition Editor auf eine Ubergangslinie hinter dem Cond1 tion-Baustein, um
einen Ausflhrungszweig zu wahlen.

2. Wahlen Sie unter Edit Condition den Prozessbaustein aus, dessen Ausflhrstatus zur
Prozesslaufzeit ausgewertet werden soll.
Hier stehen nur vorangegangene Bausteine des Prozesses zur Auswahl. Alternativ kdnnen Sie
auch einen Prozessbaustein aus der Prozessvorschau per Klick wahlen.

3. Wahlen Sie einen Vergleichsoperator aus(z. B. <, =), und geben Sie einen ganzzahligen
Vergleichswert an, auf den in der Bedingung geprift werden soll, z. B. 1 (ok).
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¥4 Condition Editor O X
Branch
Parameters ~  BRANCH [#2 "SetStatexsl" -= #1 "Stop"] ~
» Project Parameters
» Global Parameters
» Systern Parameters o ) @),
L . o L1
O - TN m * Q
Start SetState.xsl Stop 0o
[£] &

O

Stop

Condition

TIF #2 "SetState.xsl” (Integer) [Transform] [Component] <= 1 (ok)

A
&

of D
0R

noT

9 Delete #2 "SetStatexsl” (Integer) [Transform] [Compenent] <= 1 (ok)

Edit Condition
B Components ] Parameters [_| Variables

If result of ' 22 “SetStatexsl” (Integer) [Transform] [Component] w IS <= v

Close

Bei Bedarf konnen Sie auch Bedingungen mit logischen Operatoren (AND, OR, NOT) verknlipfen

bzw. verschachteln.
4. Klicken Sie auf Close, um die Bedingungen speichern.

3.3.4.1.3 Bedingungen anhand von System-Parametern definieren

Mit Condiition-Bausteinen kdnnen Sie anhand von aktuellen Umgebungsbedingungen die Ausfiihrung
des Technical Processes beeinflussen. Dazu kdnnen Sie in Bedingungen Uber System-Parameter wie %
CURRENT_PROJECT% die aktuellen Werte zur Prozesslaufzeit ermitteln. Weitere Informationen hierzu
finden Sie unter Ubersicht der System-Parameter.

Um eine Bedingung anhand eines Parameters zu definieren, gehen Sie wie folgt vor:

1. Klicken Sie im Condition Editor auf eine Ubergangslinie hinter dem Cond1 tion-Baustein, um

einen Ausflhrungszweig zu wahlen.
2. Wabhlen Sie in der Auswabhlliste links oben den Eintrag Parameters, um darunter in einer Liste

die verfigbaren Parametergruppen und deren Parameter anzuzeigen.
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3. Wahlen Sie den Parameter aus, dessen aktueller Wert zur Prozesslaufzeit ausgewertet werden
soll, z. B. CURRENT_PROJECT.
4. Wahlen Sie einen der folgenden Vergleichsoperatoren:
« =gleichwie ...
« !=ungleich...
« containsenthalt...
« startsWith beginnt mit ...
« endsWithendet mit ...
5. Geben Sie einen beliebigen alphanumerischen Vergleichswert an, auf den geprift werden soll,

z.B. MyX4Project.

¥4 Condition Editor O
Branch
Parameters ~  BRANCH [#3 "Put MyVar" (Put) -> #1 "5top"] -
> Project Parameters
5 Global Parameters
» Systemn Parameters ? &),
Start Variable Put Myvar Stop O
[2] [
O
l
Stop
Condition
& T/F CURRENT_PROJECT (String) [Systern Parameter] = MyX4Project
of A
IR
noT

I Delete CURRENT_PROJECT (String) [System Parameter] = MyX4Project

Edit Condition
[J Components (@ Parameters [ Variables

If result of CURRENT_PROJECT (String) [System Parameter] MLIE v MyX4Project

Close

Bei Bedarf konnen Sie auch Bedingungen mit logischen Operatoren (AND, OR, NOT) verkniipfen

bzw. verschachteln.
6. Klicken Sie auf Close, um die hinterlegte Bedingung zu speichern.
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3.3.4.1.4 Bedingungen anhand von globalen oder Projekt-Parametern definieren

Mit Condiition-Bausteinen kdnnen Sie unter bestimmen Voraussetzungen auch globale oder Projekt-
Parameter flir die Definition von Bedingungen verwenden. Wie mit System-Parametern lasst sich
somit je nach aktuellen Umgebungsbedingungen die Ausflihrung des Technical

Processes beeinflussen.

Um in Bedingungen globale oder Projekt-Parameter im Condition Editor zu verwenden und zur
Prozesslaufzeit auswerten zu kénnen, gehen Sie grundsatzlich wie bei der Definition von
Bedingungen mit System-Parametern vor.

3.3.4.1.4.1 Bedingungen anhand von globalen Parametern definieren

® Beachten Sie jedoch folgende zusatzlichen Voraussetzungen bei globalen Parametern:

« Der globale Parameter muss bereits in der Global Parameter Configuration definiert
sein, um im Condition Editor ausgewahlt werden zu kdnnen. Weitere Informationen
hierzu finden Sie unter Globale Parameter und -gruppen erstellen.

« Der globale Parameter muss zudem auch wahrend der Prozessausfihrung in der Global
Parameter Configuration definiert sein, um zur Laufzeit vom X4 Servers
ausgewertet werden zu kénnen.

« Inden Prozess-Eigenschaften muss in der Eigenschaft Parameter Groups die
entsprechende Parametergruppe ausgewahlt sein. Weitere Informationen hierzu
finden Sie unter Globale Parameter und -gruppen erstellen.

3.3.4.1.4.2 Bedingungen anhand von Projekt-Parametern definieren

® Beachten Sie jedoch folgende zusatzlichen Voraussetzungen bei Projekt-Parametern:

« Der Projekt-Parameter muss bereits in der Datei mit der Endung *.param im Projekt
definiert sein, um im Condition Editor ausgewahlt werden zu konnen. Weitere
Informationen hierzu finden Sie unter Projekt-Parameter.

« Mit Custom Types und Custom Type Values konnen Auswahloptionen flr die
Verwendung im Condition Editor definiert werden. Weitere Information hierzu finden
Sie unter Custom Types erstellen.

3.3.4.1.4.3 Anwendungsbeispiel fir Projekt-Parameter mit Custom Types

Der Custom Type AnswerOptions hat die Werte (Values) YES, NO, MAYBE und Anzeigenamen (Display
Names) yes, no, maybe:
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4 Manage Custom Types

Custom Types Custom Type Values
Add B8 Rename/Refactor w Delete Add B8 Rename/Refactor x Delete
Mame AnswerOption Value Display Name
3 i YES yes
nswerQption NO o
MAYBE maybe

Ok

Die Values sind dann im Condition Editor auswahlbar:
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¥4 Condition Editor O X
Branch
Parameters ~ BRAMCH [#1 "Start" -> #7 "Stop”] -
w Project Parameters
AnswerQptien-1 (AnswerOption)
AnswerQption-2 (AnswerOption) @),
AnswerQption-3 (AnswerOption) : .._.O
w Global Parameters Q
> GlobalParameterGroup Stop E
» System Parameters
2] &

Start Stop
j
Stop
Condition
{':__, TIF AnswerOption-1 (AnswerOption) [Project Parameter] =
of RO
Of
nar
% Delete AnswerOption-1 (AnswerOption) [Project Parameter] =
Edit Condition
(] Components @ Parameters [ Variables
If result of AnswerOption-1 (AnswerOption) [Project Parareter] v|iE|= w )
MO
MAYBE

3.3.4.1.5 Bedingungen anhand von Kontextvariablen definieren

Mit Condition-Bausteinen kdnnen Sie anhand von aktuellen Kontextvariablenwerten Bedingungen
definieren, welche die Ausfihrung des Technical Processes beeinflussen.

Um eine Bedingung anhand einer Kontextvariablen zu definieren, gehen Sie wie folgt vor:

1.

Klicken Sie im Condition Editor auf eine Ubergangslinie hinter dem Cond1tion-Baustein, um

einen Ausflhrungszweig zu wahlen.
Wabhlen Sie in der Auswabhlliste links oben den Eintrag Variables, um darunter eine Liste von

Kontextvariablen anzuzeigen, die bereits im Prozess definiert wurden.
Wahlen Sie die Kontextvariable aus, deren aktueller Wert zur Prozesslaufzeit ausgewertet

werden soll, z. B. myvar.
Wahlen Sie einen der folgenden Vergleichsoperatoren:
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« =gleichwie...
« !=ungleich ...
« containsenthalt...
« startsWithbeginnt mit...
« endsWithendet mit...
5. Geben Sie einen beliebigen alphanumerischen Vergleichswert an, auf den geprift werden soll,
z.B. 1.
¥4 Condition Editor

Branch
Variables ~  BRANCH [#2 "Put MyVar" (Put) -»= #5""]

MyVar

=) Q
ariable Put MyVar Stop &]
]

WS m——— -

:

Stop

Condition

~ 0T Logical MOT of operand

TIF WiyVar (String) [Variable] contains 1

of  finD

OR

¥ Delete MyVar (String) [Variable] contains 1

Edit Cendition
[J Components [_]Parameters (@ Variables

If result of  MyVar (String) [Variable] w i5 contains w1

Close

Bei Bedarf konnen Sie auch Bedingungen mit logischen Operatoren (AND, OR, NOT) verknlpfen

bzw. verschachteln.
6. Klicken Sie auf Close, um die hinterlegte Bedingung zu speichern.

3.3.4.2 Condition Editor

Mit dem Condition Editor kdnnen Sie fiir Condition-Bausteine innerhalb eines Technical Processes
festlegen, wann verschiedene Verzweigungen ausgeflihrt werden sollen. Fir jede Verzweigung lassen
sich Bedingungen definieren, die Statuswerte von vorangehenden Prozessbausteinen,
Kontextvariablenwerte oder Parameterwerte (globale, Projekt- oder System-Parameter) zur
Prozesslaufzeit auswerten.
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So o6ffnen Sie den Condition Editor

1. Offnen Sie einen Technical Process.

2. Doppelklicken Sie im Technical Process auf ein Condition-Symbol < oder auf einen der
Ausfihrungszweige hinter dem Cond1ition-Baustein.
Im Condition Editor wird eine vereinfachte Ansicht des Prozessdiagramms ohne
Zeichnungselemente angezeigt:

¥4 Condition Editor ] x
Branch
Parameters ~ BRANCH [#2" -> #4"] v
» Project Parameters
» Global Parameters
~ System Parameters @

ACTION_ID (Integer)
CALLING_PROCESS (String)
CALLING_PROCESS_NAME (String)
CALLING_PROCESS_PATH (String)
CURRENT_PROCESS (String)
CURRENT_PROCESS_NAME {String) 1
CURRENT_PROCESS_PATH (String) O—b—%_> ) m 1 >

CURRENT_PROJECT (String)

b

o T

Y

HOSTNAME (String) Start Check \.Ll}aa.rj?leter Stop
HTTP_PORT (Integer)

INSTAMCE (String)

IPADRESS (String)

MOWY (String)

MNOW_PLAIM (Integer)
PID (Integer)

PUID (String)
START_PROCESS (String)

Condition
& T/F CURRENT_PROJECT (String) [System Parameter] = MyProject
of A
R
noT

9 Delete CURRENT_PROJECT (5tring) [System Parameter] = MyProject

Edit Condition
BCDmponents B Parameters @ Variables

If result of  CURRENT_PROJECT (String) [System Parameter] s = ~ MyProject |

Close

Rechte Seite des Bereichs Branch

Im Bereich Branch wahlen Sie zunachst auf der rechten Seite Uiber die Auswahlliste den Zweig, fir
den Sie eine Bedingung festlegen mdchten. Alternativ kénnen Sie in der Prozessansicht auch die
gewiinschte Ubergangslinie anklicken, um fiir diesen Zweig eine Bedingung zu definieren.

Ansichtsoptionen fiir die Prozessdarstellung:

Zoomin Ansicht vergréBern
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@, Original zoom Urspringliche GroBe anzeigen
Q Zoom out Ansicht verkleinern

O Zoom to page Alles anzeigen

B Zoom to width Ansicht auf voller Breite

Linke Seite des Bereichs Branch

Auf der linken Seite des Bereichs Branch kdnnen Sie Uber eine Auswahlliste zusatzliche Kriterien zur
Definition von Bedingungen wahlen. Im Bereich darunter werden gemaB lhrer Auswahl alle
verflgbaren Eintrage angezeigt. Als Kriterien stehen folgende Optionen zur Auswahl:

« Parameters: eine Liste der aktuell verfigbaren Parametergruppen und deren Parameter
(System-, Projekt- oder globale Parameter)

® Globale Parameter sind nur auswahlbar, wenn sie bereits in der Global Parameter
Configuration angelegt wurden.
Projekt-Parameter sind nur auswahlbar, wenn sie bereits in der Datei mit der Endung
*.paramdes Projekts angelegt wurden (siehe Projekt-Parameter erstellen).

« Variables: eine Liste der Kontextvariablen, die im aktuellen Technical Process bereits definiert
wurden

Bereich Condition
Im Bereich Condition werden die Bedingungen fir den ausgewahlten Zweig angezeigt und bearbeitet.
Um eine neue Bedingung zu erstellen oder zu bearbeiten, doppelklicken Sie in den Bereich Condition.

Bearbeitungsoptionen fiir Bedingungen:

< Undo Rickgangig machen
(58 Redo Rickgangig gemachten Schritt wiederherstellen
of Cut Auswahl ausschneiden

Copy Auswahl kopieren
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Paste Auswabhl einfligen
A Logical AND Logische UND-Verknlpfung einfligen
oA Logical OR Logische ODER-Verknupfung einfligen
nar Logical NOT Logische NICHT-Verknipfung einfligen
m Delete Markierte Bedingung l6schen
Bereich Edit Condition

Im Bereich Edit Condition kénnen Sie die gewahlte Bedingung erstellen oder bearbeiten. Weitere
Informationen hierzu finden Sie unter Bedingungen erstellen und verwenden.

Edit Condition
Components Parameters (B Variables

If result of CURRENT_PROJECT (String) [System Parameter] v B |= v MyProject

Comp Option, mit der Sie angeben kdnnen, ob in der Auswahlliste If result of Prozessbausteine
onent angezeigt werden sollen, um deren Ausflhrstatus zur Prozesslaufzeit auszuwerten.
s

Para Option, mit der Sie angeben kénnen, ob in der Auswabhlliste If result of eine Liste aller aktuell
meter verfligbaren Parameter(System-, Projekt- und globale Parameter) angezeigt werden soll, um
s deren Werte zur Prozesslaufzeit auszuwerten.

Varia Option, mit der Sie angeben kénnen, ob in der Auswahlliste If result of eine Liste aller im
bles aktuellen Prozess bereits definierten Kontextvariablen angezeigt werden soll, um deren
Variableninhalt zur Prozesslaufzeit auszuwerten.

If In dieser Auswabhlliste wahlen Sie das Kriterium (Prozessbaustein, Parameter oder Variable)
result furlhre Bedingung.
of
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is Hier wahlen Sie einen Vergleichsoperator:

« <kleinerals...

« <=kleiner als oder gleich wie ...

+ =gleich wie ...

« >=groBer als oder gleich wie ...

« >groBerals...

<>ungleichzu ...

Fdr Parameter und Variablen stehen hier folgende Vergleichsoperatoren flr Zeichenketten
zur Verflgung:

« =gleichwie...

« !=ungleich...

« contains enthalt ...

+ startsWithbeginnt mit...
« endsWith endet mit...

(Vergl Im Eingabefeld geben Sie den Wert an, der mit dem ausgewahlten Kriterium verglichen
eichs werden soll.
wert)

a) Bei Bezug auf Prozessbausteine ist dies immer ein numerischer Statuswert:

+ 1: Standardwert bei erfolgreicher Ausfiihrung

« —1: Standardwert bei fehlerhafter Ausfiihrung

« 0: Standardwert bei leerem Ergebnis bzw. noch nicht erreichter erfolgreicher
Ausflhrung

« nnnn: beliebiger ganzzahliger Wert (z. B. 2000) bei Bezug auf ein ConditionState-

Mapping
b) Bei Bezug auf Kontextvariablen und Parameter ist dies ein alphanumerischer
Vergleichswert.

« Inhalt einer zuvor mit Put erzeugten Kontextvariable
« Inhalt eines Parameters (System-Parameters oder zuvor definierten globalen oder
Projekt-Parameters)

3.3.5 Connection

D_%—‘ Connection: Gibt den Input aus dem vorangegangenen Prozessschritt ebenso wie dessen
Status unverandert aus. Es markiert den jeweiligen Ausflihrungszweig fir den X4 Server eindeutig. So
|asst sich mit diesem Baustein in Schleifen der Rlicksprung zum ersten Schleifenbaustein explizit
setzen. Er verbindet einen Condi tion-Baustein mit einem Stop-Baustein oder einen Fork-Baustein
mit einem direkt darauf folgenden Join-Baustein.

Eigenschaft

Label Beschriftung des Symbols im Prozessdiagramm

Output
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Der Verbindungsbaustein gibt den Input unverandert aus, inklusive Ausfiihrstatus des vorherigen
Prozessbausteins.

Beispiele
« Bei Schleifenriickspriingen wird als letzter Schleifenbaustein ein Verbindungsbaustein gesetzt.

» > i\..‘{_. » ||

Adapter Transform

0]

« Bei Fork/Join-Konstrukten, in denen in einem Ausfiihrzweig eine Operation ausgefuhrt wird
(z. B. ein XSL-Mapping zur dynamischen Parametrierung eines Adapters)und im anderen Zweig
lediglich das Input-Dokument durchgeleitet werden soll, wird ein Verbindungsbaustein gesetzt.

— = — I_. !
Document Adapter.fa
Transform
« Zwischen einem Condition-Baustein und einem Stop-Baustein wird ein Verbindungsbaustein

gesetzt.

[1]
Stop

3.3.6 Pause

@ Pause: Definiert Wartezeiten innerhalb eines Prozesses. Nach einer festgelegten Dauer oder zu
einem bestimmten Zeitpunkt wird die Ausfiihrung des Prozesses fortgesetzt. Dabei kann ein Pause-B
austein einen Input vom vorangegangenen Prozessbaustein erhalten und diesen an den darauf
folgenden Prozessbaustein unverandert weitergeben.

Eigenschaften

Label Beschriftung des Symbols im Prozessdiagramm

© SoftProject GmbH 65



X4 ESB

Duration Dauer der Pause

Mogliche Werte:

« beliebige Dauer mit Angabe von Tagen, Stunden, Minuten,

Sekunden und Millisekunden

« 9999d 23h 59m 59s 999ms: maximale Wartezeit pro Pause-

Baustein

« 0d 6h Om 0s Oms: keine Wartezeit (Standard)

@ Alternativ zur Angabe einer Wartezeit lasst sich (iber Unti1 ein
Endzeitpunktim Format yyyy-MM-dd hh:mm:ss flir die Pause

festlegen, z. B. 2010-08-30T01:55:10.

@ Um die Pausendauer zu definieren, doppelklicken Sie auf den Pause-Baustein, oder klicken
Siein der Sicht Properties unter Duration auf Eud . AnschlieBend definieren Sie die Dauer im

Dialogfenster Duration.

w . Duraticn O

Configure Interval

[==]

4816

[==]
—_
(=

O) Unil |:.‘-.:4.-:-:-:-: |

-
-

{® Duration |0 | Days |0 | Hours |0 = Minutes [0 2 Seconds |0 | Milliseconds
Y

3.3.6.1 Pause-Baustein dynamisch parametrieren

Der Pause-Baustein Iasst sich tGber die technischen Parameter sleep_time und sleep_untilauch

dynamisch parametrieren.

« Dynamische Parametrierung iiber sleep_time
Im folgenden Beispiel wird der Pause-Baustein auf eine Pausendauer von 5 Sekunden
parametriert:
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Dynamische Parametrierung iiber sleep_time

<?xml version="1.0" encoding="UTF-8"7?>
<xsl:stylesheet xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform" version="2.0">
<xsl:output method="xml" media-type="text/xml"></xsl:output>
<xs'l:template match="/">
<!-- Pause duration 5 seconds / used format "0(d):0(h):0(m):0(s).0(ms)"-->
<xsl:processing-instruction name="DynamicParameter">
<xs'l:text>sleep_time="0:0:0:5.0"</xsl:text>
</xsl:processing-instruction>
<Empty></Empty>
<!-- <xs'l:processing-instruction name="NoResult"></xsl:processing-
instruction> -->
</xsl:template>
</xsl:stylesheet>

« Dynamische Parametrierung iiber sleep_until
Im folgenden Beispiel wird der Pause-Baustein auf das aktuelle Datum und die aktuelle Uhrzeit
zuziglich 1Minute und 15 Sekunden parametriert:

Dynamische Parametrierung iiber sleep_until

<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform" xmlns:xs="http
://www.w3.0rg/2001/XMLSchema" version="2.0">
<xsl:output method="xml" media-type="text/xml"></xsl:output>
<xsl:template match="/">
<xsl:processing-instruction name="DynamicParameter'">
<xsl:text>sleep_until="</xsl:text>
<xsl:value-of select="format-dateTime(current-dateTime()+
xs:dayTimeDuration('PTOH1IM15S"),'[YOOO01]-[MO1]-[DO1] [H10]:[mO1]:[s01]')"></xsl:
value-of>
<xsl:text>"</xsl:text>
</xsl:processing-instruction>
<l-— <Empty></Empty> -->
<xsl:processing-instruction name="NoResult"></xsl:processing-instruction>
</xsl:template>
</xsl:stylesheet>

3.3.7 Counter

En Counter: Ermdglicht die Implementierung von Zahlschleifen in Prozessen. Hierfur wird in der
Eigenschaft Start ein Anfangswert und in der Eigenschaft End ein Endwert gesetzt. Bei jedem
Durchlauf des Zahlers wird dessen Wert um die in Eigenschaft Step Size angegebenen Wert
verringert bzw. erhdht, bis der Endwert erreicht ist. Uber ein XSLT-Mapping lassen sich die
Eigenschaften dynamisch setzen und der aktuelle Index kann Gber indexName in eine Variable
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gespeichert werden.
Eigenschaften

Start
Dynamischer
Parameter: start

Anfangswert, von dem heruntergezahlt bzw. hochgezahlt wird

Mdgliche Werte: beliebige ganze Zahl, die groBer o ist

® Der Anfangswert wird beim Durchlauf nicht mitgezahlt. Beachten Sie,
dass der Startwert (start)lediglich beim ersten Schleifendurchlauf
dynamisch parametriert werden kann.

End
Dynamischer
Parameter: end

Endwert, bis zu dem heruntergezahlt bzw. hochgezahlt wird

Mdégliche Werte: beliebige ganze Zahl, die gréBer 0 ist. Wenn der Endwert kleiner
als der Startwert ist, wird heruntergezahlt. Andernfalls wird hochgezahlt.

® Der Endwert wird beim Durchlauf nicht mitgezahit.

Step Size
Dynamischer
Parameter: step

Label

Index Name
Dynamischer

Zahlschritte fur das Hochzahlen bzw. Herunterzahlen, z. B. 2

Mdgliche Werte: beliebige ganze Zahl, die groBer o ist

Beschriftung des Symbols im Prozessdiagramm
Name der Variablen

Parameter: Mogliche Werte: Name der Variablen, um auf den aktuellen Index des Zahlers
indexName zuzugreifen
Input

Der Baustein erwartet nur dann einen Input, wenn die Eigenschaften dynamisch gesetzt werden.
Output

Wird die Eigenschaft dynamisch gesetzt, gibt der Baustein eine Variable mit <7ndexName>und den
Wert des aktuellen Index aus. Andernfalls liefert der Baustein keinen Output.

Statuswerte

0 (counting) Zahler l1auft (Endwert wurde noch nicht erreicht)

1 (finished) Herunterzahlen ist beendet (Endwert wurde erreicht)

Beispiel

Einfache Zahlschleife mit Zahler- und Bedingungs-Baustein (Counter und Condi tion). Dabei wurden
die Eigenschaften Start=1, End=4 und Step Size=1 festgelegt. Die Zahlschleife wird zweimal
durchlaufen, da der Anfangswert und der Endwert nicht mitgezahlt werden.
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Start

3.3.8

Document Put x Coupter

Transaction

T Transaction: Fiihrt Prozessschritte transaktionssicher durch: Bei einem Commitwerden
samtliche Operationen auf dem Zielsystem persistent ausgefihrt, bei einem Rollbackwerden alle
Operationen auf den Ursprungszustand vor der Transaktion zuriickgesetzt. Um Prozessschritte in
eine Transaktion zu kapseln, setzen Sie vor und hinter die Prozessschritte die entsprechenden
Transaktionsbausteine. Der Transaktionsbaustein wird hauptsachlich fir JMS-Warteschlangen-
Operationen und fir Datenbankoperationen verwendet.

® Beachten Sie folgende Hinweise:

Transaktionen kdnnen nicht im Debug-Modus des X4 Designers durchgefihrt werden.

Innerhalb von Transaktionen kénnen auch Subprozesse ausgefihrt werden.

Wenn innerhalb einer Transaktion ein Subprozess Uber den Process Starter-Adapter
gestartet wird, dann gilt die Transaktion nicht fiir diesen Subprozess(Transaktionen
sind nicht thread-lbergreifend).

Transaktionen in Transaktionen zu verschachteln ist nicht mdglich.

Innerhalb einer Transaktion konnen mehrere Datenbankverbindungen und
Warteschlangen verwendet werden.

Die verwendete Datenbankverbindung (JDBC DataSource) muss Transaktionen
unterstitzen.

Um Transaktionen ausfihren zu kdnnen, darf bei der Konfiguration der zu
verwendenden Datasource innerhalb der standalone.xml das Attribut jta nicht auf
false gesetzt werden.

Eigenschaften

Label Beschriftung des Symbolsim Prozessdiagramm
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Opera Transaktionsoperation festlegen
tion
Mdgliche Werte:

« Not assigned: noch keine Transaktion festgelegt
» Begin: Transaktion beginnen
« Commit: Transaktion durchfihren/abschlieBen

« Rollback: Transaktion abbrechen undinnerhalb der Transaktion durchgefihrte
Operationen rickgangig machen

Statuswerte

1 Transaktionsbaustein wurde erfolgreich ausgefihrt.
0 Transaktionsbaustein wurde ohne Ergebnis ausgefiihrt.

-1 Wahrend der Transaktion trat ein Fehler auf.

3.3.9 Variable

~7 Variable: Speichert temporar Daten, wahrend ein Technical Process ausgefiihrt wird.
Innerhalb desselben Technical Processes oder eines Subprozesses kdnnen Sie die Variable auslesen.
Mithilfe des context:-Protokolls kdnnen Sie auch in XSL-Mappings auf solche Variablen zugreifen.

Eigenschaften

Operat Bestimmt, ob die Variable initialisiert, verwendet oder verworfen werden soll
ion

Mogliche Werte:

« Put: Daten aus dem vorangegangenen Prozessschritt in der Variable speichern
(Standard)
« Get: Variableninhalt lesen und an den nachsten Prozessschritt weitergeben

« Remove: Variable verwerfen (aus dem Arbeitsspeicher |[6schen)

« Test: Prifen, ob eine Variable vorhanden ist. Ist keine Variable gesetzt, wird der
Status 0 ausgegeben.
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Name  Eindeutige Bezeichnung der Variable

Mdgliche Werte:

« Zeichenkette, die aus alphanumerischen US-ASC//-Zeichen (Aa-Zzund 0-9) sowie aus
Unterstrichen(_) bestehen darf und nicht mit einer Ziffer beginnt (z. B. Report_bData61)

» X4STATE: Enthalt den Status des vorherigen Prozessschritts als XML-Dokument; siehe

Kontextvariablen.

» X4PREVACTION: Enthalt Action ID, Beschriftungstext und Status des vorherigen

Prozessschritts als XML-Dokument

3.3.9.1 Variablen verwenden

In Kontextvariablen lassen sich Daten im Kontext eines aktuell ausgefihrten Technical

Processes zwischenspeichern. Jede Kontextvariable muss zunachst initialisiert werden, also einen
eindeutigen Namen erhalten und mit einem Wert belegt werden (Put-Operation). In spateren
Prozessschritten kann dann per Get-Operation auf die Kontextvariable zugegriffen werden.
SchlieBlich kdnnen Variableninhalte iber die Remove-Operation aus dem Speicher geldscht werden.

Variablen-Baustein erstellen

Variable initialisieren

Variable auslesen

Variable testen

Variable aus dem Speicher [dschen

Innerhalb von XSL-Mappings auf
Prozessvariablen zugreifen

Per Drag&Drop aus der Palette in den Technical
Process ziehen und in der Sicht Properties in der
Eigenschaft Name einen eindeutigen
Variablennamen eingeben(z. B. Vari1)

In der Sicht Properties in der Eigenschaft
Operationden Wert Put wahlen, um die Daten aus
dem vorangegangenen Prozessschritt in die Variable
zu laden

Den Variablen-Baustein mit demselben Namen
erneut einfligen und die Eigenschaft Operation auf
Getsetzen

Den Variablen-Baustein mit demselben Namen
erneut einfligen und die Eigenschaft Operation auf
Testsetzen

Den Variablen-Baustein mit demselben Namen
erneut einfligen und die Eigenschaft Operation auf
Remove setzen

Das context://-URL-Protokoll verwenden, z. B.
Uber den XPath-Ausdruck document (' context://
Varl ')
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3.3.9.2 Kontextvariablen

In Technical Processes stehen standardmaBig eine Reihe von Kontextvariablen zur Verfligung, die
Informationen zur aktuell ausgeflhrten Prozessinstanz liefern. Diese Variablen kénnen Sie sowohlim
Technical Process Uber einen Variable-Baustein Uber die Operation Get als auch in XSL-Mappings
Uber das context:-URL-Protokoll abrufen.

X4STAT Gibt den Status des vorherigen Prozessschritts (unmittelbar vor dem aktuellen
E Prozessschritt)in einem XML-Dokument aus.

Beispiel

<state>-1</state>

X4PREV Gibt Informationen (Action ID, Beschriftungstext und Status)zum vorherigen
ACTION Prozessschritt als XML-Dokument aus.

Beispiel

<action>
<id>4</4d>
<label>File.tra</label>
<state>-1</state>
</action>

Beispiel

Mit diesen Kontextvariablen wird eine erweiterte Fehlerbehandlung erméglicht. So kdnnen Sie z. B.
den Fehlermeldungstext eines Adapters gemeinsam mit dem Adapterstatus ausgeben.

<Merge>

<state>-1</state>

<error>General File Error (see log for details).</error>
</Merge>

Adapter-Fehlermeldung und dessen Statuscode zusammengefihrt in ein XML-Dokument:

1] Get X45TATE [II

@—7—1_ """ - —@

Start File.tra El— ; — Merge Error.xml Stop

ElementWrap.fa

© SoftProject GmbH 72



X4 ESB

3.4  Bausteine im Bereich ,Modules”

Die folgenden Modul-Bausteine verbinden IT-Prozesse mit der AuBenwelt und anderen Prozessen,
beispielsweise in Form von Datenbankverbindungen, Funktions-Adaptern und Subprozessen. Modul-
Bausteine liegen als wiederverwendbare Dateien in der Sicht Projects vor. Deren Konfiguration
erfolgt entweder in der jeweiligen Adapter-Konfiguration oder direkt in einem XSL-Stylesheet (bei
Mappings und Reports).

= Maodules

B I .7 '5,-.;:' @ m —\h T
3 I__ = [

e pr
i ] T

Auf den folgenden Seiten finden Sie weitere Informationen zur Funktion der einzelnen Bausteine.

3.4.1  Function Adapter

Function Adapter: Stellt grundlegende oder zusatzliche Funktionen bereit, etwa
Zeichensatz-Konvertierungen oder ermdglicht beispielsweise den Zugriff auf ein SAP-System. Da der
X4 Designer hauptsachlich mit XML-Daten arbeitet, werden mit Adaptern meist XML-Dokumente
erzeugt oder verandert. Als Output erzeugen Adapter vorwiegend XML-Daten, die in einem nachsten
Prozessschritt weiterverarbeitet werden.

@® Umden Adaptertyp zu wahlen und Parameter festzulegen, doppelklicken Sie in der
Zeichnungsflache auf das entsprechende Funktions-Adapter-Symbol. Die spezifische
Bedeutung der im Folgenden genannten Eigenschaften der Funktions-Adapter istin der
jeweiligen Adapter-Referenz beschrieben.

Eigenschaften

Adapter Name des Adapters
type

Compone Component-Parameter setzen, siehe Component-Parameter verwenden
nt

Paramet
ers

Documen Pfad zum verknlpften Adapter im Repository
t

Label Bezeichnung des Adapters im Technical Process (Freitext)

Operati Bestimmt, welche Operation mit dem Funktions-Adapter durchgefihrt wird. Je nach
on Adapter unterscheiden sich die Werte und Funktionen.

© SoftProject GmbH 73



X4 ESB

Adapter anlegen und verwenden

Adapter lassen sich innerhalb eines ESB-Projekts im Ordner Adapters anlegen. Hierzu stehen zwei

Mdéglichkeiten zur Verfligung:

« Uber das Menu Project > Add Adapter
« Uber das Kontextmenl New > Adapter

Um einen Adapter anzulegen und zu parametrieren, gehen Sie wie folgt vor:

1. Klicken Sie in einem ESB-Projekt mit der rechten Maustaste auf den Ordner Adapters, um das

Kontextmen aufzurufen.
2. Rufen Sie im Kontextmenl New > Adapter auf.

Der File Creation Wizard zum Anlegen von Adaptern wird ge6ffnet.

w. File Creation Wizard

Adapter Type

Select adapter type and enter a file name.,

-

Abas ERP Connector
Ceonnects X4 with abas ERP

Marme Version  Licensed Category Description ()
Bing Maps 1.0.0 true Geo Location Accesses the Bing Maps V1 WebService AP an retrieves geographical in...
Business Data Legger 1.0.0 true ¥4 Tools Converts business data inte events which can be handled by loggers.

Case Management 1.0.0 true X4 Tools APl to access and work with ¥4 Cases,

Case Management Doc..  1.0.0 true ¥4 Tools APl to access and work with decuments,

Case Management Stati... 1.0.0 false X4 Tools Provides statistics for case processes and human tasks.

Charset Changer 1.0.0 true File Processing Changes the encoding of a document. v

Description

File name: | Abas_ERP_Connector_1.fa

5
@

3. Wahlen Sie den gewinschten Adapter aus der Liste.

@ Im Suchfeld kénnen Sie die Adapternamen und Beschreibungen nach einem Stichwort
durchsuchen und somit die angezeigten Adapter einschranken. Zudem kénnen Sie die

Adapter durch Klicken auf den Spaltentitel Category nach Kategorien sortieren.

4. Geben Sie in File name den Adapter-Namen ein.
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5. Klicken Sie auf Finish, um den Adapter in der Sicht Projects anzulegen.

Der Adapter wird im Adapter-Editor zur Konfiguration der Parameter geoffnet.

Case_Management_1.fa &I = 0
Adapter

Type: Case Management Category: X4 Tools

Version:: 1.00

Description: APl to access and work with ¥4 Cases,

Parameter Filter : Fr—
Parameter Value Comment
P Adapter de.softproject.xd.server.bpm.casemanagement.adapter. CaseManagementAdapte o, Implementation class
P Cazeld SCASE_ID%
P CaseProcess SeSTART_PROCESS%
P Caselserld %USER_ID%
Parameter
Name: Adapter Reset

Description: API to access and work with X4 Cases, Reset All

6. Hinterlegen Sie im Adapter-Editor die gewlinschten Parameterwerte, mindestens jedoch die

10.

Pflichtparameter.

Pflichtfelder erkennen Sie am Symbol
P

® « Setzen Sie alle Adapter-Parameter, die vertrauliche Informationen enthalten,
immer dynamisch per XSL-Mapping, z. B. (iber die Processing Instruction Dynami
cParameter. Weitere Informationen hierzu finden Sie unter Benutzerdefinierte
Parameter verwenden. So werden die Zugangsdaten erst zur Laufzeit des
Technical Processes im Adapter gesetzt, und die entsprechenden Parameter
mussen nicht im Adapter angegeben werden und sind somit nicht einsehbar.

« Eine Beschreibung der Parameter fiir einzelne Adapter finden Sie unter

Ubersicht der X4 Adapter.

Speichern Sie den Adapter.

Flgen Sie den Adapter per Drag&Drop aus der Sicht Projects in den Technical Process ein.
Wahlen Sie in der Sicht Properties fir den markierten Adapter in der Eigenschaft Operation ei
ne Adapter-Operation aus.

Der Funktions-Adapter ist nun einsatzbereit.

Speichern Sie den Technical Process.
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3.4.2 XML

lj XML: Bindet wohlgeformte XML-Daten in den Prozess ein. Dabei wird die Zeichenkodierung aus
der XML-Deklaration und der MIME-Typ aus der Dateinamensendung ermittelt.

Eigenschaften

Document Pfad zum verknipften XML-Dokument im Repository
Label Beschriftung des Symbols im Prozessdiagramm
Operation Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Modgliche Werte:

e Read: XML-Dokument in den Prozess einlesen und Daten an den
nachsten Prozessschritt weitergeben (Standard)

» Write: XML-Dokument mit den Daten aus dem
vorangegangenen Prozessschritt speichern

Type Bestimmt den Typ der Datei
Modgliche Werte:

« Resource
« Buffer(Standard)

XML-Dokument erstellen und verwenden

XML-Dokumente lassen sich innerhalb eines ESB-Projekts im Ordner Resources (flir Ressourcen) und
im Ordner TemporaryFiles (fir Puffer-Dateien) anlegen. Hierzu stehen zwei Mdglichkeiten zur
Verfligung:

« Uber das Menl Project > Add XML Document
« Uber das Kontextmeni New > XML Document

1. Klicken Sie im ESB-Projekt mit der rechten Maustaste auf den Ordner, um das Kontextmenu
aufzurufen.
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2. Rufen Sie im Kontextmenli New> XML Document auf.
Eine Auswahl an verfligbaren Vorlagen wird angezeigt.

' File Creation Wizard O *
XML File Name

Select template from the list and enter a file name.

Empty Start with an empty XML

File name: | oIkl

3. Wahlen Sie eine leere Vorlage oder eine vorhandene Vorlage.

4. Geben Sie in File Name den Dateinamen ein.

5. Klicken Sie auf Finish, um das XML-Dokument anzulegen.
Das XML-Dokument wurde angelegt und wird im XML Editor ge6ffnet.

6. Bearbeiten Sie das XML-Dokument wie gewlinscht.

7. Ziehen Sie das XML-Dokument per Drag&Drop aus der Sicht Projects in das Prozessdiagramm.
Beispiel: Zwischen Funktions-Adapter und Stop-Baustein einfligen.

8. Legen Sie in der Sicht Properties in Operation fest, ob das XML-Dokument gelesen (Read)
oder geschrieben (write) werden soll.

3.4.2.1 XML Editor

Mit dem XML Editor kdnnen Sie wohlgeformte XML-Dokumente erstellen und bearbeiten.

® Um den XML Editor zu starten, legen Sie entweder ein neues XML-Dokument an oder 6ffnen
ein bereits vorhandenes Dokument.

Aufbau des XML-Editors

« Zum Bearbeiten von XML-Dokumenten stehen zwei Sichten zur Verfligung: die Sicht Design un
d die Sicht Source. Uber die Registerkarten am unteren Rand des Editors kdnnen Sie zwischen
den Sichten wechseln.
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=] Customer-Data.xml| &

Node Content
22 xml version="1.0" encoding="UTF-8"
~ [e] Root
v [e] Dataset
[e] CustomerlD

[e] CompanyMName
[e] ContactName
[e] ContactTitle
[e] Address
[e] PostalCode
Created by X4 Designer, Copyright @ SoftProject GmbH. All rights reserve...

Design | Source

Design In der Sicht Design wird die Baumstruktur des gedffneten XML-Dokuments tabellarisch
dargestellt. In der linken Spalte befinden sich die verschiedenen Knoten, die Sie auf- und

zuklappen kénnen, sofern Kindknoten existieren. In der rechten Spalte werden die
Inhalte der Knoten angezeigt.

Uber das Kontextmenii kénnen Sie die folgenden Aktionen ausfiihren:

» Remove: Markierten Knoten entfernen

« Add DTD Information: Strukturdefinition in Form einer DTD (Document Type
Definition) hinzufligen

« Edit Namespaces: Namensraume bearbeiten

« Add Attribute: Neues Attribut hinzufligen

« Add Child: Neuen Kindknoten (Element, Processing Instruction usw.) hinzufiigen

+ Add Before: Neuen Knoten vor dem markierten Knoten einfligen

» Add After: Neuen Knoten hinter dem markierten Knoten einfligen

Source In der Sicht Source konnen Sie den Quelltext von XML-Dokumenten bearbeiten.

Dabei unterstitzt Sie der Editor durch folgende Funktionen:

« Syntax-Highlighting: Die verschiedenen Knotentypen werden farblich
hervorgehoben.

« Wohlgeformtheit: Beim Speichern erfolgt eine Prifung auf Wohlgeformtheit des
XML-Dokuments.

« Eingabehilfe: Der Editor macht Vorschlage, wenn Sie neue Elemente einfligen
mochten.

« Pretty-Print: Uber das Menii Source > Format kdnnen Sie |hr XML-Dokument mit
Einrickungen und Zeilenumbrichen lesbarer formatieren.

3.4.5 JSON

r
Ij JSON document: Bindet JSON-Dokumente in den Prozess ein.
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Eigenschaften

Document Pfad zur verknlpften JSON-Datei im Repository
Label Beschriftung des Symbols im Prozessdiagramm
Operation Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Mogliche Werte:

« Read: Dateiin den Prozess einlesen und Daten an den nachsten
Prozessschritt weitergeben (Standard)

« Write: Datei mit den Daten aus dem vorangegangenen
Prozessschritt speichern

Type Bestimmt den Typ der Datei
Mogliche Werte:

¢ Resource
« Buffer(Standard)

JSON-Dokument erstellen

JSON-Dokumente lassen sich innerhalb eines ESB-Projekts im Ordner Resources (flir Ressourcen)
und im Ordner TemporaryFiles (flir Puffer-Dateien)anlegen. Hierzu stehen verschiedene
Moglichkeiten zur Verfligung:

« Uber das Men( Project > Add JSON Document
« Uber das Kontextmenli New > JSON Document
« Uber das Meni New > Add JSON Document

Um ein JSON-Dokument anzulegen, gehen Sie wie folgt vor:

1. Klicken Sie im ESB-Projekt mit der rechten Maustaste auf den Ordner, um das Kontextmenu
aufzurufen.
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2. Rufen Sie im Kontextmeni New > JSON Document auf.
Eine Auswahl an verfligbaren Vorlagen wird angezeigt.

. File Creation Wizard O *
JSON Document File Name

Select template from the list and enter a file name.

Empty Start with an empty JSON Document

File name: ‘ Mjson

(?;' Finish Cancel

3. Wahlen Sie eine leere Vorlage oder eine vorhandene Vorlage.
4. Geben Siein File Name den Dateinamen ein.
5. Klicken Sie auf Finish, um das JSON-Dokument anzulegen.
Das JSON-Dokument wurde angelegt und wird im JSON Editor gedffnet.

3.4.3.1  JSON Editor
Mit dem JSON Editor kdnnen Sie JSON-Dokumente direkt im X4 Designer bearbeiten.

® Um den JSON Editor zu starten, legen Sie entweder ein neues JSON-Dokument an oder
offnen ein bereits vorhandenes Dokument.

In der Sicht Outline wird die Struktur des gedffneten JSON-Dokuments angezeigt. Zudem kénnen Sie
Uber das KontextmenU Quick Outline oder Uber die Tastenkombination STRG+0 die Sicht Quick Outline
offnen, um innerhalb des JSON-Dokuments nach Schlisseln und Werten zu suchen.

Tastenkombinationen

STRG+0 Sicht Quick Outline 6ffnen
STRG+Umschalttaste+F JSON-Code formatieren
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T text_1json 52 = B  I= Outiine 32 = 8

191 ~ {} Object

P v {} "glossary"

o S 'title": "example glossary”

m- v {} Object - ~ {3} "GlossDiv"

= ~ {} "glossary" 5 ‘title™ "S"

76 S "title": "example glossary” v {7} "GlossList"

a v {} "GlossDiv" v {1} "GlossEntry”

| S 'title: 'S 5 "D "SGML"

- v {} "GlossList" 5 "Sorths": "SGML"

12 v {1 "GlossEntry" 5 “GlossTe tandard Generalized Markup Language”

3 : S "ID":"SGML” 5 "Acronym': "SGML"
"para®: “A S "SortAs"; "SGML" languages such as DocBeok.”, 5 "Abbrev": 150 8879:1986"
"GlossSeeAl S "GlossTerm"; "Standard General £} "GlossDef"
"§losssee”: “ma 2 Sy 5 "GlossSee": "markup”
" S "Abbrev"; 'S0 8379:1986"
} v {} "GlossDef"
i 5 "para"; "A meta-markup lan)
¥ + 1 "GlnssSerhlsn” A
< >
Regular expressions enabled|

@ Die Formatierung des JSON-Codes sowie die Farben zur Syntaxhervorhebung kdnnen Sie
unter Tools > Options > JSON Editor andern. Siehe auch JSON-Editor konfigurieren.

3.4.4 Document

Document: Bindet beliebige Nicht-XML-Daten, wie z. B. ASCII-Text oder Binar-Formate, in den
Prozess ein. Dabei wird versucht, den MIME-Typ aus der Dateinamensendung zu ermitteln. Als
Zeichenkodierung wird die System-Zeichenkodierung verwendet.

® wenn Zeichenkodierung und MIME-Typ nicht korrekt ermittelt werden, dann verwenden Sie
den Document Properties Changer, um diese entsprechend zu setzen.

Eigenschaften

Document Pfad zur verknUpften Text- oder Binar-Datei im Repository
Label Beschriftung des Symbols im Prozessdiagramm

Operation Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Mdgliche Werte:

« Read: Dateiin den Prozess einlesen und Daten an den nachsten
Prozessschritt weitergeben (Standard)

« Write: Datei mit den Daten aus dem vorangegangenen
Prozessschritt speichern
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Type

3.4.4.1  ASCII-Deskriptor

Bestimmt den Typ der Datei
Mogliche Werte:

 Resource
« Buffer(Standard)

Ein (ASCIl-)Deskriptor ist ein XML-Dokument, das die Struktur von Datenséatzen in einer Textdatei
beschreibt und u. a. den Adaptern ASCII Writer, COBOL Copybook Writer und COBOL Copybook
Reader als Regeldatei zur Konvertierung zwischen Text- und XML-Daten dient. Der Repository-Pfad
von Deskriptor-Dokumenten wird in diesen Adaptern als Parameter angegeben. Deskriptoren werden
also in der Regel nicht als eigener Baustein in Prozesse eingebunden.

® Fur Textdateien im Cobol Copybook-Format kdnnen Sie ein spezifisches Deskriptor-
Dokument Gber den Cobol Copybook to XML Wizard automatisch erzeugen. Fiir CSV-
Textdokumente verwenden Sie den CSV Converter.

Elemente

<Descriptor>

<Record>

<Column>

Attribute von <Descriptor>

Attribut
Id

Wurzelelement. Enthalt ein oder mehrere Elemente <Record> sowie
die unten genannten Attribute.

Entspricht einem Datensatz in der Textdatei. Kann ein oder mehrere
Elemente <Column> oder <Record> sowie die unten genannten
Attribute enthalten.

Entspricht einer Spalte bzw. einem konkreten Wert in der Textdatei
und besitzt die unten genannten Attribute, darf aber keine
Kindelemente besitzen.

Beschreibung
ID des Datensatzes (optional)

® Das Attribut wird im ASCII Reader und ASCI|
Writer verwendet.
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Attribut

Name

Description

RecordSeparator

Columns

RecordOrder

Beschreibung
Name des Wurzelelements im XML-Dokument

® Das Attribut wird im GDV Message Writer sowie im COBOL
Copybook Writer(String)und COBOL Copybook
Reader (String)verwendet.

Beschreibungstext flir den ASCII-Deskriptor (optional)

Trennzeichen flr die einzelnen Datenséatze (optional)

® . Das Attribut wird im GDV Message Writer, im ASCI| Reader
(EscapedString)und ASCIl Writer (EscapedString)
sowie im COBOL Copybook Writer(String)und COBOL
Copybook Reader(String)verwendet.
» Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile(newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab - Cursor um einen vorgegebenen Abstand
weiterriicken (tab)
e \u....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \uGOFF zu 255

Erforderliche Spaltenanzahl des Datensatzes (optional)

@® Das Attribut wird im ASCII Reader (integer)und ASCI|
Writer (integer)verwendet.

Reihenfolge der einzelnen Datensatze (optional)

Mogliche Werte:

« Fix: Die Reihenfolge bleibt wie in der Textdatei.
» Loose: Die Reihenfolge aus dem ASCII-Deskriptor wird
Ubernommen.

® Das Attribut wird im ASCII Reader und ASCI|
Writer verwendet.
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Attribut
RecordLength

Identifier

IdentifierPos

IdentifierLength

TeilsatzPos

Beschreibung
Lange der einzelnen Datensatze (optional)

® Das Attribut wird im GDV Message Reader (integer)verwend
et.

Wert des Datensatz-ldentifikators (optional)

@® Das Attribut wird im ASCII Reader (String)und ASCII
Writer (String)verwendet.

Position der Datensatz-ldentifikatoren (optional)

® Das Attribut wird im GDV Message Reader (integer), im ASCII
Reader (integer)und ASCIl Writer (integer)sowie im COBOL
Copybook Writer (integer)und COBOL Copybook
Reader (integer)verwendet.

Lange der Datensatz-Identifikatoren (optional)

® Das Attribut wird im GDV Message Reader (integer), im ASCII
Reader (integer)und ASCIl Writer (integer)sowie im COBOL
Copybook Writer (integer)und COBOL Copybook
Reader(integer)verwendet.

Gibt die Position innerhalb der Record-Daten an

@® Das Attribut wird im GDV Message Reader (integer) verwend
et.

Madgliche Werte:

« Identifier = TeilsatzPos: Sub-Records werden gelesen.
» 0: Eswerden alle Sub-Records gelesen.
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Attribut
Suffix

Prefix

Mandatory

Beschreibung
Suffix-Angabe (optional). Markiert das Ende eines Datensatzes.

® . Das Attribut wird im ASCII Reader (EscapedString)
und ASCII Writer (EscapedString)verwendet.
» Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile (newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab-Cursorum einen vorgegebenen Abstand

weiterricken (tab)
e \Uu....:Hexadezimalzahlen mit 4 Ziffern werden in

ganze Zahlen umgewandelt, z.B. \u®OFF zu 255
Prafix-Angabe (optional). Markiert den Beginn eines Datensatzes.

® . Das Attribut wird im ASCII Reader (EscapedString)
und ASCII Writer (EscapedString)verwendet.
« Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile(newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab - Cursor um einen vorgegebenen Abstand

weiterriicken (tab)
e \u....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \uGOFF zu 255

Datensatz als Pflichtdatensatz deklarieren (optional)

® Das Attribut wird im ASCIl Reader und ASCI|
Writer verwendet.

Mogliche Werte:

« true: Pflichtdatensatz
- false: kein Pflichtdatensatz
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Attribut
Multiple

Length

Separator

Attribute von <Record>

Attribut
Id

Beschreibung
Datensatz kann mehrfach vorhanden sein (optional)

® Das Attribut wird im ASCII Reader und ASCI|
Writer verwendet.

Madgliche Werte:

- true: Datensatz kann mehrfach vorhanden sein (siehe Attribut
Occurs).
Das Attribut Occurs muss hierbei einen Wert enthalten, da sonst
der Fehler java. lang. NumberFormatException: null
ausgegeben wird.

« false: Datensatz darf nur einmal vorhanden sein.

Erforderliche Lange des Datensatzes in Zeichen (optional)

® Das Attribut wird im ASCII Reader (LengthFormat)und ASCII
Writer (LengthFormat)verwendet.

Trennzeichen fiir die einzelnen Datensatze (optional)

® . Das Attribut wird im ASCII Reader (EscapedString)
und ASCII Writer (EscapedString)verwendet.
» Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile (newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab - Cursorum einen vorgegebenen Abstand
weiterriicken (tab)
e \Uu....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \ueOFF zu 255

Beschreibung
ID des Datensatzes (optional)

@® Das Attribut wird im ASCII Reader (String)und ASCII
Writer (String)sowie im COBOL Copybook Writer (String)
und COBOL Copybook Reader (String)verwendet.
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Attribut

Name

Prefix

Suffix

Beschreibung
Name der Datensatz-Elemente im XML-Dokument

® Das Attribut wird im GDV Message Reader und im GDV
Message Writer, im ASCIl Reader (String)und ASCI|
Writer (String)sowie im COBOL Copybook Writer (String)
und COBOL Copybook Reader (String)verwendet.

Prafix-Angabe (optional). Markiert den Beginn eines Datensatzes.

® . Das Attribut wird im ASCII Reader (EscapedString)
und ASCII Writer (EscapedString)sowie im COBOL
Copybook Writer(String)und COBOL Copybook
Reader(String)verwendet.
« Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile(newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab - Cursor um einen vorgegebenen Abstand
weiterriicken (tab)
» \u....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \u®OFF zu 255

Suffix-Angabe (optional). Markiert das Ende eines Datensatzes.

® . Das Attribut wird im ASCI| Reader (EscapedString)
und ASCII Writer (EscapedString)sowie im COBOL
Copybook Writer(String)und COBOL Copybook
Reader(String)verwendet.
« Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile (newline)
« \r: Wagenriicklauf(carriage return)
« \t: Tab - Cursor um einen vorgegebenen Abstand
weiterriicken (tab)
e \u....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \uGOFF zu 255
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Attribut
Mandatory

Multiple

IdentifierPos

IdentifierLength

Identifier

Beschreibung
Datensatz als Pflichtdatensatz deklarieren (optional)

® Das Attribut wird im ASCII Reader und ASCII Writer sowie
im COBOL Copybook Writer und COBOL Copybook
Reader verwendet.

Madgliche Werte:

- true: Pflichtdatensatz
« false: kein Pflichtdatensatz

Datensatz kann mehrfach vorhanden sein (optional)

® Das Attribut wird im ASCII Reader und ASCII Writer sowie
im COBOL Copybook Writer und COBOL Copybook
Reader verwendet.

Madgliche Werte:

- true: Datensatz kann mehrfach vorhanden sein (siehe Attribut
Occurs).
Das Attribut Occurs muss hierbei einen Wert enthalten, da sonst
der Fehler java. lang.NumberFormatException: null
ausgegeben wird.

« false: Datensatz darf nur einmal vorhanden sein.

Position der Datensatz-ldentifikatoren (optional)

® Das Attribut wird im ASCII Reader (integer)und im ASCII
Writer (integer)verwendet.

Lange der Datensatz-Identifikatoren (optional)

® Das Attribut wird im ASCII Reader (integer)und im ASCII
Writer (integer)verwendet.

Wert des Datensatz-ldentifikators (optional)

® Das Attribut wird im GDV Message Reader und im GDV
Message Writer, im ASCIl Reader (String)und ASCI|
Writer (String)sowie im COBOL Copybook Writer (String)
und COBOL Copybook Reader (String)verwendet.
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Attribut Beschreibung
ColumnSeparator Spalten-Trennzeichen (optional)

® . Das Attribut wird im ASCII Reader (EscapedString)
und ASCII Writer (EscapedString)sowie im COBOL
Copybook Writer(String)und COBOL Copybook
Reader(String)verwendet.
« Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile (newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab - Cursor um einen vorgegebenen Abstand
weiterriicken (tab)
» \u....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \u@OFF zu 255

Columns Erforderliche Spaltenanzahl des Datensatzes (optional)

ColumnOrder Reihenfolge der Spalten

@ Das Attribut wird im ASCII Reader und im ASCI|
Writer verwendet.

Madgliche Werte:

» Fix: Die Reihenfolge bleibt wie in der Text-Datei.
« Loose: Die Reihenfolge aus dem ASCII-Deskriptor wird
Ubernommen.

Occurs Anzahl der Wiederholungen des Datensatzes

® Das Attribut wird im ASCII Reader (integer)und ASCI|
Writer (integer)sowie im COBOL Copybook Writer(integer)
und COBOL Copybook Reader (integer)verwendet.

Description Beschreibungstext fiir den Datensatz(optional)

Length Erforderliche Lange des Datensatzes in Zeichen (optional)

® Das Attribut wird im GDV Message Reader (integer), im ASCII
Reader(LengthFormat)und ASCII Writer (LengthFormat)
sowie im COBOL Copybook Writer (integer)und COBOL
Copybook Reader (integer) verwendet.
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Attribute von <Column>

Attribut
Id

Name

Type

Prefix

Beschreibung
Spalten-ID (optional)

@® Das Attribut wird im ASCII Reader (String)und ASCII
Writer (String)sowie im COBOL Copybook Writer(String)
und COBOL Copybook Reader (String)verwendet.

Name des Feld-Elements im XML-Dokument

® Das Attribut wird im GDV Message Reader (String), im ASCI|
Reader(String)und ASCIl Writer (String) sowie im COBOL
Copybook Writer(String)und COBOL Copybook
Reader (String)verwendet.

Datentyp der Spalte bzw. des Felds

® Das Attribut wird im GDV Message Writer (Integer |
String), im ASCII Reader (Integer|String)und ASCII
Writer (Integer |String)sowie im COBOL Copybook
Writer (Integer|String)und COBOL Copybook
Reader(Integer|String)verwendet.

Madgliche Werte:

« String: Zeichenkette
o Number: Zahlenwert

Prafix-Angabe (optional). Markiert den Beginn eines Feldwerts.

® . Das Attribut wird im ASCII Reader (EscapedString)
und ASCII Writer (EscapedString)sowie im COBOL
Copybook Writer(String)und COBOL Copybook
Reader(String)verwendet.
« Im Falle von EscapedString werden einige Escape-
Zeichen automatisch ersetzt:
« \n: neue Zeile(newline)
« \r: Wagenricklauf (carriage return)
« \t: Tab - Cursor um einen vorgegebenen Abstand
weiterriicken (tab)
» \u....:Hexadezimalzahlen mit 4 Ziffern werden in
ganze Zahlen umgewandelt, z.B. \uGOFF zu 255
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Attribut
Suffix

Mandatory

Multiple

IdentifierPos

IdentifierLength

Identifier

Beschreibung
Suffix-Angabe (optional). Markiert das Ende eines Feldwerts.

Feld als Pflichtfeld deklarieren (optional)

® Das Attribut wird im ASCII Reader und ASCII Writer sowie
im COBOL Copybook Writer und COBOL Copybook
Reader verwendet.

Mogliche Werte:

o true: Pflichtfeld
- false: kein Pflichtfeld

Feld kann mehrfach vorhanden sein (optional)

® « Das Attribut wird im ASCIl Reader und ASCI|
Writer verwendet.

Mdgliche Werte:

« true: Feld kann mehrfach vorhanden sein.
o false: Feld darf nur einmal vorhanden sein.

Position der Spalten-ldentifikatoren (optional)

@® Das Attribut wird im ASCII Reader (integer)und ASCI|
Writer (integer)verwendet.

Lange der Spalten-ldentifikatoren (optional)

@® Das Attribut wird im ASCII Reader (integer)und ASCI|
Writer (integer)verwendet.

Wert des Spalten-Identifikators (optional)

® Das Attribut wird im ASCII Reader (String)und ASCI|
Writer (String)verwendet.
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Attribut
Default

Regex

Length

RecordMultiplicator

Beschreibung
Standardwert des Felds (nur bei Pflichtfeldern)

@® Das Attribut wird im ASCII Reader (String) und ASCII
Writer (String)sowie im COBOL Copybook Writer (String)
und COBOL Copybook Reader (String)verwendet.

Regularer Ausdruck, der die Spaltenwerte beschreibt (optional)

@® Das Attribut wird im ASCII Reader (String)und ASCII
Writer (String)sowie im COBOL Copybook Writer (String)
und COBOL Copybook Reader (String)verwendet.

Beispiel: *[0-9a-fA-F]+. *

Erforderliche Feldldnge in Zeichen (optional)

® . pas Attribut wird im GDV Message Reader (integer)und
im GDV Message Writer (integer), im ASCIl Reader
(LengthFormat)und ASCIlI Writer (LengthFormat) sowie
im COBOL Copybook Writer(LengthFormat)und COBOL
Copybook Reader (LengthFormat)verwendet.
« Im COBOL Copybook Writer und COBOL Copybook

Reader sind folgende Wert-Angaben maglich:

» ganze Zahlen:z.B.10 wird als 10,0 interpretiert

+ keine Angabe: wird als 0,0 interpretiert

» Dezimalzahlen: z.B.10.2 wird als 10,2 interpretiert

Datensatz wiederholen

® Das Attribut wird im COBOL Copybook Writer und COBOL
Copybook Reader verwendet.

Magliche Werte:

« true: spezielles Feld (angegeben in RecordMultiplicated)
wiederholen
« false: Feld nicht wiederholen
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Attribut
RecordMultiplicated

Binary

Occurs

3.4.5  Subprocess

e@—

—

Beschreibung

ID des mehrfach auftretenden Datensatzes (falls
RecordMultiplicator auf truegesetztwurde)

® Das Attribut wird im COBOL Copybook Writer (integer)
und COBOL Copybook Reader (integer)verwendet.

Beim Lesen/Schreiben werden die Daten von Base64 nach binar bzw.

von binar nach Baseb4 kodiert

® Das Attribut wird im COBOL Copybook Writer und COBOL
Copybook Reader verwendet.

Anzahl der Wiederholungen der Spalte

® Das Attribut wird im COBOL Copybook Writer (integer)
und COBOL Copybook Reader (integer)verwendet.

oo Subprocess: Bietet die Moglichkeit, Teile von Prozessen bzw. Teilprozesse in separate
Prozessdateien auszulagern. Sie kdnnen jeden Prozess in einen anderen Prozess als Subprozess
einbinden. Dabei kann ein Subprozess einen Input aus dem vorangegangenen Prozessbaustein
erhalten und gibt den letzten Status innerhalb des Subprozesses sowie ggf. ein Output-Dokument an
den darauf folgenden Prozessbaustein im Ubergeordneten Prozess weiter.

® « Um den Subprozess zu bearbeiten, auf das entsprechende Symbol auf der
Zeichnungsflache doppelklicken.
« Falls ein Input- bzw. Output-Schema beim Anlegen des Prozesses hinterlegt wurde,
kann dieses Uber den Kontextmeni-Eintrag Show input schema bzw. Show output
schema aufgerufen werden.

Eigenschaften

Document

Relativer Pfad zum Subprozess

@ Dieser Pfad ist (iber den Parameter workflow dynamisch
parametrierbar. Die Verwendung von Platzhaltern(z. B.
%START_PROCESS_PATH% oder %CALLING_PROCESS_PATH%)ist
ebenfalls mdglich (nicht im Debug-Modus des X4 Designers)
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Label Beschriftung des Symbols im Prozessdiagramm

Teilprozesse als Subprozess auslagern

Bei umfangreicheren Prozessen ist es sinnvoll, zusammenhangende Bausteine als Subprozesse
auszulagern. So wird der Prozess Ubersichtlicher, und die Subprozesse lassen sich mehrfach
verwenden. Prozesse lassen sich praktisch beliebig tief ineinander verschachteln. Subprozesse
werden als separate .wrf-Dateien gespeichert.

@ Prozesse lassen sich wie andere Prozessbausteine per Drag&Drop aus der Sicht Projects in
die Zeichnungsflache des Process Editors ziehen.

1. Markieren Sie mindestens zwei Bausteine inklusive aller Ubergangslinien, die ausgelagert
werden sollen.
2. Rufen Sie die Funktion Pack As Subprocess im Kontextmenu auf:
« Geben Sie in File name den Namen des Subprozesses ein.
« Klicken Sie auf Finish.
3. Der Subprozess mit den markierten Bausteinen wird als eigenstandige Prozessdatei in der
Sicht Projects angelegt. Im Hauptprozess werden die gewahlten Bausteine automatisch durch
den neu angelegten Subprozess-Baustein ersetzt.

3.4.5.1  Private Subprozesse verwenden

Subprozesse konnen privat verwendet werden. Private Subprozesse kénnen nur flr ihren
Elternprozess wiederverwendet werden. Ein privater Subprozess kann entweder neu erstellt oder aus
bestehenden Prozessbausteinen gepackt werden.

Um einen privaten Subprozess zu erstellen, gehen Sie wie folgt vor:

1. Wahlen Sie in der Sicht Projects einen bestehenden Prozess aus.
2. Klicken Sie im Menu auf Project > Add Process....

@ Alternativ
Klicken Sie mit der rechten Maustaste auf einen bestehenden Prozess. Klicken Sie im
Kontextmen( auf New > Process.

Ein neuer Prozess wird als privater Subprozess des bestehenden Prozesses angelegt und kann
bearbeitet werden.

Um einen privaten Subprozess aus bestehenden Prozessbausteinen zu packen, gehen Sie wie folgt
vor:

1. Offnen Sie einen bestehenden Prozess.
2. Markieren Sie mindestens zwei Bausteine inklusive aller Ubergangslinien.
3. Klicken Sie mit der rechten Maustaste auf die markierten Bausteine.
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4. Wahlen Sie im Kontextmen(i Pack as Private Subprocess.

Geben Sie in File name den Namen des Subprozesses ein.

6. Bestatigen Sie mit Finish.
Die markierten Bausteine werden als privater Subprozess angelegt und kénnen dort bearbeitet
werden.

o

3.4.6  Mapping

r; Mapping: Transformiert ein XML-Dokument in einer Quellstruktur Gber ein XSLT-Stylesheet in
eine Zielstruktur (meist XML)und ermdglicht so, die einzelnen Datenelemente einander zuzuordnen
(sog. Mapping). XSLT dient der X4 BPMS zudem als Skriptsprache, mit der Prozessbausteine
dynamisch parametriert werden konnen.

Eigenschaften

Document Pfad zur verknlpften Datei im Repository

Label Beschriftung des Symbols im Prozessdiagramm

Component Component Parameter setzen. Weitere Informationen hierzu finden Sie unter
Parameters Component Parameter verwenden.

Empty Input Keine Daten aus dem vorangehenden Prozessschritt im XSL-Mapping verarbeiten
(X4EMPTYINPUT
) Mogliche Werte:

« true: keine Input-Daten verarbeiten

® WennEmpty Inputauf true gesetztist, wird der Mapping-Baustein
zusatzlich gekennzeichnet.

« false: Input-Daten verarbeiten(Standard)

Skip Dynamic Auswertungvon dynamischen Parametern abschalten. Dies kann die Ausfihrung

Params von XSL-Mappings deutlich beschleunigen.
(X4SKIPDYNPAR
AM) Mogliche Werte:

« true: Auswertung von dynamischen Parameter abschalten

@ WennsSkip Dynamic Params auf true gesetzt ist, wird der Mapping-
Baustein zusatzlich gekennzeichnet.

« false: Dynamische Parameter im XSL-Mapping verarbeiten (Standard)
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Remove X4 X4 Processing Instructions im Mapping-Ergebnis entfernen
Processing
Instructions Mogliche Werte:

« true: X4 Processing Instructions aus dem Ergebnis |6schen (Standard)

« false: X4 Processing Instructions im Ergebnis anzeigen

® WennRemove X4 Processing Instructions auf false gesetztist,
wird der Mapping-Baustein zusatzlich gekennzeichnet.

3.4.6.1  XSL-Mapping anlegen und verwenden
Mappings lassen sich innerhalb eines ESB-Projekts im Ordner Transformations anlegen.

Hierzu stehen zwei Mdglichkeiten zur Verfligung:

« Uber das Menl Project > Add XSL Stylesheet
« Uber das Kontextmeni New > XSL Stylesheet

So legen Sie ein XSL-Mapping an:

1. Klicken Sie im ESB-Projekt mit der rechten Maustaste auf den Ordner Transformations, um das
Kontextmen aufzurufen.

2. Rufen Sie im Kontextmeni New > XSL Stylesheet auf.
Eine Auswahl an verfliigbaren Vorlagen wird angezeigt.

—e e S W P e ]
eation Wizard L

Mapping File Name

/

Select template from the list and enter a file name.

= Empty Start with an empty Mapping
» & Process

» & ReST

File name: My5Stylesheet.xsl

'f?:: Finish Cancel
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3. Wahlen Sie eine leere Vorlage oder eine vorhandene Vorlage.
4. Geben Sie in File Name den Dateinamen ein.
5. Wahlen Sie Finish aus, um das XSL-Mapping anzulegen.
Das XSL-Mapping wurde angelegt und wird im Mapping Editor ge6ffnet.

3.4.6.1.1 Quell-und Zieldatenstruktur im XSL-Mapping definieren

Im ersten Schritt legen Sie die Quelldatenstruktur der Transformation fest. Das heiBt, dass Sie den
linken Bereich des XSL-Mappings mit Quelldaten befillen.

Dazu haben Sie zwei Méglichkeiten:

1. Ziehen Sie ein XML-Quelldokument (XML-Dokument oder XML-Schema) aus der Sicht
Projects per Drag&Drop in den Quelldokument-Bereich des Mapping Editors.
Alternativ kdnnen Sie mit der rechten Maustaste in den Quelldokument-Bereich des XSL-
Mappings klicken und Assign Input auswahlen, um eine Datei zum Einfligen auszuwahlen. Zur
Auswahl stehen alle Projekte aus der Sicht Projects.
+ XSL-Mapping.xsl = B8
v B stylesheet version="2.0"
@ xminsxsl="http://www.w3.0rg/1999/X5L/Transform"
@ xminsxs="http://www.w3.0rg/2001/XMLSchema"
exclude-result-prefixes="xs"
o5 output method="xml" media-type="text/xml"
B B template match="/"
o Created by X4 Designer, Copyright @ 5...

Design| Source

® Der Namespace xmlns:xs="http://www.w3.0rg/2001/XMLSchema" und das Attribut
exclude-result-prefixes="xs" ermdglichen die Verwendung von Datentypen in
Verbindung mit XPath 2.0. Beide Eintrage sind nur in neu angelegten XSL-Stylesheets
enthalten, die nicht auf einer Vorlage basieren.

2. Klicken Sie mit der rechten Maustaste in den Quelldokument-Bereich des XSL-Mappings, und
wahlen Sie Paste Input, um den Inhalt der Zwischenablage einzufiigen.
Beispiel: Sie konnen beim Debuggen eines Prozesses die Daten aus der Sicht Output in die
Zwischenablage kopieren und hier einfligen, oder Sie kénnen XML-Daten aus einem Editor
kopieren und hier einfligen.

Das eingefligte XML-Quelldokument wird in einer Baumansicht dargestellt:
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# *XSL-Mapping.xsl =8
v [ Root v [ stylesheet version="2.0"
v [ Dataset @ xmins:xsl="http://www.w3.0rg/1999/X5L/Transform"
[&] CustomerlD @ xminsxs="http:/fwww.w3.0rg/2001/XMLSchema"
&l CompanyName exclude-result-prefixes="xs"
[e] ContactName <5 output method="xml" media-type="text/xml"
el ContactTitle N template match="/"

[&] Address «— Created by X4 Designer, Copyright @ S..
[e] PostalCode

Im nachsten Schritt legen Sie die Grundstruktur des Zieldokuments im XSL-Mapping an. Dazu gehen
Sie wie folgt vor:

1. Klicken Sie im Stylesheet-Bereich mit der rechten Maustaste auf das Root-Template ( Ef
template match="/"), um das Kontextmeni zu 6ffnen.

2. Wahlen Sie im Kontextmen( XSL Element, um den XSL Element Creation Wizard zu 6ffnen.

3. Fugen Sie alle bendtigten Elemente mit der entsprechenden Hierarchie ein.
Beispiel: Die Struktur des Zieldokuments ist ein HTML-Grundgerist (<html>, <body>), das eine
Tabelle (<table>)mit einer Zeile (<tr>) mit drei Kopfzellen(<th>)und einer weiteren Zeile

(<tr>)mit drei Zellen(<td>) enthalt.

® Wenn Sie bereits die XML-Struktur kennen, die durch das XSL-Mapping erzeugt werden
soll, dann kénnen Sie per Drag&Drop aus der Sicht Projects ein XML-Dokument oder ein
XML-Schema zuweisen. Dieses kdnnen Sie dann als Zielstruktur fiir das Mapping
verwenden.
Beim Zuweisen einer XML-Struktur per Drag&Drop werden Sie gefragt, wie diese
eingefligt werden soll:

+ Full XML structure including data fligt die komplette XML-Dokumentstruktur
inklusive Element-und Attributwerte ein.

« Virtual nodes (structure without data) fligt lediglich die Baumstruktur als
virtuelle Knoten in den Stylesheet-Bereich ein. Erst per Doppelklick oder Gber ein
Daten-Mapping auf einen virtuellen Knoten werden diese tatsachlich in der
Zielstruktur erzeugt.

4. Wenn Sie Text hinzufligen mochten: Wahlen Sie im Kontextmen( Add Other Nodes > Text.
Beispiel: Kopfzeilen-Beschriftung fir die Tabellenkopfzellen einfligen.
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3.4.6.1.2 Daten-Mapping: for-eachverwenden

So bauen Sie mit <xs1:for-each> eine Zielstruktur auf, die sich pro Datensatz wiederholt:

1.

Markieren Sie im Quelldokument die wiederholt vorkommende Knotenstruktur. Halten Sie die S
hift-Taste gedrlickt, und ziehen Sie die Struktur per Drag&Drop auf das zu wiederholende
Zielelement.

Ein for-each-Element wird erzeugt.

Beispiel: Verknlpfen Sie <Dataset> auf diese Weise mit dem zweiten <tr>-Element, um
HTML-Tabellenzeilen dynamisch zu erzeugen.

. Stellen Sie sicher, dass das for-each-Element unmittelbarer Elternknoten des zweiten <tr>-E

lements ist.

3.4.6.1.3 Daten-Mapping: value-ofverwenden

So Ubernehmen Sie mit <xs1:value-of> Knoteninhalte vom Quelldokument in das Zieldokument:

1.

2.

Klicken Sie den Quellknoten an, und ziehen Sie ihn per Drag&Drop auf den Zielknoten.

Beispiel: Weisen Sie das<CustomerName>-Element dem ersten <td>-Element, das

Element <CompanyName> dem zweiten <td>-Element und das Element <Address> dem dritten
<td>-Element zu.

Ziehen Sie weitere Verbindungslinien.

Fir jede Verbindung wird eine Linie angezeigt.

[ XSL-Mappingxsl % = 8
~ [e] Root v B stylesheet version="2.0"
v [€] Dataset @ xminsxsl="http://www.w3.0rg/1999/XSL/Transform"
[e] CustomerlD @ xmins:xs="http://www.w3.0rg/2001/XMLSchema"”
[e] CompanyNat exclude-result-prefixes="xs"
[e] ContactNami 23 output method="xml" media-type="text/xml"
[e] ContactTitle ‘\ G v template match="/"
[e] Address — ~ [€] html
[e] PostalCode \\ v [8] body
v [€] table
v [E] 1r
[l th
\ [l th
\ \ [€] th
~ "% for-each select="Root/Dataset”

\ v [e] 1r
\\\ \a e

= value-of select="CompanyMName"
v [e] td

‘L"' = value-of select="ContactName"

\ ' g

\\l."-_

=5 value-of select="Address"
I-- Created by X4 Designer, Copyright © S...

Design| Source
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3.4.6.1.4 Daten-Mapping: copy-ofverwenden

So kopieren Sie mit <xs1:copy-of> einen Knoten inklusive aller Kindknoten (Elemente, Attribute,
Namespace-Definitionen etc.):

1.
2.

Markieren Sie im Quelldokument den zu kopierenden Knoten.

Halten Sie die Strg-Taste gedrlickt, und ziehen Sie den Knoten per Drag&Drop auf das
Zielelement.

Ein copy-of-Element wird erzeugt.

3.4.6.1.5 Source-Ansicht: XSLT-Funktionen verwenden

®

Beispiel
Die Elementinhalte von ContactName und ContactTitle sollen Uber die Funktion concat
zusammengeflhrt werden.

Wahlen Sie die Registerkarte Source, um das XSL-Mapping im Quelltext anzuzeigen.
Bearbeiten Sie die XSLT-Syntax.

Beispiel: Ersetzen Sie die Zeile <xs1l:value-of select="ContactName"></xsl:value-of>
durch <xsl:value-of select="concat(ContactName, ', ', ContactTitle)"/>.

3.4.6.1.6  Ausgabeformat andern

1.

2.

Passen Sie in Element <xs1:output> in Attribut method="xml1" das Ausgabeformat an.
Beispiel: Zum Erzeugen eines HTML-Dokuments method="htm1" setzen.

Passen Sie in Element <xs1:output> in Attribut media-type="text/xml" den MIME-Typ des
Ausgabedokuments an.
Beispiel: Zum Erzeugen eines HTML-Dokuments mime-type="text/html" setzen.

3.4.6.1.7 XSL-Mapping testen

Wenn ein Input-Dokument verfligbar ist, kénnen Sie die integrierte Vorschaufunktion des Mapping
Editors verwenden.

1.
2.

Speichern Sie das XSL-Mapping mit Strg+S.

Klicken Sie in der Symbolleiste auf P und anschlieBend auf Run Transformation, um das XSL-
Mapping lokal auszuflhren.

Das Transformationsergebnis wird nun in der Sicht Output angezeigt.

3.4.6.1.8 XSL-Mappingin einen Prozess einbauen

1. Ziehen Sie das XSL-Mapping aus der Sicht Projects per Drag&Drop in den gedffneten Prozess.

Beispiel: Zwischen XML-Dokument und Stop-Baustein einfligen.
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2. Definieren Sie bei Bedarf Parameter in der Eigenschaft Component Parameters.
Diese werden beim Ausflhren des Prozesses an XSL-Mapping Ubergeben. Weitere
Informationen hierzu finden Sie unter Prozessbausteine parametrieren.

3.4.6.2  Mapping Editor

Mit dem Mapping Editor kénnen Sie XSL-Mappings in einer grafischen Ansicht erstellen und
bearbeiten. Eine XML-Datenstruktur kann hier mithilfe von XSLT in eine andere XML-Datenstruktur
oder in ein XSL-FO-Dokument transformiert werden. Der Mapping Editor unterstitzt Sie beim
Erstellen eines XSL-Mappings durch eine grafische Oberflache und durch eine automatische
Glltigkeitsprifung des Stylesheets sowie der XPath-Ausdricke.

Bei einem XSL-Mapping sind drei Dokumente involviert:

« XML-Quelldokument (oder ein XML-Schema mit der Strukturinformation)
« XSLT-Stylesheet (dieses wird im Mapping Editor erstellt)
« XML-Ausgabedokument

® Umden Mapping Editor zu starten, legen Sie entweder ein neues Mapping an oder 6ffnen ein
bereits vorhandenes XSLT-Mapping.

Aufbau des Mapping Editors

Der Mapping Editor ist in folgende Bereiche unterteilt:
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¥4 Designer - /ESBProject_1/Transformations/1/XSLMapping sl - XSLMappingaxs!

| File Edit View Project Tools Run Window Help
i Ak o
= Projects x | gR= 8
Filter
| [ [ EsBproject_1
> & Adapters
> & Processes

> & Resources
> & TemporaryFiles
> & Transformations

|| > ® X4Common (Libra

[ Properties x

Property Value

1 Quelldokument-Bereich

2  Verkniipfungsbereich

- o x
Q | u[& O
% XSLMappinguxsl X =n
« [ Data ~ B stylesheet version="1.0"
~ [&] CUSTOMERS Xminsaxsl="httpy//www.w3.0rg/1999/XSL/Transform"
sl CUSTOMERID =% output method ="html” media-type="text/ntmi"
5 COMPANYNAME —————————— 5~ & template match="/"
[& ADDRESS . v & htmi
moy ————— N\ @ xmins="httpy//www.w3.0rg/1999/xhtmI"
& POSTALCODE NN « [ head
5] COUNTRY NN v (@ title
sl PHONE AN \\ T "Customers”
\\ N « & body
N @ style="font-familyCalibri, sans-serif"
N 5 « "8 for-each select="/Data/CUSTOMERS"
O\ v @ div
N v @
N e \alueof select="COMPANYNAME"
AN v Ep
e ¥ value-of select="CITY"
v Ep
@ style="text-alignright"
T “(c) SoftProject GmbH"
£~ Created by X4 Designer 42, Copyright..
| Design| source| .
[ Output X |6d Quick Watch| > Run/Debug Console REBAR =0

Encoding: UTF-8 MIME-Type: text/xmi

<?xml version="1.8" encoding="I150-8859-1"?>
<Data> I
<CUSTOMERS >
<CUSTOMERID>1@1</CUSTOMERID>
<COMPANYNAME>SoftProject GmbH
</COMPANYNAME>
<ADDRESS>Am Erlengraben 3</ADDRESS>
<CITY>Ettlingen</CITY>
<POSTALCODE>76275¢</POSTALCODE>

Connected to: X4 Server (localhost:8080) | Workspace: 1 | Username: demo | X4 Server 7.3.1-SNAPSHOT

In diesem Bereich wird das zu transformierende Quelldokument
oder eine XML-Schema-Datei (. xsd)angezeigt.

Uber das Kontextmenii kdnnen Sie den gewahlten Knoten wie
folgt bearbeiten:

Copy XPath for this element to Clipboard: XPath-

Ausdruck zum entsprechenden Element in die
Zwischenablage kopieren und an anderer
Stelle verwenden
« Assign Input: Input-XML-Dokument zuweisen
« Remove Input: Input-XML-Dokument entfernen
« Paste Input: Input-XML-Dokument aus der

Zwischenablage einfligen

In diesem Bereich werden die Verknlpfungen zwischen Knoten
im Quelldokument und XSL-Stylesheet als verschiedenfarbige
Linien visualisiert.

® Unter Tastenkombinationen im Mapping Editor finden
Sie nutzliche Tastenkombinationen fir die Arbeit mit
XSL-Stylesheets in der grafischen Ansicht des X4
Mapping Editors.
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3

Stylesheet-Bereich

In diesem Bereich bearbeiten Sie den Hauptbestandteil eines
Mappings, das XSL-Stylesheet. Das Stylesheet wird in einer
Baumstruktur angezeigt und bietet Gber das Kontextmen
Zusatzfunktionen fur die XSL-Bearbeitung.

Die verschiedenen Bestandteile des XSL-Stylesheets werdenin
der Baumansicht mit Symbolen und farblichen Hervorhebungen
dargestellt:

« Knoten mit XSL-Anweisungen sind durch eine braune
Schriftfarbe und ein entsprechendes Symbol
gekennzeichnet, z. B. H*E*L for-each select="0atajCustomers" )

« Knoten mit einem XPath-Ausdruck sind durch ein
entsprechendes XPath-Symbol ( =) gekennzeichnet. Um den
XPath-Ausdruck zu bearbeiten, klicken Sie auf dieses
Symbol.

« Virtuelle Knoten (aus der Quellstruktur Gbernommene, aber
noch nicht im Stylesheet explizit vorhandene Knoten) werden
grau dargestellt.

Uber das Kontextmenii kdnnen Sie im Stylesheet-Bereich den
gewahlten Knoten wie folgt bearbeiten:

« Edit XSL Element: XSL-Element bearbeiten
« Rename: Knoten umbenennen
« Element: Element einfligen
« Attribute: Attribut einfligen
- Edit: (bei Processing Instructions, Namespace-
Deklarationen): Knoteninhalt bearbeiten
+ XSL Element: XSL-Element einfligen
« as Child: als Kind-Knoten
» Before: als Knoten vor dem markierten Knoten
« After: als Knoten hinter dem markierten Knoten
- Add other nodes: andere Knoten einfligen (Namespace, Text,
Comment, Processing Instruction)
« Add here: (nur bei virtuellen Knoten): virtuellen Knoten in
tatsachlichen Knoten umwandeln
« Add Processing Instructions: Processing Instructions
hinzufligen, um Parameter dynamisch zu setzen
+ Condition State flr Statusinformationen
« Log Info flr Log-Nachrichten
« Dynamic Parameter zum Setzen von dynamischen
Werten
+ No Result flr leere Mapping-Ausgaben
« Add Parameter: System-, Projekt- oder
globale Parameter einflgen, siehe Parameter erstellen und
verwenden
- Add Parent: Eltern-Element (ibergeordnetes Element)
einflgen
» Cut/Copy/Paste: Auswahl ausschneiden, kopieren und
einflgen
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4

5

 Delete: Knoten l6schen

« Expand/Collapse: Unterelemente des Knotens aufklappen
bzw. zuklappen

« Assign Virtual Nodes: virtuellen Knoten aus einem XML-
Dokument einfligen

« Remove Virtual Node: eingefiigten virtuellen Knoten
entfernen

@ Mit dem XSL Element Creation Wizard kdnnen Sie
einfach und schnell XSL-Mappings erstellen. Der Wizard
bietet neben der kompletten Palette an XSLT 2.0-
Elementen auch die Maglichkeit, die Mappings
bequem Uber das Kontextmenu anzulegen.

Uber den Wizard lasst sich festlegen, ob das neue
Element vor oder nach dem ausgewahlten Element oder
als Kind des ausgewahlten Elements angelegt werden
soll. Funktionen wie Autovervollstandigung oder die
Anzeige aller verfligbaren und erlaubten XSL-Elemente
ermoglichen schnelleres Arbeiten.

Zudem kdnnen die Attribute des XSL-Elements gesetzt
bzw. nach dem Anlegen bearbeitet werden. Zwingend
erforderliche Attribute werden dabei automatisch
Ubernommen, optionale Attribute konnen je nach Bedarf
ausgewahlt und befllt werden.

Bei Attributen, die mehrere Optionen zur Auswahl haben,
wird eine Liste mit den verfligbaren

Werten bereitgestellt.

Source- und Design-Ansicht Der Mapping Editor verfligt iber zwei Ansichten, zwischen denen

Output

Sie Uber zwei Registerkarten wechseln kénnen:

« Design: In der dreispaltigen Design-Ansicht wird das
XSLT-Stylesheet als Baum dargestellt. Hier konnen Sie die
Knoten des Quelldokuments den Knoten im XSLT-
Stylesheet grafisch zuordnen.

« Source: Indieser Quellcode-Ansicht konnen Sie das XSLT-
Stylesheet direkt im XML-Editor bearbeiten.

Das Ergebnis von lokal ausgefilihrten XSL-Mappings wird in der
Sicht Output angezeigt.

AuBerdem kénnen Sie Uber die Symbolleiste die folgenden
Aktionen ausfuhren:

« H save content of output view: Daten aus der Sicht Output
speichern

« le= Format the content of the output view: Daten aus der
Sicht Qutput formatieren
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6  RunTransformation Uber P Run Transformation wird das XSL-Mapping lokal
ausgeflhrt, und das Transformationsergebnis wird in der Sicht
Output (5) angezeigt.

3.4.7 PDF Creator

lj PDF Creator: Transformiert ein XML-Dokument mithilfe eines XSLT-Stylesheets in ein XSL-
FO-Dokument. Dieses wird im selben Prozessschritt iber den XSL-FO-Prozessor Apache FOP 1.0in
ein seitenorientiertes Ausgabemedium umgewandelt. Mogliche Ausgabeformate flr Reports sind
PDF, PDF/A und PostScript.

Eigenschaften

Document Pfad zur verknipften Datei im Repository

Component Component Parameter. Weitere Informationen hierzu finden Sie unter
Parameters Component Parameter verwenden.

Report type Ausgabeformat des Reports

Mdgliche Werte:

« PDF: PDF-Dokument (Portable Document Format)

« PDF/A: PDF-Dokument im Archivierungsformat PDF/A-1bgemaB /SO
19005-1; siehe Hinweis unten

» PS: PostScript-Datei

@ Fir die PDF/A-Option fordert Apache FOP 1.0 fiir jeden Textblock
innerhalb des FO-Dokuments explizit die Festlegung einer Schriftart
Uber das Attribut font-family. Zudem mussen samtliche
verwendeten Schriftarten auf dem System wahrend der PDF/A-
Erzeugung verfligbar sein.

Reports erstellen mit XSL-FO

Mit dem Baustein PDF Creator kénnen Sie zur Laufzeit eines Prozesses dynamisch Dokumente fir
die Druckausgabe (Reports) generieren. Ein Report ist ein spezielles XSL-Mapping, das XML-Daten
transformiert und ein XML-Dokument mit XSL-FO-Anweisungen ausgibt. Das erzeugte XSL-FO-
Dokument wird der X4 BPMS direkt in das angegebene Ausgabeformat umgewandelt und an den
nachfolgenden Prozessschritt weitergegeben.

Die X4 BPMS verwendet Apache FOP als XSL-FO-Prozessor zum Verarbeiten der Reports.
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UberdasXSL—FO—Eknnent<fo:external—graph1c src="url('Pfad/zur/Datei.png')"> kdnnen
Grafikdateien(z. B. GIF, JPEG, PNG, SVG)ins Report-Dokument eingebunden werden. Um Grafiken
aus dem Repository der X4 BPMS einzubinden, kdnnen Sie deren Pfad mit einer xstore: /-URL
angeben, z. B.:

<fo:external-graphic src="url('xstore://Project/Folder/File.png')"
content-width="10mm" content-height="10mm"/>

Mit den optionalen Attributen content-width und content-height kdnnen Sie Breite und Hohe des
Bilds im Ausgabedokument bestimmen.

@ Alternativ kdnnen Sie binire Grafikdateien auch als BaseB4-kodierte Zeichenkette in den
Report nach folgendem Muster einbetten. Weitere Informationen hierzu finden Sie unter
Baseb4 Converter:

<fo:external-graphic src="url(data:;base64,Base64-kodierte Bilddaten)"/>

Bei SVG-Bildern kann zudem deren Quellcode direkt in den Report eingebettet werden, z. B.:

<fo:instream-foreign-object>
<svg:svg xmlns:svg="http://www.w3.0rg/2000/svg"
height="1mm" width="40mm">
<svg:line yl="0" y2="0" x1="0" x2="40mm"
style="stroke:#0000FF;stroke-width:0.5pt" />
</svg:svg>
</fo:instream-foreign-object>

Achten Sie hierbei darauf, dass alle SVG-Elemente den Namespace svg: besitzen.

Beispiel

Im Folgenden ein Beispiel fir ein sehr einfaches (minimales) XSL-FO-Dokument:
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<fo:root xmlns:fo="http://www.w3.0rg/1999/XSL/Format">
<fo:layout-master-set>
<fo:simple-page-master master-name="simple" page-height="29.7cm"
page-width="21cm" margin-left="2.5cm" margin-right="2.5cm">
<fo:region-body margin-top="3cm"/>
</fo:simple-page-master>
</fo:layout-master-set>
<fo:page-sequence master-reference="simple">
<fo:flow flow-name="xsl-region-body">
<fo:block>Hello World</fo:block>
</fo:flow>
</fo:page-sequence>
</fo:root>

@ \Weitere Informationen zum Thema Hyphenation finden Sie unter https://
xmlgraphics.apache.org/fop/2.5/hyphenation.html.

3.5 Elementeim Bereich ,Drawing”

Folgende Zeichnungselemente kdnnen Sie in Technical Processes verwenden:

3.5.1 Connector

/ Connector: Ermdglicht die logische Verbindung von beliebigen Elementen.

® Connector-Verbindungslinien ausschlieBlich zur Visualisierung von logischen

Zusammenhangen!

Bei der Ausfihrung Gber den X4 Server werden ausschlieBlich Prozessbausteine in den

Daten- und Kontrollfluss mit einbezogen, die in Business Processes tiber Sequenzfluss-Linien

(siehe Sequence Flow) bzw. in Technical Processes {iber Transition-Ubergangslinien

verbunden sind (siehe Transition).

Eigenschaften

Label Freitextfeld zur Beschriftung der Verbindungslinie (zur tibersichtlicheren

Gestaltung bzw. Dokumentation)

Line Routing  Linienflhrung
Modgliche Werte:

+ Angled: Angewinkelte Linie
« Straight: Gerade Linie (Standard)
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Line Type Linientyp
Mogliche Werte:

« Dash line: Gestrichelte Linie (Standard)
« Solid line: Durchgezogene Linie

« Dot line: Gepunktete Linie

Line Color Farbe der Verbindungslinie. Um die Farbe zu andern, die Eigenschaft markieren

......

und auf ki klicken.

Modgliche Werte:
« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog

wahlbar)

« RGB(0,0,0): Schwarz(Standard)

Line Source Symbol fir den Linienanfang
Decorator und

Line Target Mégliche Werte:
Decorator

+ Circle: Kreis(Standard)

« Empty arrow: Ungeflllter Pfeil

» Association arrow: Offener Pfeil

« Arrow: Geflllter Pfeil

« Inverted arrow: Umgekehrter Pfeil
« Diamond: Geflllte Raute

« Empty diamond: Ungeflllte Raute

« Plain: Kein Symbol

3.5.2  Rectangle und Ellipse

] Rectangle Zeichnet ein beliebiges Rechteck

-] Ellipse Zeichnet eine beliebige Ellipse

Eigenschaften
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Line Color Rahmenfarbe.Um die Farbe zu &ndern, die Eigenschaft markieren und auf kus:
klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(0,0,0): Schwarz(Standard)
Line Width Linienbreite des Zeichnungselements

Mogliche Werte:

« beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)

Hide Line Rahmenlinie ausblenden

Fill Color Fillfarbe des Zeichnungselements; Um die Farbe zu andern, die Eigenschaft

markieren und auf ki klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(255, 255, 255):WeiB(Standard)

Transparent Zeichnungselement als transparent kennzeichnen. Durch Aktivieren der Eigenschaft
wird die Eigenschaft Fil1l Color aufgehoben.

3.5.3 Textbox

Abc Textbox: Flgt einen Textrahmen ein, dessen Inhalt Sie per Doppelklick in einem Dialogfenster
bearbeiten und formatieren kénnen.

Eigenschaften

Hyperlink Hinterlegte Verlinkung fiir das Textfeld. Zum Verlinken eine giiltige URL eintragen.
@ Mit strg+Klick lasst sich die eingetragene URL aufrufen.

Text Inhalt des Textrahmens; um den Text zu &ndern und zu formatieren, die Eigenschaft
markieren und auf ki Klicken.
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Rotation Drehung des Textrahmens

Mogliche Werte:

0: keine Drehung(Standard)

90: um 90° gegen den Uhrzeigersinn drehen

186: um 180° drehen

276: um 270° gegen den Uhrzeigersinn drehen

Fill Color Flullfarbe des Textfeldes. Um die Farbe zu andern, die Eigenschaft markieren und auf
wd klicken.

Mdgliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (liber den Farbauswahldialog wahlbar)
e RGB(255, 255, 255):WeiB(Standard)

Transparen Textfeld als transparent setzen. Durch Aktivieren der Eigenschaft wird die
t Eigenschaft Fill Color aufgehoben.

3.5.4  Polygon

& Polygon: Zeichnet ein Polygon mit beliebig vielen Eckpunkten.

Eigenschaften

Line Color Rahmenfarbe. Um die Farbe zu &ndern, die Eigenschaft markieren und auf fu:
klicken.

Mogliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (iber den Farbauswahldialog
wahlbar)

« RGB(0,0,0): Schwarz(Standard)
Line Width Linienbreite des Zeichnungselements
Madgliche Werte:

« beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)
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Fill Color Flllfarbe des Zeichnungselements. Um die Farbe zu andern, die Eigenschaft
markieren und auf kad klicken.

Madgliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (Uber den Farbauswahldialog
wahlbar)

« RGB(255,255,255): WeiB (Standard)

Transparent Transparente Fillung(keine Fillfarbe verwenden). Durch Aktivieren der Eigenschaft
wird die Eigenschaft Fi1l Color aufgehoben.

3.5.5  PolylineundLine
AP Zeichnet eine Linie mit beliebig vielen Wegpunkten

Polyline

Yo Zeichnet eine gerade Linie
Line

Eigenschaften

Line Linienfarbe. Um die Farbe zu &ndern, die Eigenschaft markieren und auf ki klicken.
Color
Madgliche Werte:
« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (Uber den Farbauswahldialog wahlbar)
- RGB(0,0,0): Schwarz(Standard)
Line Linienbreite des Zeichnungselements
Width
Madgliche Werte:
 beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)
3.5.6 Image

Image: Flgt einen Bildrahmen ein, mit dem sich eine Grafikdatei vom Typ .gif, . jpg, .png
oder .bmp einbinden lasst.

® Das eingefligte Bild wird im Prozess gespeichert.
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Eigenschaften

Line
Color

Line
Width

Image
File

auf kad klicken.

Madgliche Werte:

« RGB(RRR,GGG,BBB): 24-Bit-RGB-Farbcode (iber den Farbauswahldialog wahlbar)

« RGB(0,0,0): Schwarz(Standard)

Linienbreite des Zeichnungselements

Madgliche Werte:

+ beliebige positive ganze Zahl
« 1:1Pixel breite Linie (Standard)

Pfad der verknlpften Grafikdatei
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4 Mit ESB-Projekten arbeiten

Das X4 Repository ist in Projekten organisiert. Projekte besitzen eine Dateisystem-Struktur und
konnen beliebige Ordner, Prozesse, Prozessbausteine und andere Dateien enthalten.

4.1  Templates

4.2  Die Struktur von ESB-Projekten

ESB-Projekte haben eine vordefinierte und nicht veranderbare Ordnerstruktur, die beim Anlegen
eines neuen ESB-Projektes automatisch angelegt wird.

@ Die automatisch angelegten Ordner und Unterordner konnen nicht geléscht, verschoben oder
umbenannt werden.

Adapters Hier kdnnen beliebig viele Adapter angelegt werden.
Processes Hier konnen beliebig viele Technical Processes(.wrf)angelegt werden.
Resources Hier konnen neben Ordnern auch Ressourcen wie Bilder, Text- und XML-Dokumente

sowie weitere Dateien abgelegt werden.

TemporaryFil Hier werdentemporar verwendete Dateien abgelegt.
es

Transformati Hier kdnnen Transformationen(.xs1)sowie Reports(.rep)abgelegt werden
ons

<Projekt>.ws Webservice-Definition, die automatisch beim Anlegen des Projektes angelegt und
inc nach dem Projekt benannt wird, z. B. ESBProject_Documentation.wsinc.

@® Ein Projekt kann lediglich eine Webservice-Definition enthalten.

4.5 ESB-Projekt anlegen

Sie haben verschiedene Moglichkeiten, um ein BPM-Projekt im X4 Designer anzulegen:

« Uber New ESB Project auf der Welcome-Seite des X4 Designers
« Uber das Kontextmenii New > ESB Project in der Sicht Projects
. Uber das Menti File > New > ESB Project

So legen Sie ein ESB-Projekt an
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1. Wahlen Sie im X4 Designer File > New > ESB Project aus.

w ' Project Creation Wizard O X
New ESB Project
Choose a template from the list.
Empty Start with an empty ESB Project

== Basic Tutorials

Project name:

ESBProject_3

2. Wahlen Sie ein leeres Projekt oder eine vorhandene Projektvorlage aus.

® Eskénnenauch Projekte auf Basis eines Templates aus einer alteren Version der X4
Suite erstellt werden. Diese werden wahrend des Erstellens automatisch migriert.

3. Geben Sie unter Project name den Namen des Projekts ein.

4. Klicken Sie auf Finish, um das Projekt anzulegen.
In der Sicht Projects wird ein leeres ESB-Projekt mit der vordefinierten Struktur angelegt.
Uber das Kontextmenii kénnen Sie nun Elemente fiir Ihr ESB-Projekt auswahlen und im
jeweiligen Ordner anlegen. Welche Optionen im Kontextment verflgbar sind, hangt davon ab,
an welcher Stelle in der Baumstruktur das Kontextmeni aufgerufen wird.

® Wenn Sie beim Anlegen des Projekts den Projekttyp Expert ESB Project auswahlen, konnen
Sie ein leeres ESB-Projekt ohne vorgegebene Ordnerstruktur anlegen und im Expertenmodus
arbeiten. Bei diesem Projekttyp konnen Sie die Ordnerstruktur und die darin enthaltenen
Elemente selbst festlegen.
Hinweise zur Verwendung von ESB-Projekten aus alteren X4-Versionen:
« ESB-Projekte aus X4-Versionen vor 6.x werden automatisch in ein Expert ESB Project

importiert.
« Classic ESB Projectsaus alteren X4-Versionen werden automatisch in ein Expert ESB

Project umgewandelt.

4.4 Projekte verwalten

Erfahren Sie hier, wie Sie Projekte im Repository Navigator verwalten.
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4.4.1  Repository-Elemente importieren

Hier erfahren Sie, wie Sie Projekte sowie verschiedene Ressourcen aus dem lokalen Dateisystem in
die Sicht Projects importieren.

4.41.1  Importieren via Drag&Drop

Aus dem Dateisystem (z. B. vom Desktop oder dem Windows Explorer) konnen Sie eine oder mehrere
markierte Dateien per Drag & Drop in die Sicht Projects und damit ins aktuell verbundene Repository
importieren. Falls eine Datei gleichen Namens am Ziel bereits vorhanden ist, werden Sie aufgefordert,
einen neuen Namen einzugeben.

® Beachten Sie:

« Ordnerstrukturen werden beim Import nicht unterstitzt, verwenden Sie hierzu den
entsprechenden Wizard.

- BeigroBeren Dateilibertragungen (insgesamt tiber 1MB) wird ein Bestatigungsdialog
eingeblendet, da méglicherweise Verzégerungen bei der Ubertragung sowie
Arbeitsspeicher-Probleme auftreten kénnen.

« Importierte Dateien, die Sonder-/Leerzeichen oder Umlaute im Dateinamen enthalten,
mussen zunachst umbenannt werden, bevor Sie diese im X4 Designer 6ffnen kénnen.

» Projekte verfigen Uber eine vordefinierte Struktur, sodass die eingefiigten Dateien nur
im jeweils vordefinierten Ordner abgelegt werden kdnnen, siehe auch Die Struktur von
ESB-Projekten

4.4.1.2 Import Wizard fur Dateien und Projekte nutzen

® Beachten Sie

« Projekte verfligen Uber eine vordefinierte Struktur, sodass die zu importierenden
Dateien nur im jeweils vordefinierten Ordner abgelegt werden kénnen, siehe auch Die
Struktur von ESB-Projekten

+ Projekte konnen lediglich auf oberster Ebene und in der vordefinierten Projektstruktur
importiert werden, siehe auch Die Struktur von ESB-Projekten

1. Menu Projekt > Import aufrufen.
Der Resource Import Wizard wird aufgerufen.
2. Ressource auswahlen.
. Uber Browse die zu importierende Datei (. zip) oder das zu importierende Projekt
wahlen und in New project/file name den entsprechenden Namen eingeben.
3. Finish klicken.
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4.4.2  Repository-Elemente exportieren

Hier erfahren Sie, wie Sie Projekte sowie verschiedene Ressourcen aus der Sicht Projects ins
Dateisystem exportieren.

4.4.2.1 Export Wizard fur Dateien und Projekte nutzen

® Beachten Sie

« Projekte kdnnen nur dann exportiert werden, wenn die oberste Projektebene
ausgewahlt ist.

1. Men( Projekt > Export aufrufen.

Der Resource Export Wizard wird aufgerufen.
2. Zielordner auswahlen.
3. Speichern klicken.

4.4.3 Repository-Elemente intelligent umbenennen

Wenn Sie Dateien im Repository umbenennen méchten, kdnnen Sie (ber den Rename Repository
Resource Wizard die Referenzen in den Prozessen automatisch aktualisieren lassen.

1. Auf das gewlnschte Element im Repository Navigator rechtsklicken, um das Kontextmen zu
offnen.

© SoftProject GmbH 116



X4 ESB

2. Refactor/Rename wahlen.
Der Rename Repository Resource Wizard wird nun geoffnet.

w . Rename Repository Resource Wizard g

Welcome to Rename Repository Resource Wizard

Rename repository rescurce

JadvancedcrRM

Update references

Updating references can last up to some minutes

@' < Back Mext = Finish Cancel

3. In Rename repository resource einen neuen Dateinamen eingeben.
4. Next klicken, um anzuzeigen, welche Referenzen auf die umbenannte Datei angepasst werden.

a

+. Rename Repository Resource Wizard

Files with reference to/AdvancedCRM

Pt

g.ﬂxdvanced CRM/Services/Processes/Repository/&dministration/Category/&dd Categorny. wrf
g;’ldvanced CRM/Services/Processes/Repository/Administration/Category/DeleteCategony.wrf
ghdvanced CRM/Services/Processes/Repository/Administration/Category/Load Categony wrf
g.ﬂxdvanced CRM/Services/Processes/Repository/Administration/Category/UpdateCategony.wrf
gﬁdvanced CRM/Services/Processes/Repository/Administration/Country/AddCountry.wrf
g}ldvanced CRM/Services/Processes/Repository/&dministration/Country/Delete Country wrf
g.ﬂxdvanced CRM/Services/Processes/Repository/Administration/Country/Load Countries.wrf
ghdvanced CRM/Services/Processes/Repository/Administration/Country/UpdateCountry.wrf

< >

? Next > Finish e
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5. Finish klicken, um die gewiinschten Anderungen durchzufiihren.
Die betroffenen Dateien werden nun umbenannt und die entsprechenden Referenzen zu
Prozessen, Ressourcen oder Komponenten angepasst.

4.4.4  Repository-Elemente intelligent verschieben

Sie kdnnen Elemente innerhalb vom Repository verschieben. Dabei kdnnen die Referenzen auf die
verschobene Datei in anderen Prozessen auf Wunsch automatisch angepasst werden.

1. Ressource an die gewlinschte Stelle im Repository verschieben.

® Projekte verfligen Uber eine vordefinierte Struktur, sodass die eingefligten Dateien nur
im jeweils vordefinierten Ordner abgelegt werden kdnnen, siehe auch Die Struktur von
ESB-Projekten

Das Fenster Update references wird gedffnet.
w. Update references >

Update all documents that reference to "JIDBC_Connector_1.fa"?

es Mo Cancel

2. Wenn samtliche Referenzen auf die verschobene Datei bzw. den Ordner geandert werden
sollen:
» YesKklicken.
Das Fenster ConfirmMove wird ge6ffnet. Hier wird angezeigt, von welchen Elementenim
Repository die verschobene Datei verwendet wird.
« OK klicken, um die gewiinschten Anderungen durchzufiihren.

? Unknown Attachment
Beim Verschieben von XSL-Mappings mit referenzierten Input-

und Output-XML-Dokumenten/Schemas mussen diese Dateireferenzen manuell
angepasst werden, falls sich deren relative Pfade geandert haben.
3. Wenn die Referenzen nicht aktualisiert werden sollen: No klicken.

® Tipp
Wenn Sie die Strg-/Alt-Tasten dricken, kdnnen Sie auch mehrere Dateien markieren und
verschieben. Fir jede Datei wird dann das Fenster Update references aufgerufen. Dort
erhalten Sie zusatzlich folgende Moglichkeiten:

« Yes To All: Referenzen flr alle zu verschiebenden Dateien aktualisieren.
« No To All: Alle Referenzen nicht aktualisieren.
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4.45  Repository-Referenzen reparieren

Wenn in einem Prozessdiagramm Repository-Elemente falsch referenziert sind - etwa weil ein
Projekt oder Ordner umbenannt wurde oder von einer veralteten Vorlage erstellt wurde - so kdnnen
Sie diese Referenzen Uber den Repair References Wizard reparieren lassen. Dabei werden die
Pfadangaben fir Prozessbausteine automatisch auf den tatsachlichen Pfad im Repository-Projekt
angepasst.

1. Offnen Sie einen Technical Process, Business Process oder Process Landscape in dem
Referenzen auf Repository-Bausteine fehlerhaft (ausgegraut) sind und ermitteln Sie in der
Properties-Sicht den inkorrekten Pfadbestandteil flir einen markierten Prozessbaustein.

® Beispiel
In einem Prozessdiagramm sind die Prozessbausteine inkorrekt referenziert:
Deren Repository-Pfade verweisen auf das nicht vorhandene Projekt . Diese
Pfadangaben sollen auf den tatsachlichen Projektnamen ProjectName korrigiert
werden.

2. Auf das betroffene Projekt oder den betroffenen Ordner im Repository Navigator rechtsklicken,
um das Kontextmend zu 6ffnen.

3. Repair References wahlen, um den Repair References Wizard aufzurufen.
Im Feld Replacement path wird nun das markierte Projekt bzw. der gewlUnschte Ordnername
angezeigt. Dieser Pfadbestandteil wird im nachsten Schritt automatisch auf die fehlerhafte
Referenzen angewendet.

+ Repair References Wizard O X
Welcome to Repair References Wizard ﬁ E
Choose repository ressource path to be fixed Def

Path to replace

BrokenProjectName |

Replacement path

ESB-Doku

o — —

4. In Path to replace den fehlerhaften Projekt- oder Ordnernamen angeben, den Sie in Schritt 1
ermittelt haben.

5. Next klicken, um eine Liste von Prozessen anzuzeigen, welche die fehlerhaften Referenzen
aufweisen und angepasst werden sollen.

6. Finish klicken, um die gewiinschten Anderungen durchzufiihren.
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4.46  Nichtverwendete Ressourcen ldschen
Wenn im Repository nicht verwendete Ressourcen vorhanden sind, so kdnnen Sie diese Uber den
Project Clean-Up Wizard auflisten und auf Knopfdruck entfernen.
1. Auf das betroffene Projekt im Repository Navigator rechtsklicken, um das Kontextmend zu
offnen.
2. Clean-Up Project wahlen, um den Project Clean-Up Wizard aufzurufen.
Alle nicht verwendeten Dateien werden nun aufgelistet.

@ Dieser Vorgang kann einige Zeit in Anspruch nehmen.

' Project Clean-up Wizard O x

Files to Delete
Select unused files to delete from repository.

[] ESBProject_1/Processes/1-StartStopTransitions.wrf
I:‘ E5BProject_1/Processes/2-Compeonents.wrf

[J ESBProject_1/Processes/3-Conditions-Connections.wrf
[] ESBProject_1/Processes/4-Pausewrf

[] ESBProject_1/Processes/5-ForkloinMerge.wrf

[] ESBProject_1/Processes/6-Variableawrf

[] ESBProject_1/Processes/7-Subprocesseswif

[] ESBProject_1/Processes/8-Counter.wrf

[ Esep roject_1/Resources/statement_1.stm

Done!

Select All | | Clear All

@ o

\£) Cancel

3. Gewlinschte Ressourcen wahlen.

a Achtung: Mdéglicher Datenverlust!
Beachten Sie, dass es mdglich ist, dass Dateien angezeigt werden, die z. B. als
dynamischer Parameter in einem XSL-Mapping referenziert werden.
Ldschen Sie nur Dateien, von denen Sie sicher sind, dass Sie diese nicht mehr
bendtigen!

4. Finish klicken, und das endgiltige Loschen anschlieBend mit Yes bestatigen.

Die Ressourcen wurden nun geldscht.

4.4.7  Repository-Elemente durchsuchen

Hier erfahren Sie, wie Sie innerhalb des Repository mit der Funktion Find in Files nach Texten,
Regularen Ausdriicken und UTF-8-Symbolen suchen kénnen.
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® Beider Suche werden lediglich Dateiinhalte durchsucht. Dateinamen werden bei der Suche
nicht berlcksichtigt.

1. Mend Edit > Find in Files aufrufen.
Das Suchfenster wird aufgerufen.

[2) Find in Files O X

Find: |

Find opticns

[ ] Match case
[ ] Match whole word

[] Use reqular expressions

File type:

* i

Scope

(®) Entire repository Enclosing project Selected itemn

Search Close

2. BeiFind Zeichen eingeben, nach dem gesucht werden soll.
3. Suchoptionen festlegen:
« Match Case: GroB3-/Kleinschreibung bei der Suche beachten.
« Match whole word: Nach dem vollstandigen Wort suchen.
« Useregular expression: Nach reqularen Ausdriicken suchen.
« File type: Dateityp angeben, der durchsucht werden soll, z. B. bpm oder fa.

® Mit der Einstellung x werden alle Dateitypen durchsucht.

4. Umfang der Suche festlegen:
- Entirerepository: Im gesamten Repository suchen.
« Enclosing project: Die Suche im ausgewahlte Projekt ausfihren.
« Selected item: Suche auf ausgewahlte Elemente beschranken.
5. Search klicken.

@ Sie kénnen auch anhand von Adapter-Parametern suchen, sodass beispielsweise alle Adapter
mit einem bestimmten Parameter angezeigt werden.
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4.4.8  Veraltete Projekte migrieren

Veraltete Projekte werden im Repository Navigator besonders gekennzeichnet und werden lediglich
in einer Read-only-Ansicht angezeigt. Um die Projekte weiter zu bearbeiten, bietet der X4 Designer
eine Funktion zur Migration des Projektes in die aktuelle X4 BPMS-Version.

Dazu das gewtinschte Projekt im Repository Navigator wahlen und tUber das Kontextmen( Migrate
Project oder das MenU Project > Migrate Project das Projekt migrieren.

[P Repository Navigator 52 & = O
X4 Server (Default) v Q-
Filter
» [T ESBProject_1 (6.2.0)

[79 MyESBProject

(5 MyWebAppProject
5P ¥4Commaon (Library)

& veraltete Projekte lassen sich ab Version 6.0.0 der X4 BPMS in die aktuelle X4 BPMS-Version
migrieren.
Projekte mit einer Version alter als 6.0.0, missen zunachst manuell auf Version 6.0.0
aktualisiert werden.

© SoftProject GmbH 122



X4 ESB

5 Prozesse anlegen und modellieren

5.1 Prozessanlegen

Mit dem Process Editor konnen Sie Technical Processes grafisch modellieren.

Sie kdbnnen sowohl leere Bausteine aus der Palette als auch Dateien aus der Sicht Projects auf die
Zeichnungsflache ziehen und in der Sicht Properties die jeweiligen Eigenschaften konfigurieren, um
einen ausfihrbaren Prozess zu erstellen.

Um einen neuen Prozess anzulegen, gehen Sie wie folgt vor:

1. Klicken Sie mit der rechten Maustaste auf den Ordner Processes, und wahlen Sie im
KontextmenU New > Technical Process....
Das Dialogfenster Process Creation Wizard wird gedffnet.

#4 Process Creation Wizard O >
Technical Process File Name ol
Select template from the list and enter a file name, e
Blank Start with a blank Technical process
File name: process.wrf
Process title: process

Process description:

? Finish | Cancel

2. Wabhlen Sie eine leere Prozessvorlage oder eine vorhandene Prozessvorlage.

3. Geben Sie im Feld File name den Prozessnamen ein.
@ Leerzeichen, Umlaute und Sonderzeichen sind im Dateinamen nicht erlaubt!

4. Geben Sie im Feld Process title einen Prozesstitel ein.
Der Prozesstitel wird im Prozessdiagramm angezeigt und kann in der Sicht Properties tber die
Eigenschaft Title verandert und bei Bedarf Uber die Eigenschaft Show Title ein-und
ausgeblendet werden.
@ Um die Eigenschaft Show Title anzuzeigen, klicken Sie in der Sicht Properties auf das
Symbol Show Advanced Properties.

5. Hinterlegen Sie ggf. im Feld Process description eine Prozessbeschreibung. Die Angabe einer
Prozessbeschreibung ist optional.
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6. Wahlen Sie Finish, um den Prozess anzulegen.
Ein leeres Prozessdiagramm wird mit der Dateinamensendung .wrf in der Sicht Projects
erstellt und im Process Editor gedffnet.

7. Modellieren Sie den Prozess wie gewlinscht:

« Ziehen Sie Bausteine aus der Palette oder Dateien aus der Sicht Projects per Drag&Drop
auf eine bereits vorhandene Ubergangslinie zwischen zwei Prozessbausteinen oder an
eine freie Stelle auf der Zeichnungsflache.

. Zeichnen Sie ggf. Ubergangslinien, um die Prozessbausteine zu verbinden. Gehen Sie
dazu wie folgt vor:

« Fahren Sie mit dem Mauszeiger Uber den Quellbaustein, um einen kleinen Pfeil
anzuzeigen.
« Klicken Sie auf den Pfeil, und ziehen Sie eine Linie zum Zielbaustein.

® Tipp
Uber das Menii Project > Validate Project lasst sich der Prozess (iber einen integrierten
Prozess-Validator auf Gultigkeit prifen.
Wenn Sie Dateien aus der Sicht Projects in [hren Prozess einbinden und diese in der
Sicht Properties entsprechend konfigurieren, kénnen Sie den modellierten Prozess
tiber P ausfihren.

5.1.1  Nutzungvon Private Files unterhalb von Prozessen

Wenn Prozessressourcen nur innerhalb eines Prozesses verwendet werden sollen, lassen sich diese
direkt unterhalb eines Elternprozesses anlegen. Damit kénnen sie ausschlieBlich im Prozesskontext
verwendet werden und lassen sich aus anderen Prozessen auch nicht aufrufen.

Grundsatzlich lassen sich unterhalb eines einzelnen Prozesses die gleichen Ressourcen anlegen wie
innerhalb eines Projektes - seien es Unterprozesse, Dokumente wie beispielsweise XML-Dateien,
SQL-Statements oder auch Adapter.
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~ [ %] SampleESBProject

[ Adapters

w [~ Processes

g Integri = . o
(= Resource Mew ¥ . Process..
= Temporar Open Adapter...
& o Openvi |5 soNDeeumen.
& X4Common Save As Template... f Text Document..
Copy Full Path to Clipboard =] XML Document...
Copy X5tore URL to Clipboard =  XHTML Document...
o Cut Ctilax | =% XSLStylesheet..
Copy Ctdsc | 1] Report..
K Delete Delete '@ SOL Staterment...
Rename/Refactor... 2 |
® Die zu verwendenden Ressourcen kénnen sowohl iiber das Kontextmenii New >

5.2

<Ressourcenname> als auch lber die Symbolleiste
werden.

Die angelegten Ressourcen lassen sich anschlieBend wie gewohnt parametrieren und per
Drag & Drop aus dem Repository in das Prozessdiagramm einbauen.

* > Add <Ressourcenname> angelegt

Eigenschaften eines Technical Process (.wrf)

Technical Processes(.wrf)werden tber den Process Editor grafisch modelliert und kénnen
auf dem X4 Server ausgefiihrt werden, wenn samtliche Bausteine entsprechend parametriert
und korrekt mit Repository-Dateien verknipft wurden.

Die Eigenschaften jedes Technical Processes lassen sich in der Properties-Sicht des Process
Editors bearbeiten, wenn im Process Editor ein freier Bereich der Zeichnungsflache
angeklickt wird.

StandardmaBig werden die gebrauchlichsten Eigenschaften angezeigt, Giber die Symbolleiste
der Properties-Sicht lassen sich jedoch zuséatzliche Einstellungen vornehmen:

. B Show Categories: Eigenschaften nach Kategorien geordnet anzeigen

—+
. |5t Show Advanced Properties: Erweiterte Eigenschaften anzeigen

Eigenschaften

Documentation
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Title

Show Title

Description

Version

Project Name
Created
Created by
Last Update
Last Update by
Metadata

Manage Metadata

Technical

Schema
Declaration

Location

Can Stop

Stop on error

Freitextfeld fir den Prozesstitel

Prozesstitel durch Aktivieren bzw. Deaktivieren des Auswahlfeldes ein-und
ausblenden

Prozessbeschreibung; Kann bei Bedarf geandert werden
Projektversion

@ Wenn keine Version gesetzt ist, wird der Zeitstempel als Version genommen.

Projektname; Kann bei Bedarf gedndert werden
Erstelldatum des Prozesses

Name des Prozess-Erstellers

Datum der letzten Anderung

Name des letzten Bearbeiters

Metadaten verwalten, z. B. hinzufligen, I6schen oder bearbeiten; Dazu die

Eigenschaft markieren und auf ki klicken, siehe Prozess-Metadaten hinzufligen

Schema fir Input und Output des Prozesses

Vollstandiger relativer Pfad des Prozesses innerhalb des X4 Repositorys; Wird
automatisch gesetzt.

Prozess darf wahrend der Ausfiihrung angehalten werden
@ Diese Eigenschaft wird nicht an Subprozesse vererbt.
Mdgliche Werte:

e True: fir normale Prozesse (Standard)

« False: fur kritische Prozesse, die zu Ende laufen missen
Im Fehlerfall die Prozess-Ausfihrung anhalten

Mégliche Werte:

« True: Ausflihrung abbrechen, wenn ein Fehler auftritt (Standard)

« False: Fehlerhaften Prozess weiter ausfiihren (sofern mdglich)
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In service

Schedule

Instance limit

Owner

Prozess aktiv oder inaktiv setzen. Werden inaktive Prozesse direkt ausgefiihrt,
so erhalten sie die Prozess-ID -1 . Subprozesse, also Prozesse, die in anderen
Prozessen aufgerufen werden, kdnnen unabhangig von dieser Eigenschaft
immer ausgefihrt werden.

Mdgliche Werte:

« True: Prozess kann ausgefiihrt werden (Standard)

« False: Prozess kann nicht ausgefiihrt werden (nur als Subprozess)

Schedule-Werkzeug, das zeitgesteuertes Ausfiihren von Prozessen auf dem X4

Eigenschaft markieren und auf ki klicken.

Mégliche Werte:

« Disabled: Kein Zeitplan wurde festgelegt (Standard)

« Enabled: Ein Zeitplan fur die Ausflhrung des Prozesses wurde hinterlegt

Maximale Anzahl von Instanzen dieses Prozesses, die parallel ausgefihrt werden
darfen

& Beachten Sie!

Instance limitwirdignoriert, wenn der Prozesse als Subprozess
aufgerufen wird.

Mégliche Werte:

- Beliebige positive ganze Zahl

- 0: Keine Begrenzung(Standard)

Freitextfeld zur Benennung eines Prozess-Verantwortlichen

5.3  Prozessbausteine ausrichten

Prozessbausteine von Technical Processes und Business Processes konnen Uber den Kontextmenu-
Eintrag Layout auf einfache Weise aneinander ausgerichtet werden. Damit schaffen Sie schnell und
einfach eine saubere, strukturierte Prozessubersicht.

Dazu die gewiinschten Prozesskomponenten auswahlen und Gber Rechtsklick das Kontextmen
aufrufen. AnschlieBend Layout und die gewiinschte Option wahlen.

Folgende Optionen stehen flr das Ausrichten der Prozesskomponenten zur Verfligung

« Align Horizontal: Komponenten anhand des Mittelwertes horizontal ausrichten
« Align Vertical: Komponenten anhand des Mittelwertes vertikal ausrichten
« Distribute Horizontal: Komponenten gleichmaBig horizontal verteilen
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« Distribute Vertical: Komponenten gleichmaBig vertikal verteilen

Get Customers

Select Ciistomers

i E Add Component > |
Write Cust
n XM Layout > f8 Align Horizontal
<) Undo move/resize ¥ Align Vertical
. Select Al [+0  Distribute Horizontal
> Distribute Vertical
2] = THE [E Copy [}
Select Customers Get Customers of Cut
% Copy Process Diagram to Clipboard
3 Delete

Pack As Subprocess

L

® Fir die Optionen Align Horizontalund Align Vertical missen mindestens zwei
Prozesskomponenten ausgewahlt sein, fur die OptionenDistribute
Horizontalund Distribute Vertical mindestens drei Komponenten.

5.4 Prozesse validieren

Sowohl Business Processes (. bpm)als auch Technical Processes(.wrf)kdnnen iber einen
integrierten Prozess-Validator auf Giltigkeit geprift werden. Dabei kann die Validierung auf Basis von
standardmaBig hinterlegten oder benutzerdefinierten Validierungsregeln durchgefihrt werden.

Die Prozess-Validierung kann Gber folgende Menls geo6ffnet werden:

« Kontextmen( > Validate bei Rechtsklick auf Prozesse im Repository
« Menl Project > Validate Project

Bei der Prozess-Validierung werden drei Schweregrade unterschieden:

« Error: Fehler, welche die Ausfihrung des Prozesses verhindern
« Warning: Fehler, die eine fehlerhafte Ausfliihrung des Prozesses verursachen kdnnen
« Information: Informationen zum Zustand eines Prozesses

5.4.1  Prozess-Validierung durchfihren

Um einen Prozess auf Gultigkeit zu prtfen, gehen Sie wie folgt vor:
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1. Offnen Sie den Dialog fiir die Prozess-Validierung, z.B. (iber das Menii Project > Validate

Project.
& Validation ] hed
Validation
Select processes for Validation
O Browse...

ESEProject_1/Processes/1-StartStopTransitions.wrf

O ESEProject_1/Processes/2-Components.wrf

O ESEProject_1/Processes/2-Conditions-Cennections.wrf
[] ESBProject 1/Processes/4-Pausewrf

O ESEProject_1/Processes/3-FerkloinMerge.wrf

[] ESBProject_1/Processes/6-Variablewrf

O ESEProject_1/Processes/T-Subprocesses.wrf

[] ESBProject_1/Processes/8-Counter.wrf

[] ESBProject_1/Processes/Subprocesses/7/Subprocess.wrf
[ ESBProject_1/Processes/Subprocesses//CounterDynamicParameters.wrf
[] ESBProject_1/Processes/Subprocesses/8/CounterWithProperties.wrf

Selectall | Clear all

2. Diezuvalidierenden Prozesse auswahlen.

3. Uber Use custom config file und Browse, ggf. eine Konfiguration fiir eigene Validierungsregeln
hochladen, siehe Abschnitt Benutzerdefinierte Validierungsregein.

4. Mit Start die Validierung beginnen.

In der Validation Report Sicht wird nun das Validerungsergebnis gedffnet.

¥ Validation Report 2 E = O
v - xstore)///Documentation_6.0/Processes/process.wrf
& The Parameter file_name of SQL Statement "SQL Statement” with Action ID 1 is empty
o « Mit Doppelklick auf den Prozesspfad wird der entsprechende Prozess im X4

Designer geo6ffnet.
« Mit Doppelklick auf ein Validierungsergebnis werden die Eigenschaften der
entsprechende Prozesskomponente in der Properties-Sicht getffnet.

b.4.2  StandardmaBig hinterlegte Validierungsregeln

Folgende Validierungsregeln sich bereits standardmaBig hinterlegt:

Validierungsregel

Beschreibung Schwere

Action Parameter Validation Sind alle Aktionen korrekt parametriert? Error

Condition Validation

Connection Validation

Sind alle Zweige eines Condition-Baust Warning
eine gefullt?

Sind alle Pfade geschlossen? Error
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5.4.3  Benutzerdefinierte Validierungsregeln

Es kénnen auch eigene Validierungsregeln definiert werden. Diese missen als XSLT-Mapping mit
einer vorgegebenen Struktur vorliegen.
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Beispiel: Mapping-Beispiel fiir benutzerdefinierte Validierungsregeln

<xsl:stylesheet xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform" version="2.0">
<xsl:output media-type="text/xml" method="xml"></xsl:output>
<xsl:template match="/">
<xsl:param name="subprocessCount" select="count(Workflow/Actions/Action[Module/
text() = "iXworkflow'])"></xsl:param>
<xsl:param name="componentCount" select="count(Workflow/Actions/Action)"></xsl:pa
ram>
<xsl:param name="textCount" select="count(Workflow/Graphics/svg/text)"></xsl:para
m>
<step>
<xsl:choose>
<xsl:when test="$componentCount &gt; 100">
<warn>The number of process components is <xsl:value-of select="$componentC
ount"></xsl:value-of>. Processes with more than 100 components may probably be
unclear and error-prone. Please check, if you can outsource parts of the process as
subprocesses.</warn>
</xsl:when>
<xsl:otherwise>
<info>The number of process components is <xsl:value-of select="$componentC
ount"></xsl:value-of>
</info>
</xsl:otherwise>
</xsl:choose>
<xsl:choose>
<xsl:when test="$textCount &gt; 0">
<xsl:if test="$componentCount div S$textCount &gt; 5">
<warn>The ratio of process components to text components 1is greater than
5:1. It is <xsl:value-of select="$componentCount div S$textCount"></xsl:value-of>:1.</
warn>
</xsl:if>
</xsl:when>
<xsl:otherwise>
<info>The process doesn't contain any text components.</info>
</xsl:otherwise>
</xsl:choose>
<xsl:choose>
<xsl:when test="$subprocessCount &gt; 0">
<xsl:if test="( ScomponentCount - $subprocessCount ) div $subprocessCount
&gt; 10">
<warn>The ratio of process components to subprocesses is greater than
10:1. It is <xsl:value-of select="( $componentCount - $subprocessCount ) div
$subprocessCount"></xsl:value-of>:1</warn>
</xsl:if>
</xsl:when>
<xsl:otherwise>
<info>The process doesn't contain any subprocesses.</info>
</xsl:otherwise>
</xsl:choose>
</step>
</xsl:template>
</xsl:stylesheet>
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Flr die Prozess-Validierung muss eine XML-Datei mit folgendem Aufbau Gbergeben werden. Das zu
verwendende Mapping wird hier anhand der xstore-URL referenziert:

<validationConfig>
<default active="true"/>
<custom_xslt active="true" name="processMetrics">
xstore://Projekt/Unterverzeichnis/customValidationMetrics.xsl
</custom_xslt>
</validationConfig>

5.5  Prozessbausteine parametrieren

Auf den nachfolgenden Seiten erfahren Sie Folgendes:

- welche Arten von Parametern genutzt werden konnen
« wie Bausteine von Technical Processes parametriert bzw. konfiguriert werden
- wie Parameterinnerhalb eines Technical Processes verwendet werden

Lesen Sie mehr dazu auf den folgenden Unterseiten:

« Moglichkeiten der Parametrierung

« Anwendungsbeispiele fir Parameter

« Dynamische Parameter verwenden

« Component-Parameter verwenden

Status mit ConditionState dynamisch setzen
Parameter in XSL-Mappings verwenden

5.5.1  Moglichkeiten der Parametrierung

Hier erhalten Sie einen Uberblick ber die Erstellung und Verwendung von Parametern in der X4
BPMS.

Gliltigkeitsbereich (Scope) fiir Parameter:

- System-Parameter: vom System vorgegebene Parameter (siehe System-Parameter)

» Globale Parameter: Parameter, die Sie als Nutzer anlegen kdnnen und die in allen Projekten der
X4 BPMS verwendet werden kdnnen (siehe Globale Parameter)

+ Projekt-Parameter: Parameter, die in einer Datei in einem Projekt erstellt, innerhalb dieses
Projekts genutzt und mit dem Projekt importiert bzw. exportiert werden kénnen (siehe Projekt-
Parameter erstellen)

Verwendung von Parametern:

Parameter konnen in Technical Processes in Prozessbausteinen, Mappings, Adaptern und Conditions
genutzt werden. In Geschéaftsprozessen (BPM-Prozessen) konnen Sie zudem in Rules und Human Task
verwendet werden. Es kdnnen globale, System- oder Projekt-Parameter verwendet werden.
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® Mit der Tastenkombination Strg+Leertaste kdnnen in Projektdateien (Prozessbausteinen,
Mappings, Adaptern und Conditions) alle verfligbaren System-, Projekt- und globalen
Parameter angezeigt und ausgewahlt werden.

& Beachten Sie folgende Priorisierung bei der Verwendung von Parametern:
System-Parameter — Projekt-Parameter — Globale Parameter
Bei Namenskonflikten wird eine Fehlermeldung bzw. Warnung in der Sicht Problems
angezeigt:

» Fehlermeldung bei Namenskonflikten von System- und Projekt-Parametern
« Warnung bei Namenskonflikten von Projekt-Parametern und globalen Parametern

Wo werden Parameter gespeichert?

System-
Parameter

Die X4 BPMS enthalt eine Reihe von vordefinierten System-Parametern, z. B. ¥PID%
(aktuelle Prozessinstanz-ID) oder %Now% (aktuelles Datum und Uhrzeit).

System-Parameter konnen nicht wahrend der Laufzeit gedndert werden.
Typischer Anwendungsfall:

Technische Parameter, z.B. eine Mailserver-Adresse, setzen flr diese
Laufzeitumgebung/Stufe.

Dateinamen oder Prozess-1D eines Technical Processes ausgeben

Fir zusatzliche Anwendungsfalle, die nicht durch System-Parameter abgedeckt werden, kénnen Sie
globale oder Projekt-Parameter erstellen.

Globale oder Projekt-Parameter kénnen, im Gegensatz zu System-Parametern, zur Prozesslaufzeit
gesetzt werden.

Globale
Parameter

Globale Parameter kdnnen Sie in der Global Parameter Configuration definieren.
Diese Konfiguration wird im jeweiligen Prozess gespeichert.

Beispiele fir Anwendungsfalle von globalen Parametern finden Sie in Globale
Parameter verwenden.

Typischer Anwendungsfall:
Parameter setzen, die in verschiedenen Projekten genutzt und die wahrend der

Laufzeit geandert werden kdnnen, z.B. die Empfanger von systemgenerierten Mails
oder die FuBzeile in systemgenerierten Mails.
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Projekt- Projekt-Parameter kdnnen in einem Projekt in mehreren Technical Processes
Parameter verwendet werden.

Diese Parameter werden in der Project Parameter Configuration (x.param)im
Projekt gespeichert und kdnnen mit dem Projekt exportiert bzw. importiert werden.

Typischer Anwendungsfall:

» Technical Process:
Ein Projekt-Parameter kann als Grenzwert fiir Messwerte (Messwert muss
zwischen zwei Grenzwerten liegen) definiert werden.

« Geschaftsprozess mit Business Rule: }
Ein Projekt-Parameter kann als Limitierung zur Uberprifung eines Werts
(Abnahme/Ablehnung je nach gesetztem Wert) festgelegt werden.

« Geschaftsprozess mit Human Task:
Ein Projekt-Parameter kann in einem Mapping in einem Technical Process
gesetzt werden, der vom Geschaftsprozess aufgerufen wird. Hier kann z.B.
die Duration im Human Task unterschiedlich sein je nach Umgebung.

Wo werden Parameter verwendet?

In Technical Processes konnen Parameter fiir folgende Elemente gesetzt werden:

« Adapter

Conditions

Mappings

weitere Prozessbausteine

In Geschaftsprozessen (BPM-Processes) kénnen Parameter fiir folgende Elemente gesetzt werden

« Rules
« Human Task (lber Mapping in einem Technical Process)

@ Beachten Sie folgende Priorisierung bei der Nutzung von Component Parameters und
dynamischen Parametern:
- Component Parameters Uberschreiben die Konfiguration von Prozessbausteinen im
Repository (beispielsweise Funktions-Adapter) wahrend der Prozesslaufzeit.
» Dynamische Parameter tGberschreiben gesetzte globale, Projekt-Parameter System-
Parameter sowie die Konfiguration von Prozessbausteinen im Repository
(beispielsweise Funktions-Adapter) zur Prozesslaufzeit.
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Aktion

Adapter-
Parameter

Conditions

Mappings

Component-
Parameter

Beschreibung
Parameter lassen sich in Adapter-Konfigurationen einsetzen.

Typischer Anwendungsfall:
In einem XML Encryption (Password) Adapter kann im Parameter xpath ein Pfad zu

einem Element, das verschlisselt/entschlisselt werden soll, gesetzt werden. Dieser
Pfad kann fest definiert (//Data) werden oder (ber einen Parameter gesetzt werden.

Fallunterscheidungen in Verzweigungen von Condition-Bausteinen konnen Sie mit
Parametern definieren (siehe Bedingungen erstellen und verwenden).

Typischer Anwendungsfall:

Es soll geprift werden, ob der Output eines Prozessbausteins einen bestimmten
Parameterwert enthalt.

Parameter(globale, Projekt- und System-Parameter) kénnen in XSL-Mappings
verwendet werden.

Hierzu missen Sie im Mapping eingefligt werden (siehe Parameter in XSL-Mappings
verwenden).

Markierte Prozessbausteine eines gedffneten Prozesses kdnnen Sie in der Sicht Pro
perties anpassen.

Mit Component-Parameter kdnnen Sie einen markierten Prozessbaustein fir den
einzelnen Prozess parametrieren (siehe Component-Parameter).

Diese Parameter werden im jeweiligen Prozess gespeichert.
Typischer Anwendungsfall:

Mit Component-Parameter konnen die Parameter eines Adapters in einem Prozess
Uberschrieben werden.

Innerhalb von Component-Parameter konnen Sie feste Werte (fester Pfad z.B. c:

\temp) oder Parameter verwenden. Hier kdnnen System-Parameter oder zuvor
definierte globale bzw. Projekt-Parametern genutzt werden.
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Aktion

Dynamische
Parameter

Beschreibung

Mit dynamischen Parametern konnen Sie globale, System- und Projekt-Parameter in
XSL-Mappings Gberschreiben.

Innerhalb eines Prozesses konnen Sie in Abhangigkeit von verarbeiteten Daten mit
dynamischen Parametern verschiedene Prozessbausteine ansteuern. Dynamische
Parameter werden in XSL-Mappings in Form von Processing Instructions abgelegt
und vom darauf folgenden Prozessbaustein (z. B. einem Adapter)interpretiert (siehe
Dynamische Parameter verwenden).

Die Konfiguration wird nur wahrend der Prozesslaufzeit dynamisch verandert.
Typischer Anwendungsfall:

Mit dynamischen Parametern konnen Sie Prozessbausteine ansteuern und bereits
gesetzte Parameter zur Prozesslaufzeit Gberschreiben.

5.5.2  Anwendungsbeispiele fur Parameter

Hier finden Sie mdgliche Anwendungsbeispiele fir die Verwendung von globalen, System-und
Projekt-Parametern.

Parameter in Adaptern verwenden

Parameter konnen in Adaptern auf zwei Arten gesetzt werden:

- inder Properties-Sicht iber Component Parameters (sieche Component-Parameter)
« inallen Textfeldernim Adapter-Editor

® Hinweis

Bei Adaptern, werden in der Spalte Value mit der Tastenkombination Strg + Leertaste werd
en alle verfligbaren System-Parameter sowie alle globalen und Projekt-Parameter vom Typ
String angezeigt.
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Der gewlinschte Parameter kann aus einer Drop-down-Liste ausgewahlt werden:

*FTP_Connectorfa X = 0
Adapter
Type: FTP Connector Category : Communication
Version : 1.00

Description : Reads and writes files and creates directories that are located on a remote file system. It allows to easily perform actions such as listing, moving,
copying and deleting files or directories

Parameter Filter: Show All
Parameter Value Comment
P Adapter de.softproject.integration.adapter.ftpadapter. FileTransferAdapter w |mplementation class
P, host
P port 21 SPARAM_MyGroup_MyTargetHost%

%PARAM_MyGroup_MyTargetPort%
%PARAM_MyGroup_MyTargetChannel%
BACTION_ID%

B, user

P, password

F. path %CALLING_PROCESS%
P targetPath %CALLING_PROCESS_NAMES:
P protocol T %CALLING_PROCESS_PATH%
%CURRENT PROCESS%
P connecthlode & %CURRENT PROCESS NAMES
P nameFilter %CURRENT_PROCESS_PATH
P addNewline Ne %CURRENT PROJECTS
P hostValidationEnabled L= v

P hostValidationFile

Parameter

Name: host Reset

Description: Host Reset All

5.5.3  Dynamische Parameter verwenden
Wie kann ich dynamische Parameter verwenden?

Innerhalb eines Technical Processes kdnnen Sie in Abhangigkeit von verarbeiteten Daten mit
sogenannten dynamischen Parametern Prozessbausteine ansteuern und ggf. bereits gesetzte
Parameter zur Prozesslaufzeit iberschreiben.

Dynamische Parameter werden in XSL-Mappings als Processing Instruction erzeugt und vom darauf
folgenden Prozessbaustein (beispielsweise einem Adapter) verarbeitet.

Hierbei haben Sie mehrere Moglichkeiten:

« Parameter via XSL-Mapping setzen: Hier konnen Sie ein einzelnes XSL-Daten-Mapping
einsetzen, das XML-Daten transformiert und gleichzeitig dynamisch Processing
Instruction-Definitionen enthalt.

« Dynamisch parametrieren ohne Datentransformation: Sie kdnnen auch ein separates XSL-
Mapping erstellen, das nur die Processing Instructions generiert.

« Dynamisch parametrieren mit Processing Instructions und Dynamic Parameter: Sie kdnnen
auch ein separates XSL-Mapping erstellen, das die Processing Instruction-Definitionen mit
dynamischen Parametern enthalt.
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@ Hinweis
Beachten Sie folgende Priorisierung bei der Nutzung von Component-Parameter und
dynamischen Parametern:
« Component-Parameter (berschreiben die Konfiguration von Prozessbausteinen im
Repository (beispielsweise Funktions-Adapter) wahrend der Prozesslaufzeit.
- Dynamische Parameter (iberschreiben gesetzte globale, Projekt- und System-
Parameter sowie die Konfiguration von Prozessbausteinen im Repository
(beispielsweise Funktions-Adapter) zur Prozesslaufzeit.

5.6.3.1  Parameter dynamisch via XSL-Mapping setzen

1. Positionieren Sie ein XSL-Mapping im Technical Process vor dem Adapter oder der Datenbank-
Verbindung.

2. Definieren Sie die Processing Instruction im XSL-Mapping nach folgendem Muster:
<xsl:processing-instruction name="DynamicParameter">ParameterName="Parameter
Value"</xsl:processing-instruction>

3. Ersetzen Sie ParameterName durch den gewlnschten Parameternamen.

4. Ersetzen Sie ParameterValue durch den gewlinschten Wert, meist in Form eines XSL-Befehls.

5. Wenn das XSL-Mapping ausschlieBlich dynamische Parameter erzeugen soll: Lesen Sie
zusatzlich mit <xsl:processing-instruction name="NoResult"/> fest, dass das XSL-
Mapping kein Ergebnis-Dokument erzeugt.

® Hinweis
Das XSL-Mapping muss in jedem Fall ein Wurzel-Element generieren, damit das XSL-Mapping
ausgefihrt werden kann.

5.6.3.2  Dynamisch parametrieren ohne Datentransformation

Wenn ein Input-Dokument direkt an einen dynamisch parametrierten Adapter Gibergeben werden soll,
ist es erforderlich, eine Gabelung (mithilfe des Fork-Bausteins)in das Diagramm des Technical
Processes einzufligen:

1. Setzen Sie ein XSL-Mapping in einen Ausfuhrzweig.
2. Setzen Sie den zu Gibergebenden Prozessbaustein in einen zweiten Ausflihrzweig.
3. Setzen Sie den Adapter direkt hinter den Join-Baustein.
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® Beispiel
Ein aus einem XML-Dokument ausgelesener Dateiname soll als dynamischer Parameter an
einen Filesystem Transfer Adapter Gibergeben werden:

=2
o Dazpa ]

L0 NN
@—l . |—BF—0
Start jz] ! FileSystem Stop

L——b;;?————iﬁé}f———J

Input DynParameters

Im Beispiel besteht das XSL-Mapping aus folgendem Quelltext:

<xsl:stylesheet xmlns:xsl="http://www.w3.0rg/" version="1.1">
<xsl:output method="xml" media-type="text/xml"/>
<xsl:template match="/">
<xsl:processing-instruction name="DynamicParameter'">documentname="
<xsl:value-of select="data"/>"
</xsl:processing-instruction>
<xsl:processing-instruction name="NoResult"/>
<root/>
</xsl:template>
</xsl:stylesheet>

5.6.3.3  Dynamische Parameter mit DynamicParameter

Mit XSL-Mappings kénnen Sie die Konfiguration von Adaptern und Datenbank-Verbindungen zur
Laufzeit beeinflussen. Innerhalb des XSL-Mappings wird eine Logik implementiert, diein
Abhangigkeit von den verarbeiteten Daten benutzerdefinierte Parameterwerte ausgibt. Diese
benutzerdefinierten Parameterwerte kénnen von einem nachfolgenden Adapter-, Transfer-Adapter-
oder Datenbank-Baustein verarbeitet werden und Gberschreiben bereits gesetzte Werte.

Parameterwerte erzeugen

Um dynamische Werte innerhalb von Technical Processes zu setzen, kénnen Sie mithilfe von XSL-
Mappings Processing Instructions erzeugen, die an den nachfolgenden Prozess-Schritt ibergeben werden
und entsprechend interpretiert werden kénnen.

<xsl:processing-instruction name="DynamicParameter'">
parameterName="parameterValue"</xsl:processing-instruction>

Die Ausgabe des XSL-Mappings:
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<?DynamicParameter parameterName="parameterValue" ?>

Parameter und Parameterwerte

Im XSL-Mapping kénnen Sie beliebig viele unterschiedliche dynamische Parameter mit jeweils einem
zugehorigen Wert definieren:

« parameterName: Zu Uberschreibender Parametername
« parameterValue: Zu Uberschreibender Parameterwert; immer innerhalb von
Anflhrungszeichen

® Hinweis
Beachten Sie, dass das XSL-Mapping ein Wurzel-Element generieren muss, damit das XSL-
Mapping ausgefihrt und ein gultiges XML-Dokument erzeugt werden kann.

Beispiel

<?xml version="1.0" encoding="UTF-8"?>
<xsl:stylesheet xmlns:xsl="http://www.w3.0rg/1999/XSL/Transform"
version="1.0">

<xsl:output encoding="UTF-8" method="xml" indent="yes" version="1.0"/>
<xsl:template match="/">
<xsl:processing-instruction
name="DynamicParameter'">key="1i"</xsl:processing-instruction>
<root/>
</xsl:template>
</xsl:stylesheet>

5.5.4  Component-Parameter verwenden
Wie kann ich Component-Parameter verwenden?

Fir bestimmte Prozessbausteine (XSL-Mappings, PDF-Creator-Bausteine und Adapter) lassen sich
Component-Parameter definieren.

Als Component-Parameter konnen Sie Parameter verwenden, die zur Laufzeit des Prozesses gesetzt
werden.

Mdégliche Parameter sind:

« System-Parameter, z. B. %P1D% (aktuelle Prozessinstanz-ID) oder %NOw% (aktuelles Datum und
Uhrzeit)(siehe Ubersicht der System-Parameter)

- globale Parameter (siehe Globale Parameter und -Gruppen erstellen)

«+ Projekt-Parameter(siehe Projekt-Parameter erstellen)
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@ Hinweis
Beachten Sie folgende Priorisierung bei der Nutzung von Component-Parameter und
dynamischen Parametern:
« Component-Parameter (berschreiben die Konfiguration von Prozessbausteinen im
Repository (beispielsweise Funktions-Adapter) wahrend der Prozesslaufzeit.
- Dynamische Parameter (iberschreiben gesetzte globale, Projekt- und System-
Parameter sowie die Konfiguration von Prozessbausteinen im Repository
(beispielsweise Funktions-Adapter) zur Prozesslaufzeit.

5.5.4.1 Component Parameter definieren

Um Component-Parameter zu definieren, gehen Sie wie folgt vor:

1. Rufen Sie das Fenster Component-Parameters auf:
« Markieren Sie den Prozessbaustein im Prozess.
« Klicken Sie in der Properties-Sicht auf Component Parameters, um Ed anzuzeigen.
« Klicken Sie auf m, um das Fenster Component-Parameters aufzurufen.

4

Members: Parameter properties:

ComponentParameterMame [ComponentParameterVa|  Add Mame:

ComponentParameterMal

Remowve
Value:

Up ComponentParameter\a

lue
Down

2. Geben Sie in Name den Namen des Component-Parameter ein.
« In XSL-Mappings und Reports konnen Sie den hier gesetzten Namen als Parameter
ansprechen und den zugehorigen Wert Gibergeben, z. B. einen globalen Parameter
PDFPath mit <xsl:param name="PDFPath"/>.
- Verwenden Sie bei Adaptern und Datenbankverbindungen die exakte (technische)
Bezeichnung des zu Uberschreibenden Parameters.
3. Geben Siein Value den zu Uberschreibenden Parameterwert ein.

® Hinweis
Mit Strg+ Leertaste werden alle verfligbaren globalen, System- und Projekt-
Parameter angezeigt.

4. Klicken Sie OK, um den Component-Parameter im Prozess zu speichern.
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@ Hinweis
Ein Prozessbaustein wird mit einem @ -Symbol gekennzeichnet, sobald fir den
Prozessbaustein ein Component-Parameter festgelegt wird.

Funktionen in Fenster ComponentbParameters:

« Add: Weitere Baustein-Parameter hinzufligen
« Remove: Ausgewahlten Parameter aus der Liste |[6schen
« Up/ Down: Reihenfolge der Parameter wechseln

5.6.,6  Status mit ConditionState dynamisch setzen

Mit einem XSL-Mapping kénnen Sie abhangig von verarbeiteten Daten zusatzlich Ausfihr-
Statuswerte als Processing Instruction erzeugen, die innerhalb des Technical Processes von einem
Condition-Baustein ausgewertet werden. Je nach Status kdnnen Sie so entsprechend definierte
Verzweigungen ausfihren lassen.

—T
Ce

'
Process A Stop

[1] Condition State =1

O >3 = >< - > >O
= | [2] Condition State = 2 (I ]

Start Data Transform Process B Stop

A4

[3] Condition State = 2

@
e
Process C Stop

1. Leeres XSL-Mapping in einem Technical Process vor einem Cond+tion-Baustein positionieren.
2. Processing Instruction(s)im XSL-Mapping nach folgendem Muster definieren:

<xs'l:processing-instruction name="ConditionState">value</xsl:processing-
instruction>
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3. valuedurcheinen Wert z.B. aus dem verarbeiteten XML-Dokument ersetzen.
Beispiel: <xs1l:value-of select="data"/>

® Hinweis
Zuladssige Statuswerte ganze Zahlen (Integer)sowie negative Zahlen(z. B. -1) flr einen
Fehlerstatus; siehe Statuswerte flr Prozesse und Prozess-Schritte
Nicht zulassig sind folgende Status-Nummern, da diese systemintern reserviert sind:
« -999(Fehlerstatus der Engine)
« -998(Prozess wurde aus Lizenzgriinden nicht ausgeflhrt)
« 999(Status-ID flr noch nicht ausgeflihrte Prozessbausteine)
« 998(wird vom Save Point-Mechanismus verwendet und bewirkt die sofortige
Beendigung des gesamten Prozesses)
« 997(bewirkt die sofortige Beendigung des gesamten Technical Processes)
Empfehlung: Verwenden Sie flr benutzerdefinierte Statuswerte Zahlen groBer als
1000, um mdgliche Uberschneidungen mit anderen Statuswerten zu vermeiden.

4. Sicherstellen, dass das XSL-Mapping ein Wurzel-Element generiert, damit das XSL-Mapping
ausgefihrt und ein gliltiges XML-Dokument erzeugt werden kann.
Das XSL-Mapping gibt nun Processing Instructions nach dem Muster <?ConditionState
value ?> aus.

5. Im nachfolgenden Condition-Baustein fir jede Verzweigung einen Status definieren, siehe
Bedingungen er